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Foreword 

 
This document, personal initiative of a User, is a partial conversion to Adobe PDF 

format of the HELP files available within v. 1.7.0 of the software for PC. 
 

As it has been created to help Beginners, Legal pages and JS Library pages (more than 
400) have been removed. See the genuine Help files within the program if you need to. 

 

All texts and pictures are © 2020 Gotcha Gotcha Games Inc. 
 

© 2023 Didier Morandi https://www.lespublicationsdumarcel.com for the conversion 
from HTML to PDF and minor typo corrections, mainly menus subtitles which do not 

match the images included as examples (i.e. Balance vs Pan, etc.) 
 

Comments welcome on this document at didier.morandi@gmail.com 
 

Authorisation for public release pending. 

  

https://www.lespublicationsdumarcel.com/
mailto:didier.morandi@gmail.com
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About RPG Maker MZ 

 
RPG Maker MZ is a specialized creation tool for making role playing games. 

 
Games created using this software can also be played by users who do not have access 

to RPG Maker itself. 
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New Functions 
 

Main Features of RPG Maker MZ 
 

Newly added functions and improvements to RPG Maker MZ from the previous entry in 

the series have led to not only pure creation environment improvements, but also 
greater potential for new modes of expression, allowing you to create more challenging 

games. 
 

Game Creation Environment Improvements 

 

Functions to reduce creation time and prevent erroneous entry such as data conversion 
to support migration from the RPG Maker MV environment to the MZ environment, 

movement route previews, map layer displays, and more have been added, evolving 
RPG Maker MZ into a tool that allows you to concentrate more on creating. 
 

• Map Layer Selection Function 

• Plugin Command Improvements 
• Movement Route Preview Display 

• Prevention of Erroneous Number Input 

file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_01_01_05.html%23p02
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_01_01_05.html%23p07
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_01_01_05.html%23p07
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_01_01_05.html%23p07
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Gameplay Control Improvements 

 
 

RPG Maker MZ also includes improvements that will allow players to enjoy your games 
more, including autosave support, save data transfer via game ID, and menu UI 

changes. 
 

While MZ of course supports traditional independent gameplay using the keyboard, 
browser and touch controls are now included as default schemes.  

 
You can now create games that are easy-to-play in a variety of formats. 
 

• Improved Smartphone UI 

• Autosave Function 
• Distinction Between Creations via "Game ID" 

 

file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_01_01_06.html%23p01
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_01_01_06.html%23p02
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_01_01_06.html%23p03
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New Battle System 

 
 

In addition to turn-based battle, you can now also select time progression battles 
(TPB), where actions are taken sequentially by actors whose gauges have been filled. 

 
This allows you to adopt a real-time battle format in your own games. 

 
• About Time Progression Battles (TPB) 

• How to Switch to TPB 

 

file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_01_01_03.html%23p01
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_01_01_03.html%23p02
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Improvements to Artistic Expressions in Games 

 

The animation editor has been greatly overhauled, allowing you to use realistic 

animations in your games.  
 

Also added are a character generation function that allows you to create original 
characters, and a function that lets you adjust each part's position. 

 
You can create games that align more closely to your vision with the addition of control 

characters, a variable operand that utilizes whatever action occurred immediately prior 
to the current one, and more. 

 
• Animation Data Settings 

• Character Generator Improvement 

• "Just Prior" Variable Operand 
• Improved "Show Text" 

 

file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_01_01_04.html
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_01_01_05.html%23p01
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_01_01_05.html%23p03
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_01_01_05.html%23p05
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Other 

 
 

Small improvements such as the ability to configure resolution and font in the editor 

have been added. Beginners and experts alike can now create a larger variety of 

games. 
 
 

MV Data Conversion 
 

You can convert project data created in RPG Maker MV (hereafter "MV") into RPG 

Maker MZ (hereafter "MZ") project data. 
 

Conversion Process 

Conversion is done by copying the project data. First, follow the steps below. 

 
• Display file extensions on your PC. 

• Make a backup of the MV project data you wish to convert. 
• Create new project data in MZ to use as the conversion target. 

 

Copy all files into the MZ project 

 
All of the project data files will be copied into the MZ project. 

 
Conversion processing will be executed after launching MZ. 

 
*Conversion will not be done while the project is open in MZ. When copying the files, 

please close MZ in advance. 

 
MV and MZ data save destination 

 
Please copy and overwrite required MV data to MZ based on the following. 
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 RPG Maker MV RPG Maker MZ 

Music data \audio \audio 

Image 
data 

\img\animations 

\img\battlebacks1 
\img\battlebacks2 
\img\characters 

\img\enemies 
\img\faces 
\img\parallaxes 

\img\pictures 
\img\sv_actors 
\img\sv_enemies 

\img\tilesets 
\img\titles1 
\img\titles2 

\img\animations 

*The \img\animations 
folder must be copied 
when converting 

\img\battlebacks1 
\img\battlebacks2 
\img\characters 

\img\enemies 
\img\faces 
\img\parallaxes 

\img\pictures 
\img\sv_actors 
\img\sv_enemies 

\img\tilesets 
\img\titles1 
\img\titles2 

Icon 
image 

data \icon \icon 

System 

image 
data 

\img\system 

 
*Excluding the following 
files 

 
• ButtonSet.png 
• Damage.png 

• Loading.png 
• MadeWithMv.png \img\system 

Font data 

\fonts 
 
*Excluding the following 

files 
 

• gamefont.css \fonts 

Maps and 

map 
events 

\data\MapInfos.json 
\data\Mapxxx.json 

(xxx being the map id 
number) 

\data\MapInfos.json 
\data\Mapxxx.json 

Actors \data\Actors.json \data\Actors.json 

Classes \data\Classes.json \data\Classes.json 

Skills \data\Skills.json \data\Skills.json 

Items \data\Items.json \data\Items.json 
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Weapons \data\Weapons.json \data\Weapons.json 

Armor \data\Armors.json \data\Armors.json 

Enemies \data\Enemies.json \data\Enemies.json 

Troops \data\Troops.json \data\Troops.json 

States \data\States.json \data\States.json 

Animations \data\Animations.json \data\Animations.json 

Tilesets \data\Tilesets.json \data\Tilesets.json 

Common 

Events \data\CommonEvents.json \data\CommonEvents.json 

System 

Vocabulary 
Types 
Switch 

names 
Variable 
names \data\System.json \data\System.json 

 

Conversion Warnings 

 
Data that can be converted includes map data, map events, and database content 

created in RPG Maker MV. There is some data that is not required or not recommended 
for conversion. 
 

System image data 
\img\system 

The following image data is not 
required. 

• ButtonSet.png 

• Damage.png 
• Loading.png 
• MadeWithMv.png 

Animations 
\data\Animations.json 

\img\animations 

There is no "animations" folder inside of 
the "img" folder, so you will need to 

copy the folder. 

Font data 
\fonts 

In MZ, fonts to be used are configured 

from the database. Please copy only the 
font file. 
You can specify the font to use from 
[Database] → [System 2] → [Advanced 

Settings]. 

Plugin data 
\js\plugins 
\js\plugin.js 

Plugins are not guaranteed to run 
correctly or at all. 
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About Plugins 
 

If an RPG Maker MV plugin is included, a message will be shown in the Plugin Manager 

window. 
 
 

Time Progression Battles 
 

In RPG Maker MZ, you can switch to time progression battles in addition to the 

conventional turn-based battle format. 
 

About Time Progression Battles 

 
 
In time progression battles, actions are taken sequentially by actors whose gauges 

have been filled. 
 

A TP gauge is displayed for each actor. The TP gauge gradually fills, and actors whose 
gauges have reached 100% select an action sequentially. 

 
After their action, the TP gauge is reduced to 0 and begins to fill once more. 
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How to Switch to Time Progression Battles 

 
 
When using time progression battles, you will make your configurations in [System 1] 

in the database. Please view [System 1] → [Battle System] for more information. 
 

Animations 
 

 

file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_08_12_01.html%23p01
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The animation editor has been overhauled, allowing you to use 3D particle effects 
(hereafter "effects"). 

 

Select an effect in the new editor and configure its sound and flash. 
 

Animations configured here can be selected using [Show Animation] for items, skills, 
weapons, and event commands. 

 
Please see [Database] → [Animations] for more details. 
 

Effekseer 

 
When creating animation effects yourself in RPG Maker MZ, you'll use the effect 

creation tool "Effekseer". 

 
Please see [Database] → [Animations] → [Effekseer] for more details. 

 
 

Improvements to Artistic Expressions in Games 
 

Improvements have been added to various areas of RPG Maker MZ, allowing for more 
diversity in artistic expression within your games. 

 

Character Generator Improvement 

 
 

 

file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_10_07.html%23p04
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_08_09.html
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_08_09_01.html
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By adjusting parts and colors in the "Character Generator", which combines parts to 
create character graphics, users are capable of more varied character creation. 

 

Added color palette functionality and part adjustment using offsets allow you fine-tune 
characters. 

 
Please see [How to Use Aid Tools] → [Character Generator] for more information. 

 
Map Layer Selection Function 

 
 

 
Switch layers in map editing mode. 

Select an individual layer in order to edit the map without affecting other layers. 
 

Please see [Editing Map Designs] → [Other Editing Functions] → [Map Layer Selection 

Function] for more information. 

 
"Just Prior" Variable Operand 

A new item, "Just Prior", has been added under [Control Variables] > [Operands] > 
[Game Data] for event commands. 

 

file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_05.html%23p05
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_07_01.html%23p03
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_07_01.html%23p03
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You can easily create event development that corresponds to an action taken 
immediately prior. 

 

For example, you can use it to create an enemy that has different dialogue upon dying 
if they are killed using a specific skill. 

 
Please see [Event Commands] → [Control Variables] for more information. 
 

Database Improvements 

More settings relating to new elements and game screens have been added to the 
database. 

 

Skill & Item Improvements 

You can now create more varied skills and items. 

 
[Scope] Overhaul 

 
A special dialog box has been added to "Scope", which is used to select a target. 

 
Please see 

 
[Database] → [Skill Settings] → [Basic Settings: Scope] 

[Database] → [Item Settings] →［Basic Settings: Scope］ 

 
for more information. 

 
Multiple Execution for Effect "Common Events" 

 
If multiple effect "common events" are configured, all configured common events will 

now be able to be executed. 
 

Please see [Database] → [How to Set Effects] → [Other] Tab] for more information. 
 

Add "Attack Skills" 

 
 

file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_10_02.html%23p02
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_08_03.html%23m01
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_08_04.html%23m01
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_08_16.html%23m01
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[Attack Skills] that can be configured to actor and weapon [Traits] have been added. 
You can add skill effects to regular attacks. 

 

By configuring the newly added trait "Attack Skill", the skill you set is activated by the 
attack command. 

 
You can use this to create weapons that, when equipped, activate a skill different from 

standard attacks when used. 

 
Troop Screen ID Display 

 
 
Enemy IDs will now be shown when selecting enemies placed in a troop. 

 
When multiple enemies are placed in a troop, you can confirm their IDs by simply 

selecting a placed character. This is convenient when entering target IDs into plugin 
commands, among other situations. 

 
Added System Items 

Database system items are split into two pages, [System 1] and [System 2], with an 
increase in available configurations. 

 
Additionally, existing configuration options were adjusted for easier use. 

 
Main Changes 

 
• Title Screen 

You can now configure the command window type and position. 
 

• Battle System 

Time progression was added. 
 

• Options 
[Show TP in Window], [Show Number of Key Items], and [Enable Autosave] were 

added. 
 

• Advanced Settings 
Various configurations such as game screen resolution and font size are now 

available. 
 

Please see [Database] → [System 1] [System 2] for more details. 
 

file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_08_12_01.html
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_08_12_02.html


 
20/258 

 

Event Command Improvements 

Improved "Show Text" 

 

 
 
You now have greater capacity for artistic expression in text using the event command 

"Show Text". 
 

• "Name" was added, which allows you to display the name of the speaker at the 
top of the message screen. 

• The PX, PY, and FS control characters were added, allowing you to have greater 
control over the details of text displays. 

• [Insert Color Number] and [Insert Icon Number] are now available by right 
clicking in the text input field. 

 

Please see [Event Commands] → [Show Text] for more information. 

 
[Easing] Added to [Move Picture] 

 

[Easing] was added to the [Move Picture] event command. 
 

Please see [Event Commands] → [Move Picture] for more information. 
 
 

Addition of Conditional Branches for Touch & Mouse Controls 

 
You can now make more detailed configurations to [Conditional Branch] event 

file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_10_01.html%23p01
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_10_08.html%23p02


 
21/258 

 

command button controls. 
 

Conditional branching using 'long press' and other controls is now available. 

 
Please see [Event Commands] → [Conditional Branch] for more information. 
 

 

Various Plugin Additions 

In RPG Maker MZ, you can introduce/expand different functions by installing files 

known as plugins. You can create your own as well, but the software includes a variety 
of built-in plugins. 
 

Please see [Documentation] → [Using Official Plugins] for more information. 
 
 

Improved Ease-of-Use 

Other helpful functions have been added, with features that assist with version 
management and configuration error prevention included in the program. 
 

Editor MZ Version Management 

By selecting [Core Script Update] from [Game] in the main menu, you can upgrade or 
downgrade the core script. 

 
Plugin Command Improvements 

The [Plugin Command] event command has been improved, allowing for easier input of 
plugins with plugin commands. 

 
Movement Route Preview Display 

A preview button has been added to the [Set Movement Route] event command. You 
can configure routes while checking movement. 

 
Display of Coordinates When Selecting Transfer Player 

When selecting "Location" such as in the "Transfer Player" event command, coordinates 

will now show when the dialog box is displayed. 
 

Preview Function for Show Balloon Icon 
A preview function was added to the "Show Balloon Icon" event command. You can 

make configurations while checking the balloon animation. 
 

Prevention of Erroneous Number Input 
When a full-width number has been entered into a number input field, it will 

automatically be converted and entered as a half-width character. 
 
 

Game Control Improvements 
 
RPG Maker MZ also improves on functions from a player perspective. Players will more 

easily understand the appeal of the games you create. 
 

file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_10_03.html%23p01
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_11_05.html
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Improved Smartphone UI 

UI improvements were implemented to allow for easier play even when using touch 

controls with a smartphone or other device. 

 
• Optimized menus for dual PC/smartphone use 

• Scroll function via window swipe 
• Touch-selectable targets in battle 

 
Official plugins usable with touch controls have also been included. You can create 

games centered more around touch controls. Please see [Documentation] → [Using 
Official Plugins] for more information. 
 

 
 

Autosave Function 

The topmost save slot will be used as the autosave slot and the game will be 
automatically saved at the end of a battle and when the player is transferred. Even if 

the game is suspended for some reason, the player can restart from the autosave. The 

autosave function can be disabled from the settings in [Database] → [System 1]'s 
[Options]. 
 

 

 

file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_11_05.html
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_11_05.html
file:///D:/Documents/DIVERS/Developpements/-%20jeux%20vidÃ©o/RPG%20Maker%20MZ/help-en/01_08_12_01.html%23p01
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Distinction Between Creations via "Game ID" 

In RPG Maker MZ, it is possible to distinguish between creations using Game ID.  

 

Save data can be transferred when a game published in the browser is updated even 
when the game title is changed. 

 
You can check the game ID from [Database] → [System 2] → [Advanced Settings]. 
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System Requirements 
 
The system requirements for this software are as follows. 
 

Operating 

Systems Windows 8.1/10/11 (64bit) or macOS 10.13 or later 

CPU Intel Core i3-4340 equivalent or greater (2013 4th gen) 

RAM 8GB or more 

HDD 8GB or more of free disk space 

Graphics 
Card VRAM 1GB or greater, with OpenGL support 

Display Resolution of 1280x768 or greater 

 

An internet connection is required to perform network authentication. 

 
Specifications required to play the game smoothly vary based on the content of the 

game. 
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Getting Started Making Your Game 

 
Creating a Project 

 
In order to start making your game, you first need to create a "Project". A project 

contains all the data and assets which compose a game. You can also import your 
own files such as images and music and use them in your project. 

 

The way to create a project is as follows. 
 

(1) Creating a New Project 
 

Click the [New Project] button on the toolbar or select [New Project] option found 
under [File] in the menu bar. 

 
(2) Entering a save location and title 

 
Enter the project name (half-width alphanumeric characters are recommended), and 

enter the name of your game under [Game Title]. The project’s save location will be 
displayed under [Location]. To change the save location, click the [Choose... ] button 

to the right and specify a new save location. 
 

After setting the above and clicking [OK], a sample game will be created using the 

settings, and you will be able to start making your game. 
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Managing Projects 
 

Saving/Loading a Project 

When taking a break from making your game, make sure to save the project and 
close the program. When you click the [Save Project] button (or go to [Save Project] 

under [File]), the contents of the project you are currently editing will be overwritten 
and the project will be saved. 

 
To resume making your game, click the [Open Project] button (or go to [Open 

Project] under [File]), and select the [Game] file (or [Game.rpgproject]) and click 
[Open]. 

 
Backup/Deletion 

The contents of a project will be saved to the folder that you chose when creating a 
new project. Copy the entire contents of this folder and save on a flash drive or other 

device to backup your project. When you no longer need a project, delete the folder 
as you normally would. 

 

Moving on to Creating Your Game 
 

RPG games, the type of game made using this software, are made up of various 
components such as images on the Play Screen, the characters that players can 

control, item and magic settings, attacks and the story. 
 

In this software, these elements are made using the three types of data which are at 
the core of your game: the [Map], which is the setting for your game, [Events] which 

represent what occurs in the game and the [Database] which determines the 
settings for things such as characters. 

 
There is no particular order to creating a game. If this is your first time making a 

game using this software, it is recommended that you start from learning how to 
make a map. Following which you can then prepare the events and characters to fit 

the contents of the game you want to make. 
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Basic Editor Controls 
 
Names and Functions of Each Window Component 

 
The screen which appears after opening a project is called the "Main Window". The 

Main Window is primarily used to edit the map and events. Tools such as the 
[Database] are opened from the Main Window menu. The functions of each 

component are as follows. 
 

 
 

1. Menu Bar 
Functions available in this software are selected from here. 

 
2. Toolbar 

The specified function can be run from clicking its button. 
 

3. Tile Palette 
Tilesets which can be placed on the map are displayed here. You can switch to 

Set/Region Editor Mode using the tabs below. 

 
4. Map List 

A list which shows Map data included in the game currently being created. 
 

5. Map View 
Displays the contents of the map that is currently selected. It is used for things such 

as editing designs and specifying placement of events. 
 

6. Status Bar 
Displays details of the function that is currently selected, the map name and map 

coordinates. 
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7. Layer Button 
Switches layers in map editing mode. 

 

8. Quick Access 
Adding a map you use frequently will allow you to create more efficiently. 

 
To edit your Quick Access list, right click on the map tree, then select "Add to Quick 

Access" or "Remove from Quick Access". Items can also be removed by right-clicking 
the item on the Quick Access list. 

 
Editing Parameters 

 
Adjusting the parameters available in the various windows of the things you want to 

make, and specifying things such as text and items is at the core of the creation 
process when creating games using this software. The different types of items you 

can set and how to edit them are as follows. 
 

Text Input 

 
Click the settings field and a "|" cursor will be shown. You can enter text using a 

keyboard while the cursor is in this state. Entered text will be inserted at the cursor's 
position. You can also move the cursor using the keyboard's arrow keys. The text 

input method will depend on the input method (IME) you're using for your language. 
 

Number Input 
 

Just as with text input, click the settings field and a "|" cursor will be shown. You can 
enter half-width numbers using a keyboard while the cursor is in this state. You can 

also click the [∧] and [∨] buttons to the right of the field to increase or decrease the 

value. 
 

Radio Buttons 
 

Radio buttons specify one item to be applied from multiple items. Click a circle. 
When it is filled in, that setting is enabled. 

 
Check Boxes 

 
Specifies if a setting indicated by the item name is enabled or disabled. Click the 

square. When it is filled in with a check mark, that setting is enabled. Click again and 

the check mark will disappear. 
 

Drop-down Lists 
 

Specifies one item from the items shown in the list to be applied. Click the [∨] to the 

right of the settings field to open it. 

 
List Boxes 

 

A list box shows a list of multiple settings. Double click an item to open a window 
where you can add or change content. 
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[...] Button 
 

The content of items with a [...] to the right of the settings field is specified in a 

separate window. Click the [...] and make your configurations in the window that 
appears. 

 
[OK], [Cancel], and [Apply] Buttons 

 
Changes to settings are enabled once you confirm them. Click [OK] to confirm and 

close the window, click [Cancel] to discard your changes and close the window, or 
click [Apply] to confirm without closing the window. 

 
Searching via a Context Menu 

 
The context menu can be opened by right clicking on a map or database. From 

there, you can select the [Search] option. 
 

 
 

The [Find] window will then open. After searching once, you can select [Find Next] or 
[Find Previous] to continue searching for the same text. 
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Menu Bar Content 
 

 
 

Details regarding the items found in the Menu Bar in the Main Window are as follows. 

 

[File] Menu 
 
New Project 

 
Creates a new project. If a project is already opened, it will be closed upon creating 

a new project. 

 
Open Project 

 
Opens a saved project, allowing you to edit your game. Select your [Game] (or 

[Game.rpgproject]) file by selecting it inside its project folder using the [Open] 
window. 

 
Close Project 

 
Closes the currently opened project. A confirmation window will appear if there is 

data which has not been saved. Click [Yes] to close the project after saving and click 
[No] to close the project without saving. 

 
Save Project 

 

Overwrites the contents of the project you are currently editing. 
 

Deployment 
 

Builds your project in the platform format selected. For more information, please 
view [Output Formats]. 

 
Close RPG Maker MZ 

 
Closes the program. Just like [Close Project], a confirmation window will appear if 

there is any unsaved data. 
 

[Edit] Menu 
 
Undo 

 
Allows you to undo the action that you just performed and return the project to its 

previous state as it was 1 step prior. You can undo up to 20 actions. 
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Cut 
 

Deletes data which you have selected such as map data and map events and copies 

it to the clipboard. 
 

Copy 
 

Copies data such as map data and map events to the clipboard. 
 

Paste 
 

Adds the contents of the clipboard as new map data and map events. 
 

Delete 
 

Deletes data such as the map data and map events you have selected. 
 

[Mode] Menu 
 
Map 

 
Switches to the Map Design Editor Mode. 

 
Event 

 

Switches to the mode that allows you to create and edit map events. 
Lines which are determined by the size of tiles are displayed in the Map View. 

* Select the [R] tab in the Tileset to enter the Region Editor Mode where you can 
define the region where enemy groups will appear (areas where you encounter 

enemies). 
 

[Layer] Menu 
 
Switches layers in map editing mode. You can select an individual layer to edit the 

map without affecting other layers. 

Please see [Editing Map Designs] → [Other Editing Functions] → [Map Layer 
Selection Function] for more information. 

 

[Scale] Menu 
 

Zoom In 
 

The Map View will get bigger each time you select Zoom In. 
 

Zoom Out 
 

The Map View will get smaller each time you select Zoom Out. 
 

Actual Size 
 

Displays map in standard size (displays at same magnification) 
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[Tool] Menu 
 
Database 

 
Opens the settings window for the [Database] where you can create/edit elements 

such as your characters and items. 
 

Plugin Manager 
 

You manage your plugins here. For more information, please view [How to use Aid 

Tools]. 
 

Sound Test 
 

You can play test sounds loaded as asset files in your project. For more information, 
please view [How to use Aid Tools]. 

 
Event Searcher 

 
You can search for events using various conditions. For more information, please 

view [How to use Aid Tools]. 
 

Character Generator 
 

Combine pre-made parts to make face graphics, walk characters, and battlers. For 

more information, please view [How to Use Aid Tools]. 
 

Resource Manager 
 

you are able to manage resources included in your project. Please see [How to use 
Aid Tools] for more information. 

 
RPG Maker MV Tools 

 
Organize tools to help you create games in RPG Maker MV. Please see [How to use 

Aid Tools] for more information. 
 

[Game] Menu 
 
Playtest 

 
Starts a Playtest of your game. For more information, please view [How to use Aid 

Tools]. 
 

Skip Title Screen 
 

If the check is turned on, the game always starts with a New Game. 

 
Open Folder 

 
Opens the folder where your project is saved. Use this when you want to check the 
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location of your project folder or when you want to manually move files in your 
project folder. 

 

Update Core Script 
 

You can update the version of the core script. 
 

[Help] Menu 
 

About 

 
Displays the Help window (this window). 

 
RPG Maker Website 

 
Accesses the RPG Maker website https://www.rpgmakerweb.com  

 
Tutorial 

 
Starts a tutorial. Please see [How to Use Aid Tools] for more information. 

https://www.rpgmakerweb.com/
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How to Use Aid Tools 
 
Plugin Manager 

 
With the [Plugin Manager] tool that you can open by going to [Tools] → [Plugin 

Manager], you can manage official plugins and ones that you have created.  
 

 
 
When you click on a plugin displayed in the list, a dialog window will appear where 

you can change their ON/OFF switches and parameter values. 

 
(see image on next page) 
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Click one of the plugin parameters to open the menu. 

 

You can make edits to plugin parameters on the [File] and [Text] tabs. 
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When entering parameter values, right-click to show the menu and choose [Insert 
Icon Number] to display the IconSet Viewer. 

 

 
 
 

Right-click [Search] or press Ctrl+F (Cmd+F for Mac) at the plugins management 
screen to bring up the search function for the plugins list. 

 

 
 
 

Press Ctrl+F (Cmd+F for Mac) in the [Plugin Settings] window to bring up the search 
function for plugin help. 
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Sound Test 

 
With the [Sound Test] tool that you can open by going to [Tools] → [Sound Test], 

you can test the sound of music and sound files which are included in your project. 
Music will continue playing even after you close the window so you can use it to play 

background music as you are making your game. 
 

The window is divided into 4 tabs: BGM (background music), BGS (background 
sound), ME (music effects) and SE (sound effects). You can assign music by clicking 

on the song in the File List of each tab. When you press [Play] the music will begin to 

play. Click [Stop] to stop the music. 
 

You can adjust the Playback Volume (0 to 100%), Pitch (50 to 150%) and Pan (-100 
to 100) by using their respective sliders. 

 
 
(see image on next page) 
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You can also play the music by pressing the space bar. 

 

Event Searcher 
 

With the [Event Searcher] tool which can be opened by going to [Tools] → [Event 
Searcher], you can search events by their switches, variables and names and display 

them in a list. 
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Character Generator 
 

Open this tool by clicking on [Tools] → [Character Generator]. Here you can make 

character images allocated for actors and events. 
 

 
 
 

Click on the [Male], [Female], or [Kid] tabs to change the screen, and choose the 
variation and color for each feature. Your selection will be displayed in the [Preview] 

area. 
 

Randomize 

 
Sets all the parts at random. 

 
Face Image 

 
Opens the export window for face images. 

 
Walk Character 

 
Opens the export window for walk characters. 

 
Damaged Character 

 
Opens the export window for damage characters. 
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Battler 
 

Opens the export window for side-view battlers. 

 
Save Settings 

 
Saves the settings of the character created. 

 
Load Settings 

 
Loads the saved character settings 

 

Export Window 
 

 
 
Import 

 

Loads a base image from a file and inserts a newly made image. 
 

Export 
 

Saves the image to a file. 
 

 
Generate Dungeon 

 
Right click the map data text in the Map List and select [Generate Dungeon] to open. 

 
When you select wall and floor tiles, a map will automatically be drawn in maze form. 
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The dungeon will be generated on your selected map, so be sure to increase the map 
size if you would like to make a large dungeon.  

 

If your map size is too small, you will not be able to make a very dungeon-like map. 
 

 

 
 

Type 
 

Choose between [Rooms] and [Maze] types. When you select [Rooms], a dungeon 
with rooms connected by passages will be generated. When you select [Maze], a 

dungeon with only passages will be generated. 
 

Options 
 

 
• Add Margins 

When selected, margins will be added to the bottom, top, right, left of the map. 

• Wide passages 
When selected, passages will be widened. 

 

https://play.google.com/apps/publish/signup/
https://play.google.com/apps/publish/signup/
https://play.google.com/apps/publish/signup/
https://play.google.com/apps/publish/signup/
https://play.google.com/apps/publish/signup/
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Wall 
 

Select tiles to be used on walls. 

Select from the A4 (Wall) tileset being used. 
 

Floor 
 

Select tiles to be used on floors. 
Select from the A5 (Floor) tileset being used. 

 
 

Playtest 
 

You can test play your game at any point during creation using the Playtest feature 

which can be executed by going to [Game] → [Playtest] in the Menu Bar. Using this, 
you can see whether or not settings and events run as intended upon the release of 

your game. 
 

 
 

Using the Debug Feature 
 

The Debug Screen will be displayed when you press F9 on the keyboard during 
Playtest. You can change switches and the values of variables currently displayed 
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using this screen. * Press [F9] or the cancel button while in the Debug Screen to 
return to the Playtest. 

 

To change the value of variables, select the target switch/variable (S at the top being 
the switch, V being the variable, and the number being the range of numbers), then 

click the action button, and a cursor will appear in the list on the right at the target 
switch/variable. The ON/OFF values for switches are changed using the action 

button, and variables are changed using the left and right direction buttons or L/R 
buttons. 

 
How to Use Developer Tools 

 
Press the F8 key during a Playtest to open Developer Tools.  

 
Developer Tools have the same function as those built-in to Google Chrome.  

 
You can check each element of the game constructed in HTML5. 

 

 
 
Quitting Playtest 

 
To quit testing your game, press the X button to close the window. 
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Resource Manager 
 

In [Resource Manager], under [Tools] → [Resource Manager], you are able to 

manage resources included in your project.  
 

Each function for the buttons and parts displayed in the window is explained below. 
 

To use your original files (including images/audio/etc.) in creating a game, you are 
required to follow the predetermined standard.  

 
Please refer to [Asset Standards] for more information. 

 

 
 

Folder List 
 

On the left side of the window, a list of folders containing resource files will be 
displayed. When importing a resource file, choose the folders according to your 

purpose of use. 
 

File List 
 

On the right side of the window, the list of files contained in the chosen folder will be 
displayed. 

 
Preview 

 

Displays the preview of the image file chosen under the [File List]. 
To check a sound file, use the tool [Sound Test]. 
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Import 
 

Imports project resource files. Click [Import] after choosing the folder location in 

[Folder List] and then choose the resource file to import. 
You can import multiple files at once by selecting multiple files. (April 21th, 2016 

Update) 
 

Export 
 

Saves a project resource file outside of the project. The exported resource file will 
remain in the project after exporting. 

 
Delete 

 
Deletes resource file chosen in [File List]. Be careful as deleted data cannot be 

recovered. 
 

You can delete multiple files at once by using the Shift key to select multiple files. 

 
DLC 

 
Imports project resource files from the extra contents stored in the DLC folder*. 

After pressing the button, the DLC folder will open and the applicable files will be 
indicated. 

 
*DLC Folder 

The DLC contents are stored in a subfolder where the RPGMZ executable file is 
located. When using the Steam version, after purchasing the DLC from the Steam 

store, the contents will be automatically added to the DLC folder. 
 

Options 
 

You can open the [Options] window by going to [Tools] → [Options]. Here, you can 

change the Transparent Color settings as well as the Map Grid settings. 
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Transparent Color 
 

Sets the color to use as the transparency background in the editor. 

 
Map Grid 

 
By checking off the [Show] box, the Map Editor grid will be activated. 

 
UI  

Theme 
Changes the appearance of the editor. 

 
Object Selector 

Choose an object selector for selecting in-game objects in the editor like Items, 
Weapons, Armors, and so on.  

 

［Dropdown］・・・Optimized for less than 100 objects. 

［Extended］・・・Optimized for hundreds of objects. 

［Smart］・・・Chooses one based on the amount of objects automatically. 

 
Tutorials 
 
You can see a list of available tutorials by opening [Help]→[Tutorial]. A Tutorial 

Selector windows is displayed. Choose the topic that you would like to learn more 
about, then click the StartTutorial button. 

 

 
 

Follow the on-screen instructions to proceed through the tutorial (in the example 
below, change the title name then click the [Next] button).  
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If you do not perform the actions the tutorial is expecting, you can stop the tutorial 

and start over. 
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Playing Your Game 
 
Basic Controls 

 

Running Your Game 
 
How you run a game made using this software changes depending on how the game 

is deployed. 
 

For Windows 

 
Double-click the executable file named [Game.exe] (or [Game]) found in the game 

data folder. 
 

For macOS 
 

Double-click the executable file named [Game.app] (or [Game]) found in the game 
data folder. 

 

Controls 
 

The standard controls for games created with this software use a 4-button game 
pad. Button names are based off the Xbox 360 Controller. Supported game pad 

buttons/keyboard keys and functions used in standard games are as follows. The D-
pad on the gamepad or the keyboard's arrow keys are used to control the movement 

of characters and the cursor. 

 
 

 

Controls Game Pad Keyboard Mouse Touch 

Movement D-pad Arrow keys, 
Num pad 

Click destination * Tap destination * 

OK A Z, Enter, 
Space 

Click target Tap target 

Cancel B X, Esc, Right click Tap with two 
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Num pad 0 fingers/cancel button 

Menu Y X, Esc, 
Num pad 0 

Right click Tap with two 
fingers/menu button 

Dash X Shift 
  

Previous page LB Q, Page up 
  

Next page RB W, Page down 
  

Scroll pages D-pad Arrow keys, 
num pad 

Drag from inside of page to 
outside of page/mouse scroll 
wheel 

Tap and hold as you 
swipe from inside of 
page to outside of page 

 
* Continue to click/tap and hold inside the screen when you move around the map to continue moving 

in that direction. 

 

Special Controls 
 

Key Function 

F2 Toggle FPS and Drawing Mode display 

F3 Toggle Stretch Mode 

F4 Toggle Full Screen Mode 

F5 Reload 

F8 Open developer tools (Playtest only) 

F9 Open Debug Screen (Playtest only) 

Ctrl + Arrow key Move through obstacles (Playtest only) 

Scroll wheel Scroll pages 

 
In-game Menu Controls 

 

Title Menu 
 

The title screen will appear when you run your game. Select from the below options 
to run. 

 
New Game 

 
Start a new game from the beginning. 

 

Continue 
 

Start from a previous save. Select Save Data. 
 

Options 
 

Adjust all settings related to the overall game such as BGM volume. 
 

Menu During Movement 
 
When a player is moving on the map, this menu is displayed when you press the 

Menu button (same as the Cancel Button except for gamepad). You can do things 
like use items which recover the state of actors, and save the game state while 
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playing the game using the commands on the upper left. Details for each command 
are as follows. 

 

Item 
 

Check/use items that your party possesses. To use an item, select it from the list 
(depending on the item, you may need to select the target actor to apply its effect). 

 
Skill 

 
Check/use skills (magic, etc.). To use an skill, select it from the list (depending on 

the skill, you may need to select the target actor to apply its effect). 
 

Equip 
 

Check/change equipment. When selecting an actor and changing its equipment, you 
will select both the equipment you want to change and the equipment you will 

change (or an empty item to remove the equipment). 

 
Status 

 
Check on an actor's status. Select the target Actor. 

 
Formation 

 
Change the order of your party members. 

 
Options 

 
Adjust all settings related to the overall game such as BGM volume. 

 
Save 

 

Save the current game state. Select where you wish to save from 20 different save 
slots. 

 
End Game  

 
Quits the game. Select either [To Title] or [Cancel] (cancels the operation). 

 

Battle Menu 
 

The game will switch to the Battle Screen upon encountering an enemy in the game. 
 

You can advance the battle by selecting the following commands. When all party 
members' HP1 reaches 0, this will result in a Game Over. 

 
 

 
1 HP : Health Points (or Hit Points) of a player. When HP reaches 0, the player dies (all foot notes are 

from the author of the present PDF document). 
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Party Commands 
 

Commands that display during each turn. Select [Fight] to continue the battle and 

[Escape] to run away from the enemy.  
 

However, if an enemy moves to attack you, only the enemy can do an action until 
that turn is over even if you select [Escape]. 

 
Actor Commands 

 
You will select each party member's action when you select [Fight] in the party 

commands. The primary actions are [Attack] (attack using the currently equipped 
weapon), [Guard] (protect oneself and reduce incoming damage) and Item (use 

currently owned items).  
 

The types of actions you can select depend on the actor's settings. 
 

Shop Menu 
 
At the shop you can buy and sell items, weapons, armor, etc. 

 
Buy 

 
When you select [Buy], items, weapons, armors, etc. that you can purchase are 

displayed. Select the item and item amount and press the OK button to buy. 

 
Sell 

 
When you select [Sell] and select [Item], [Weapon], [Armor], or [Key Item], the 

items you possess will be displayed.  
 

Select the item you wish to sell, enter the amount to be sold, and press the OK 
button to sell. 

 
Owned/Actors able to equip  

 
The number of selected items possessed is displayed in the right window. 

 
When buying weapons and armor, the party members are displayed and those who 

are unable to be equipped are grayed out.  

 
When you have 5 or more party members, you can use the dash button or click (tap) 

the right window to display the members beyond the 5th member. 
 

Entering Amount 
 

D-pad/arrow key Function 

Right +1 item amount 

Left -1 item amount 

Up +10 item amount 
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Down -10 item amount 

 
* When using with a touch device, you can change the amount and confirm your 

purchase by tapping the below buttons. 
 

 
 
Developer Tools 

 
The Developer Tools will be shown when you press the F8 key while test playing your 

game.  
 

Please see [How to Use Developer Tools] for more information.  
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Map 

 
What are Maps? 

 
Maps are the data that represent the setting for your game. Maps will unfold based 

on where a character moves on the map when playing the game. 
 

A map's design is edited by placing together parts used for composing your map 

called "Tiles". 
 

 
 

 

Map Basic Specifications 
 

Role of Tiles 
 

Tiles are images which give a map its appearance, and are configured to allow or not 
allow a character to move across that tile. 

 
In one map, multiple tiles grouped together assigned to be one piece of data are 

called a "Tileset", which is used as the basis of designing the shape of a map. You 

can instantly change the appearance of a map by changing the tileset you are using. 
The contents of a tileset can be edited using the [Database]. 
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Tile Classifications 
 

It is possible to include 5 types of tiles for A through E in one tileset. A is the lower 

layer which represents the terrain and ground, and B through E are upper layer tiles 
which represent surface elements such as trees and bushes or sign boards. 

 
It is possible to place an upper layer and lower layer tile on the same location on the 

map. By using this two-layer composition, it is possible to create a very detailed and 
intricate map. 

 
As a standard, tiles that represent things such as the ocean, grasslands, floors and 

walls are the lower layer tiles, and upper layer tiles used to decorate those layers are 
provided. 

 
Moreover, it is now possible to overlap two types of upper layer tiles allowing for 

more variation in this version. 
  

 
 

Map Size and Display Method 

 

The size of a map is measured in tiles, and can be set to have a width and height of 
0 to 256 tiles respectively. 

 

The number of tiles visible on a game when playing is 17x13 tiles at one time. For 
maps larger than this, the area displayed will automatically move centered on the 

position of the player (scroll processing). Moreover, by connecting the edges of 
maps, you can have settings where the map loops just as if it was a planet (loop 

processing). 
 

Map Positioning 
 

The position of tiles on the map is represented in [Map Coordinates]. The origin of a 
map is at the upper left corner at (0,0), and moving away from this point X tiles to 

the right becomes the X coordinate, and moving away from this point Y tiles down 
becomes the Y coordinate. For example, in a map which has a tile size of 100x100, 

the coordinates of the bottom right corner is (99,99). The map coordinates of the tile 
which is currently being edited will appear in the status bar. 

 

Map coordinates can be used in event commands which monitor the current location 
of your party and the locations where a party moves based on variables. 
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Editing Map Designs 
 

Basic Editing Methods 

 
Switch to Editing Mode 

 
To edit the design of your map, click the [Map] button on the toolbar (or [Mode] → 

[Map] in the menu) to switch to Editing Mode. 
 

Selecting Map Data 

 
Click to select the map data you wish to edit in the Map List found at the bottom left 

of the window. The design of the map will be displayed in the Map View on the left 
side.  

 
Selecting Tiles 

 
Click to select a tile that you will draw from the Tile Palette. The tile that is currently 

selected will have a white frame around it. Tiles displayed in the Tile Palette will be 
switched when you click one of the A through E tabs at the bottom. 

 
You can select multiple tiles at once to draw on by drag-selecting them on the Tile 

Palette.  
 

Selecting the Drawing Tool and Drawing 

 
You can select tools (the below 5 types) which can be used for drawing tiles by 

clicking them on the toolbar. Also, tiles will be drawn when you click or drag on the 
map display area (Map View) on the right side of the window. Each tool can also be 

selected from the [Draw] Menu. 
 

You can erase tiles that you have drawn by drawing transparent tiles. You can find 
the transparent tile in the upper left of the upper layer B tab. 

 

 Pencil 
Draws the selected tile in the spot that you have clicked. 

 

 Rectangle 
The selected tile will be drawn in a rectangular area produced by clicking and 

dragging the cursor diagonally with the beginning of the drag being the starting point 
and the end of the drag being the ending point. 

 

 Ellipse 
The selected tile will be drawn in a ellipse within a square area produced by clicking 

and dragging the cursor diagonally with the beginning of the drag being the starting 

point and the end of the drag being the ending point. 
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 Flood Fill 

Tiles will be drawn from the location of the tile you click and on all surrounding tiles 
of the same type that are connected. 

 

 Shadow Pen 

Add or delete shadows for things such as walls in the location you click. 
 

Eyedropper 
 

Right-click on Map View to copy an existing tile, then left-click to paste the copied 
content. Right-click and drag to select a range of tiles to copy. 

 
Other Editing Functions 

 
Autotile 

 
A feature called [Autotile] is included in the tiles displayed in the A tab of the Tile 

Palette. With autotiles, one type of tile contains several patterns, and the border of 
the tile will be adjusted automatically depending on how the tiles are placed. Tiles 

which have the autotile function are assigned to [A1] through [A4] in the database 

[Tilesets]. 
 

Moreover, you can temporarily disable the autotile function by holding [Shift] and 
drawing tiles or using the eyedropper. 

 
Autoshadows 

 
Within autotiles, by placing two or more tiles vertically, a shadow will automatically 

be drawn to the bottom right of that tile. However, specified tiles will not have 
shadows drawn on them. 

 
Shadow Pen 

 
The Shadow Pen is a tool that allows you to draw shadows for walls and buildings. 

You can darken the hue by 1/4th of the size of a tile. Click the [Shadow Pen] button 

on the toolbar (or go to [Draw] → [Shadow Pen] in the menu), and click on the Map 
View. A shadow is drawn by clicking on a part which has no shadow, and by clicking 

a part which already has a shadow, that shadow will be removed. 
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Upper Layer Tile Special Specifications 

 
You can layer 2 different types on the upper maps B-E. 

 
* When layering a 3rd tile, the 1st upper tile will disappear. 

* When the 3rd tile layered is the same as the 2nd tile, the first tile will not disappear. 
* Only the upper left B tile can erase all upper tiles. 

 
When a passable tile and an impassable tile are layered, the effect of the tile layered 

last takes priority. 
 

* Even when a passable ☆ tile is on the bottom, the tile with the ☆ will be displayed 

on top. 

* When a passable ☆ tile is layered, the impassable tile's effect will take priority. 

 

Lower Layer Tile Special Specifications 

 
Amongst the tiles that are displayed in the [A] tab of the Tile Palette, those items 

found in [A2] in the tileset properties are divided into [Base] (tiles 1 to 4 from the 
left, or the left half) and [Decoration] tiles (tiles 5 to 8 from the left, or the right 

half). Decoration tiles can be placed on top of base tiles.  
 

However, for those [Tilesets] which have their [Mode] set to [World Type] in the 
tileset properties, when placing a decoration tile that is stacked on a 2nd or 4th base 

tile, the base tile will change either the 1st or 3rd base tile. 
 

Map Layer Selection Function 
 

Switches layers in map editing mode. You can select an individual layer to edit 
without affecting other layers.  

 

While it is usually possible to create maps using [Auto], using each layer for separate 
purposes allows you to fine-tune your map. 

 
When a layer is selected, the tile placed on the selected layer will be highlighted. 

 
Since only the highlighted tile can be edited, you can use it in situations such as 

when you want to make batch changes only to the lower layer after placing 
decorations using upper layer tiles.  

 
The figure below shows tiles placed using [Auto] and [Layer 1].  

 
You can see that only the room's floor tiles are being changed in batch with the 

[Layer 1] settings. 
 
(see image on next page) 

http://source.android.com/
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 Auto : Automatically select layer when drawing the map. 

 

 Layer 1 : Layer 1 is selected. 

 

 Layer 2 : Layer 2 is selected. 
 

 Layer 3 : Layer 3 is selected. 

 

 Layer 4 : Layer 4 is selected. 
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Map Data Controls 
 
Controls via the Context Menu 

 
Right-clicking Map Data items in the Map List allows you to do things such as 

configure/change and copy. The functions of each item are as follows. 
 

Edit 
 

Opens the Settings Window for map data. For more information regarding items that 
can be configured, please view [Map Properties]. 

 
New 

 
Adds new map data. For more information regarding items that can be configured, 

please view [Map Properties]. 

 
Load Sample Map 

 
New map data is created based on sample data. Click the data name on the list in 

the window displayed, confirm the details and click [OK]. 
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Copy 

 

Copies map data to the clipboard. 

 

Paste 

 

Adds map data currently in the clipboard. 

 

Delete 

 

Deletes map data. 

 

Shift 

 

Shifts the placement of all tiles on the map. Specify the shift direction and number of 
tiles. 

 

Generate Dungeon 

 

Automatically generates a maze form map.  

 

Please refer to [How to Use Aid Tools] for more information. 

 

Save as Image 

 

Saves the currently selected map in an image format. 

 
Group Maps 

 
By dragging map data in the Map List onto other map data, the data will appear 

under the latter map data.  

 
Just like grouping the interior map of a building under the map of a town, it is 

convenient for grouping map data and managing it.  
 

By dragging a map which has been moved to the bottom to the folder containing the 
project name, you can move it to the highest layer. 

 
This hierarchical display only changes the way that things are displayed on the Map 

List.  
 

This will in no way affect the design and settings of the map. 
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Map Properties 
 
Data Settings 

 
The Map Properties Window will be displayed when you either create a new map or 

by right-clicking the map and selecting "Edit". In this window, you can edit things 
like the size of the map, tools used for designing, background music, conditions for 

encounters (when a battle starts) with troops and behavior of the game during 
gameplay. 

 
 

Parameter Details 
 

General Settings 
 

 
 
 

Basic Settings 
 
Name 

 
This is the name of the map. This property is just used in the editor (does not affect 

the game). 
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Display Name 
 

The name of the map that is displayed when the player is moving on the map. 

 
Tileset 

 
Specify tilesets to be used in the design of the map. 

 
Width/Height 

 
The size of the map. The [Width] and [Height] can be set from values between 0 and 

256 respectively. Parts which extend beyond the map when making it smaller after 
creation will be deleted. 

 
Scroll Type 

 
Determines how the map loops. When you set the map to loop, the edge pairs of the 

map that you designate will allow the player to loop from one edge to the other. 

 
No Loop 

There will be no looping. 
 

Loop Vertically 
The upper and lower edges of the map will be connected. 

 
Loop Horizontally 

The left and right edges of the map will be connected. 
 

Loop Both 
Both the upper and lower, and the left and right edges of the map will be 

connected. 
 

Encounter Steps (Enc. Steps) 

 
Determine the frequency of random encounters by setting the average number of 

steps a player walks on the map before an encounter occurs (1 to 999/per step 
equals the movement distance per tile). Set this value low when you want monsters 

to appear frequently. 
 

Disable Dashing 
 

When enabled, a player cannot dash on this map. 
 

Autoplay BGM/ Autoplay BGS 
 

When enabled, BGM (background music) and BGS (background sounds) will start 
playing automatically when the player exists on the map. Select the sound files for 

each that you wish to play. 

 
When the map and battle BGM is identical, the music will not stop when switching 

between screens. 
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Parallax Background 

 
An image that appears in the transparent part of the map. Select the file you want to 
use in the window that opens when you click the [...]. 

 
When you enable [Loop Vertically] or [Loop Horizontally], the background will scroll 

according to the movement direction of the player. Also, by setting the scroll to a 
value other than 0 (-32 to 32), it will automatically scroll. If it's a positive value, it 

will scroll left or up. If it is a negative number, it will scroll right or down. The higher 
the absolute value is, the quicker the scroll will be. 

 
When you enable [Show in the Editor], you can confirm the parallax background that 

you set in the editor. However, there are times when how it is displayed differs in the 
actual game. 

 
Also, when you add a "!" to the beginning of a parallax background image file name, 

the parallax will become 0. 

 

Memo 
 
Here you can freely add notes when creating your game. This property is just used in 
the editor (does not affect the game). 

 
Encounter 

 
This is the list of enemy troops that appear randomly when the player moves in this 

map. You can configure the following in the window that opens when you double-
click a blank row. When you right-click a troop that you have entered, you can 

perform actions such as Copy and Delete using the context menu. 
 

 
 

Troops 
 

Define the troops you want to configure. 
 

 



 
65/258 

 

Weight 
 

Set the order of priority (0 to 100) that troops appear as battle opponents when 

encountering enemies. The higher that a troop's weight value is, the higher its 
encounter will be when there are multiple troops configured. 

 
The encounter rate for troops will be calculated based on a percentage of the total 

weight of all troops.  
 

So for example, let's assume that Troop A's weight is 9, B's is 7 and C's is 4. In this 
case, Troop A's encounter rate is 9/20 (the total weight being 9+7+4), or 0.45. In 

other words, it has a 45% chance of appearing. Likewise, Troop B's is 7/20 or 35% 
and Troop C's is 20%. 

 
Scope 

 
Specifies the region where this troop will appear. Specify "Entire Map" when you 

want it to appear regardless of region.  

 
To have an enemy encountered only in a specified region, select "Specify by Region 

ID" and specify the region ID (up to 3 regions).  
 

Please refer to the section below to see how to set a region. 
 

Setting the Region 
 

The [Region] that you specify in the Encounter settings of the map indicate the 
region in which the troop appears.  

 
One map can be divided into 255 regions.  

 
To configure region settings, select the R tab for the Tile Palette to switch to Editing 

Mode.  

 
After doing so, click to select the region ID (1 to 255) on the upper left of the 

window, and by clicking on the Map View, you can configure the region of the tile in 
that position.  

 
Only one region ID can be assigned per tile. 

 
 
(see image on next page) 
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Database 

 
What is the Database? 

 
The database is the collection of all components that make up a game aside from the 

map and map events. Components such as the character that the player controls, 
items magic and more can be prepared as the following 15 types of data. 

 

Data excluding [System], [Types] and [Terms] will be prepared for each type that 
appears in the game. For example, you will create data for each piece of equipment 

such as "Health Potions" and "Keys", and configure characteristics such as their 
names, images and what effects they have when used. 

 

Actors The character that the player can control. 

Class Characteristics that you assign to the actor (traits, growth conditions, etc.). 

Skills Actions and special skills (normal attacks, special skills and magic). 

Item Items that the player owns (potions, keys, etc.) 

Weapons Equipment that actors use for attacking (swords, canes, bows, etc.) 

Armors Equipment that an actor uses for defense (armor, shields, accessories, etc.) 

Enemies Characters that fight against actors in battle. 

Troops Group of enemies that appear in game. 

States States for actors, enemies, etc. (Poison, Knockout) 

Animations Visual effects that appear during times such as when skills are used. 

Tileset Organization of tiles used when creating maps. 

Common Events Handles commonly used events. 

System 1 Basic settings for the overall game. 

System 2 Basic settings and advanced settings for the overall game. 

Type Configure Types for elements, skills, weapons, armors and equipment. 

Terms Text such as common game commands and parameters. 

 
 

Editing the Database 
 

Displaying the Edit Screen 
 

Contents of the database are edited in the [Database] window. To display the 

window, click the [Database] button on the toolbar (or go to [Tools] → [Database]). 
 

Organization of the Edit Screen 
 

You can select data according to data type using the side menu in the [Database] 
window. By clicking a button on the side menu and switching the screen, you can 

create and edit data. 
 

When editing data aside from [System], [Types], and [Terms] data, first click to 

select the data that you will edit using the data list on the left side of the window. 
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After doing so, by editing the details of the parameters that are organized on the 
right side of the window, you can define the characteristics of the data. 

 

By pressing [F4] or [F5] on the keyboard, you can switch between the previous and 
next data for data selected in the data list. 

 
Change Maximum 

 
To change the maximum number of a data item, click the [Change Maximum] button 

below the data list, and define the new number. 
 

The maximum number of animations and tilesets can go up to 1,000. Other data 
items can go up to 9,999. However, note that configuring too many items may cause 

movements to slow down or become unstable. It is highly recommended that you set 
a low but appropriate number that can be effectively utilized by the game being 

designed. 
 

When lowering the maximum number of data entries, all data with a number beyond 

the new limit will be deleted. 
 

Controls via the Context Menu 
 

A menu will appear when right-clicking an item in the data list, allowing you to copy 
that data. The details for controls related to each item is as follows. 

 
Copy 

Copy the parameter details of that data to the clipboard. 
When selecting while pressing the Shift key, you can copy multiple data 

entries. 
 

Paste 
Apply (overwrite) the parameter details in the clipboard to the data. All data 

for parameter details of data before performing this action will be lost. 

 
Clear 

Delete all data parameter details. 
 

Regarding Data IDs 
 

The numbers which appear at the front of each entry in the data list is its Data ID 
(unique number). This ID is used on occasions such as specifying data using 

variables that will be used in event commands. 
 

Utilizing the Notes Field 
 

For some data elements (actors /classes /skills /items /weapons /armors /enemies 
/states /tilesets), there is a [Note] field available. This is for freely taking notes when 

creating your game. As a rule, this will not affect the game, there are plugins where 

you can define additional data using the notes field. 
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Actor Settings 
 
This Data’s Role 

 
Data which represents the character that the player controls is the actor data.  

 
You can give each actor unique traits. 

 
Parameter Details 

 

 

 

Basic Settings 

 

Name 

 

[Name] is the actor’s name that is displayed during gameplay. If the name is too 

long, the player name may not be fully visible in game menus and in battle. 
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Nickname 

 

The nickname of the actor. This will be displayed on the status screen in the upper 

right. 

 

Classes 

 

The class which the actor belongs to. This will affect which skills can be used, which 

weapons can be equipped, which items can be used, etc. Specific details are edited 
in the [Class] tab. 

 

Initial Level/ Max Level 

 

[Initial Level] is the level of the actor at the start of game, and [Max Level] is the 
maximum level an actor can be. An actor will never level up beyond its [Max Level]. 

Either can be set from 1 to 99. 

 

Profile 

 

Introduction of the actor. This will be displayed on the lower portion of the Status 

Screen. 

 

Images 
 

Face 

Image displayed on the menu. 
 

Walking Character 
Image displayed on the Map Screen. 

 
[SV2] Battler 

Image displayed in the Battle Screen when in Side-view mode. 

 

Initial Equipment 

 

The equipment that an actor starts with at the start of the game. Select the 

equipment position for each piece from the pulldown list. Equipment which can be 
selected is limited to what their class is able to equip. Setting this to [None] will 

cause nothing to be equipped in that location. 

 

Traits 

 

The actor's unique traits. Define the details in the window that is displayed when 

double-clicking each row of the settings field. For more information please refer to 
[How to Set Traits]. 

 
2 Side-view. See Side-view Character Standards. 
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Memo 

 

Used to make notes while making your game. 

 
Right-click to show the menu and choose [Plugin Help...] to display the Plugin Help. 
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Class Settings 
 
This Data’s Role 

 
Class data compiles trait data pertaining to actor abilities. Actors must belong to a 

class. Things such as the way an actor levels up, how their parameters increase, and 
the skills they can acquire are determined based on class settings. It is also possible 

to assign actors unique class traits. 
 

 
Parameter Details 

 

 
 

Basic Settings 
 

Name 

 
Name of the Class. The class will be displayed in places such as on the Menu Screen 

and upper part of the Status List Screen. 
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EXP Curve 
 

Parameters for determining the EXP which is required for leveling up. When an actor 

acquires the needed amount of EXP for each level, that actor's level will increase 1 
level and their Skill Points will increase and they will acquire new skills. 

 
The EXP required is set based on the below 4 values in the window that is displayed 

when you click the [...] in the settings column.  
 

The EXP required for each level will be displayed in a list, and a graph will be 
displayed in the background in the [To Next Level] tab. It's a good idea to refer to 

this while setting your parameters.  
 

The total amount of EXP until reaching each next level can be viewed in the [Total] 
tab. 

 

 
 

Base Value 

The standard value for calculating necessary EXP. By lowering this value, the 
overall necessary EXP will decrease. 

 
Extra Value 

The designated value added to necessary EXP for each level. 
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Acceleration A 
Adjust the rate at which to increase the necessary EXP. By setting this value 

higher, the amount of necessary EXP will increase proportionately according to 

the increase in level. 
 

Acceleration B 
Adjust the rate at which to increase the necessary EXP. By setting this value 

higher, the rate of increase of necessary EXP will become larger primarily at 
higher levels. 

 
Parameter Curves 

 
The parameters for trait values for each level. The Parameter Settings window will 

open when you double-click a graph. Please refer to the [Setting Parameter Curves] 
mentioned later to learn how to set parameters. 

 
Learnable Skills 

 

Skills that an actor gets upon leveling up. Set the levels and skills acquired in the 
window that is displayed when double-clicking in a column. 

 
Traits 

 
Traits which you give to actors set to this class. For more information please refer to 

[How to Set Traits]. 
 

Notes 
 

Used to make notes while making your game. 
 

Right-click to show the menu and choose [Plugin Help] to display the Plugin Help 
information. 

 

Setting Parameter Curves 
 

In the [Parameter Curves] window, parameter values for each level are set based on 
the items below.  

 
By clicking the tab with the parameter's name, you can switch to the parameter that 

you want to edit.  
 

The value that you specify will be reflected when you click [OK] after you finish 
editing (changes will be abandoned when you press [Cancel]). 

 
(see image on next page) 
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Quick Settings 

 

The values set previously will be applied to the parameter values for all levels. There 
are 5 types of patterns listed [A] through [E], and each pattern will be applied by 

clicking that pattern's button. 
 

Level/Value 
 

Directly edit the parameters for each level. After specifying the level (1 to 99) you 
wish to edit in the [Level] box, specify the value (Max HP can be set from 1 to 9999, 

Max MP3 can be set from 0 to 9999, all others from 1 to 999) for that level in the 
[Value] box.  

 
Generate Curve 

 
The values of levels will be calculated automatically based on the values at level 1 

and level 99. 

 
Define the values (Max HP can be set from 1 to 9999, Max MP can be set from 0 to 

9999, all others from 1 to 999) at [Level 1] and [Level 99] in the window that 
appears when the [Generate Curve] button is clicked. 

 

 
3 MP : Magic Points (or Manana Points). Magic or Mana is an attribute assigned to characters within a role-

playing or video game that indicates their power to use special magical abilities or "spells". Magic is usually 

measured in magic points or mana points, shortened as MP (Wikipedia). 
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Next, decide the Growth Type using the slider. The rate of growth (the amount at 
which parameter values increase) when set to the left (Fast) will become lower when 

leveling up, and will become higher when set to the right (Slow). When you click 

[OK], parameters will be set based on what was specified. 
 

Graph 
 

The parameter values for each level will be displayed in a bar graph. By clicking or 
dragging within the displayed area, you can get the value for parameters for level in 

the location clicked. 
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Skill Settings 
 
This Data’s Role 

 
This is data that defines the actions an actor takes during battle, such as fight, 

guard, magic, and special attacks. It is possible to create all kinds of actions by 
configuring the states and conditions when actions can be performed, success rate, 

the damage dealt to the target, etc. 
 

Parameter Details 
 

 
 
Basic Settings 
 
Name 

 
Name of the skill. If the name of a skill is long, it may not be completely displayed 

on the Play Screen. 
 

Icon 
 

Image which appears together with the skill name during gameplay. You can select 
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any image of your choice in the [Select an Image] window that appears after double-
clicking on the icon's image. It is typical to select an image that corresponds to 

characteristics of the skill. 

 
Description 

 
A description of the skill that appears during gameplay when the cursor is over it. 

 
Skill Type 

 
Specify the Skill Type. [Magic] and [TP Skills] are setup by default, however you can 

change this in the [Terms] settings. For those settings that were configured to 
something other than [None], the effects of each [Additional Skill Type] can be used 

only by those actors and classes given the skill. 
 

MP Cost/TP Cost 
 

The MP (0 to 999) and TP (0 to100) cost when a skill is used. An actor cannot use a 

skill if they do not have enough MP or TP. 
 

Occasion 
 

Select the state when a skill can be used. Select one of the following: [Always] 
(possible to select both in battle and in the Menu Screen), [Battle Screen] (only 

selectable during battle), [Menu Screen] (only selectable in the Menu Screen) and 
[Never].  

 
Scope 

 
The scope of the effect of the skill. You must choose one for each of the following. 

 

 
 

Side 

 
Specify the target. You can select from Enemy, Ally, Enemy & Ally, User, or None. 

 
Number 

 
Specify the number of targets. You can select from One, All, or Random. 
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Status 
 

Specify the target conditions. You can select from Alive, Dead, or Unconditional. 

 
Can only be set for allies. 

 

Activation 
 
Speed 

 

The value (between -2000 and 2000) added to an actor's Agility when using a skill. 
Affects the action order during battle, meaning that they can be effects which are 

small but can be used quickly, big but take time to use. 
 

Success 
 

The rate of success (0 to 100%) when using a skill. The effectiveness of the target 
affects the actual rate of success. 

 
Repeat 

 
The number of times (1 to 9 times) an effect is applied when used once. 

 
TP Gain 

 

The amount of TP gained after applying an effect to a target after used successfully. 
 

Hit Type 
 

Determines the type of hit. You must choose one of the following. 
 

Certain Hit 
Treats the successful use of a skill as a hit. Counterattacks, Counter Magic and 

substitutions are ineffective. 
 

Physical Attack 
Determines the success based on the user's hit rate and the evasion rate of the 

target. Counterattacks, and substitutions are applicable. 
 

Magic Attack 

Determines the success based on magic evasion rate of the target. Counter 
Magic and substitutions are applicable. 

 
Animation 

 
Animations that appear on the target of the skill used during battle. 

 

Message 
 
Assign a fixed phrase (up to 2 lines) that appears during battle when a skill is used. 
The "%1" will be replaced with the name of the skill when used. You can input a fixed 



 
80/258 

 

phrase by pressing either the [casts *!] button, [does *!] button or the [used *!] 
button. 

 

Required Weapon 
 

Weapon Type 1/Weapon Type 2 
 

The weapon needed as a condition for using a skill. Specify the weapon type in the 
two lists. If both are set to [None], a skill can be used without any requirements. 

When selecting two types, a skill can be used when one of either type of weapon is 

equipped. 
 

Damage 
 
Specify the formula for the type of effect and the amount of effectiveness if a skill 

damages a target. 
 

Type 
 

Effect types related to HP and MP. Select one open from 6 different types. [Damage] 
decreases, [Recover] increases, and [Drain] transfers (removes a small amount from 

target and gives to user). 
 

Element 

 
The element that is assigned to an effect. 

 
Variance 

 
How much the effectiveness of a skill varies (0 to 100%). Raise or lower the 

calculated effectiveness within the specified percentage. If the effectiveness is 100 
and the variance is 20, the effectiveness will be a value between 80 and 120 

(100±20). 
 

Critical Hits 
 

Specify whether or not an attack can critical or not by selecting [Yes] or [No]. When 
selecting [Yes], the chance of landing a critical attack will be determined based on 

the Critical Chance of the user and the Critical Evasion Rate of the target. 

 
 

 
Formula 

 
Formula for determining the effectiveness. 

 
Determine the referenced parameter using the strings below when entering a 

formula directly. Change "x" to "a" when referring to a value of the attacker, and "b" 
when referring to a value of the target. Entering "a.atk" refers to the attack power of 

the attacker. Additionally, you can reference the "n" variable's value by entering 
"v[n]". You can use the 4 basic arithmetic operator (+, -, *, /) symbols when writing 

M 
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your formula. 
 

When you enter "a.atk * 4 - b.def * 2", the value for the effectiveness of a skill will 

be calculated as "(Attacker's Attack Power x 4) - (Target's Defense x 2)". 
 

Also, since the effectiveness of a skill can change depending on the element and 
defense actions, these factors will not be included in the formula. 

 

x.atk Attack Power 

x.def Defense 

x.mat Magic Attack 

x.mdf Magic Defense 

x.agi Agility 

x.luk Luck 

x.mhp Max HP 

x.mmp Max MP 

x.hp Current HP 

x.mp Current MP 

x.tp Current TP 

x.level Level 

 

 

Effects 
 
Details of effects aside from damage. These can be set in the [Effects] window that 
appear when double-clicking in the list. For more information, please refer to the 

[How to Set Effects] section. 

 

Notes 
 
Used to make notes while making your game. 
 

Right-click to show the menu and choose [Plugin Help...] to display the Plugin Help. 
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Item Settings 
 
This Data’s Role 

 
Item data are those things which represent goods other than equipment. You can 

add effects that occur when an actor uses an item. Also, you can create items which 
are needed to progress the story (event contents) such as keys that open doors. 

 
 

Parameter Details 
 

 
 
Basic Settings 
 
Name 

 
Name of the item. If the name is long, it may not be completely displayed on the 

Play Screen. 
 

Icon 
 

Image which appears together with the item name during gameplay. You can select 

https://code.google.com/p/cld2/
https://code.google.com/p/cld2/
https://code.google.com/p/cld2/
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an image in the [Select an Image] window that appears after double-clicking on the 
icon's image. 

 

Description 
 

The description that appears when an item is selected in the Play Screen.  
 

Price 
 

This is the price of the item when purchasing it in a shop. The price when selling an 
item will be half of its original price. You can set it so it cannot be sold by setting this 

value to zero.  
 

Consumable 
 

This parameter determines whether or not an item disappears after being used. If 
you set this to [Yes], the quantity of this item will go down by one every time it is 

used. 

 
Occasion 

 
The state in which an item can be used. Select one of the following: [Always] 

(possible to select both in battle and in the Menu Screen), [Battle Screen] (only 
selectable during battle), [Menu Screen] (only selectable in the Menu Screen), 

[Never].  
 

Item Type 
 

The type of item. 
 

[Key Item] 
Displayed in a different frame from regular items in the item menu during 

gameplay. 

 
[Hidden Item A] and [Hidden Item B] 

These are not displayed on the item screen. These are special items that are 
only displayed when selecting items during events. 

 
Scope 

 
The scope of the item's effect. You must choose one of the following. 

 
Side 

Specify the target. You can select from Enemy, Ally, Enemy & Ally, User, or 
None. 

 
Number 

Specify the number of targets. You can select from One, All, or Random. 

 
Status 

Specify the target conditions. You can select from Alive, Dead, or 
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Unconditional. 
 

Can only be set for allies. 

 

 
 

Activation 
 
Speed 

 
The value (between -2000 and 2000) added to an actor's Agility when using an item. 

Affects the action order during battle, meaning that they can be effects which are 
small but can be used quickly, big but take time to use. 

 
Success 

 
The rate of success (0 to 100%) when using an item. The effectiveness of the target 

affects the actual rate of success. 

 
Repeat 

 
The number of times (1 to 9 times) an effect is applied when used once. 

 
TP Gain 

 
The amount of TP gained after applying an effect to a target after used successfully. 

 
Animation 

 
Animations that appear on the target of the item used during battle. 

 
Type 

 

Effect types related to HP and MP. Select one open from 6 different types. [Damage] 
decreases, [Recover] increases, and [Drain] transfers (removes a small amount from 

target and gives to user). 
 

Elements 
 

The element that is assigned to an effect. 
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Hit Type 
 

Determines the type of hit. 

 
Certain Hit 

Treats the successful use of a skill as a hit. Counterattacks, Counter Magic and 
substitutions are ineffective. 

 
Physical Attack 

Determines the success based on the user's hit rate and the evasion rate of the 
target. Counterattacks and substitutions are applicable. 

 
Magic Attack 

Determines the success based on magic evasion rate of the target. Counter 
Magic and substitutions are applicable. 

 

Damage 
 
Specify the formula for the type of effect and the amount of effectiveness if a skill 

damages a target. 
 

Type 
 

Effect types related to HP and MP. Select one open from 6 different types. [Damage] 
decreases, [Recover] increases, and [Drain] transfers (removes a small amount from 

target and gives to user). 
 

Elements 
 

The element that is assigned to an effect. 
 

Variance 

 
How much the effectiveness of an item varies (0 to 100%). Raise or lower the 

calculated effectiveness within the specified percentage. If the effectiveness is 100 
and the variance is 20, the effectiveness will be a value between 80 and 120 

(100±20). 
 

Critical Hits 
 

Specify whether or not an attack can critical or not by selecting [Yes] or [No]. When 
selecting [Yes], the chance of landing a critical attack will be determined based on 

the Critical Chance of the user and the Critical Evasion Rate of the target. 
 

Formula 
 

Formula for determining the effectiveness. 

 
Determine the referenced parameter using the strings below when entering a 

formula directly. Change "x" to "a" when referring to a value of the attacker, and "b" 
when referring to a value of the target. Entering "a.atk" refers to the attack power of 

M 
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the attacker. Additionally, you can reference the "n" variable's value by entering 
"v[n]". You can use the 4 basic arithmetic operator(+, -, *, /) symbols when writing 

your formula. 

 
When you enter "a.atk * 4 - b.def * 2", the value for the effectiveness of an item will 

be calculated as "(Attacker's Attack Power x 4) - (Target's Defense x 2)". 
 

Also, since the effectiveness of an item can change depending on the element and 
defense actions, these factors will not be included in the formula. 

 

x.atk Attack Power 

x.def Defense 

x.mat Magic Attack 

x.mdf Magic Defense 

x.agi Agility 

x.luk Luck 

x.mhp Max HP 

x.mmp Max MP 

x.hp Current HP 

x.mp Current MP 

x.tp Current TP 

x.level Level 

 

 

Effects 
 
Details of effects aside from damage. These can be set in the [Effects] window that 

appear when double-clicking in the list. For more information, please refer to the 
[How to Set Effects] section. 

 

Notes 
 
Used to make notes while making your game. 
 

Right-click to show the menu and choose [Plugin Help...] to display the Plugin Help 
information. 
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Weapon/Armor Settings 
 
This Data’s Role 

 
Weapons and armor refer to the equipment of an actor. You can do things such as 

raise or lower specific traits, or give special traits to the actor equipping the item. 
 

Parameter Details 
 

 
Weapon 

 



 
88/258 

 

 
Armor 

 
Basic Settings 
 

Name 
 

Name of the weapon/armor. If the name is long, it may not be completely displayed 
on the Play Screen. 

 
Icon 

 
The image that is displayed together with the weapon or armor during gameplay. You 

can select an image in the [Select an Image] window that appears after double-
clicking on the icon's image. 

 

Description 
 

The description that appears when a weapon or armor is selected in the Play Screen.  
 

Weapon Type/Armor Type 
 

Classification of the weapon or armor. This will be the criterion that determines 
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whether an actor can equip the item using the trait parameters of the actor or class. 
The weapon/armor classification that you can select can be changed in the [Terms] 

settings. 

 
Price 

 
This is the price when purchasing it in a shop. The price when selling will be half of 

its original price. You can set it so it cannot be sold by setting this value to zero. 
 

Animations (Weapon Data Only) 
 

Set the animation when attacking with this weapon.  
 

Equipment Type (Armor Data Only) 
 

The location where the armor will be equipped (Shield/Head/Body/Accessory). You 
can equip compatible armor for each location on an actor. 

 

Parameter Changes 
 

The value added to each trait of an actor when equipped. [Max HP] and [Max MP] 
can be set from -5000 to 5000, and all others can be set from -500 to 500. By 

entering a negative value, that trait's value will be decreased. 
 

Traits 
 
Traits given to the actor when equipping the weapon or armor. You define the details 
in the window that is displayed when double-clicking each row of the parameter field. 

For more information please refer to [How to Set Traits]. 
 

Notes 
 
Used to make notes while making your game. 

 
Right-click to show the menu and choose [Plugin Help...] to display the Plugin Help. 
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Enemy Settings 
 
This Data’s Role 

 
Data that represents the enemy characters that the player fights. In addition to 

having the same trait values as actors, you also need to set the action patterns that 
enemies will perform during battle. 

 
Parameter Details 

 

 
 

Basic Settings 
 
Name 

 

Name of the enemy. If the name is long, it may not be completely displayed on the 
Play Screen. 

 
Image 

 
The image of the enemy that is displayed while playing. You can select an image in 

the [Select an Image] window that appears after double-clicking on the icon's image. 
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When selecting an image, you can change the hue of the image by moving the [Hue] 
slider. If the image is set to [None], an image will not be displayed. 

 

Max HP/Max MP/Attack/Defense/M.Attack/M.Defense/Agility/Luck 
 

The trait values of an enemy when a battle begins. [Max HP] can be set between 1 
and 999999, [Max MP] can be set between 0 and 9999, and all others can be set 

between 1 and 999.  
 

Rewards 
 
The amount of EXP (1 to 9999999) and Gold (0 to 9999999) that the party receives 

after winning a battle. 
 

Drop Items 
 
Items (including weapons and armor) that the party receives after winning a battle. 
In the window that opens when you double-click inside the field, you can specify the 

desired item and chance of getting that item by setting the [Probability] (1/1 to 
1/1000). 

 

Action Patterns 
 

 
 

Turn 

 
The number of turns that have passed will be used as a condition. Turns will be 

defined using [A + B * X] with A being the number of turns from the start of battle, 
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and B being the interval of turns. If you set A to 2, and B to 3, conditions will be met 
every 3 turns from the 2nd turn (5th turn, 8th turn...). 

 

HP 
 

The HP of the enemy will be used as a condition. Specify the range of the percentage 
of Max HP (0 to 100%). The condition will be met when the enemy's HP is within the 

specified range. 
 

MP 
 

The MP of the enemy will be used as a condition. Specify the range of the percentage 
of Max MP (0 to 100%). The condition will be met when the enemy's MP is within the 

specified range.StateWhen the character is in the specified state will be used as a 
condition. 

 
State 

 

The specified state being applied to the enemy will be used as a condition. 
 

Party Level 
 

The level of the party members will be used as a condition. The condition will be met 
when the level of the party member with the highest level is equal to or above the 

specified value. 
 

Switch 
 

The specified switch will be used as a condition. The condition will be met when this 
switch is on. 

 

Traits 
 

Traits of the enemy. You define the details in the window that is displayed when 
double-clicking each row of the settings field. For more information please refer to 

[How to Set Traits]. 
 

Notes 
 
Used to make notes while making your game. 
 

Right-click to show the menu and choose [Plugin Help...] to display the Plugin Help. 
 

Application Rules for Action Patterns 
 

The action performed during battle will be decided from the actions set in [Action 
Patterns] according to the following rules. 

 
1. Actions which have fulfilled their conditions will be picked out from the 

configured actions. No action will occur if there is no action that meets the 
required condition. 



 
93/258 

 

2. Within those actions that meet the conditions, the action with the highest 
rating and the action with a rating that is within two points of the highest 

rating will be treated as possible choices. 

 
3. Of those possible choices, those actions which have a rating difference of 

1 and 2 from the highest rating will have their chance of being chosen being 
2/3 and 1/3 of the highest rating. The chance of being chosen will be the same 

for multiple actions which have the same rating. 
 

Example 1: The action rating is [5] and [5] 
The chance for each becomes 50%. 

 
Example 2: The action rating is [6],[5],[4],[3] 

[6] will be 50%, [5] will be 33.3% (2/3 of 50%), [4] will be 16.6% (1/3 
of 50%). [3] will not be a choice. 

 
Example 3: The action rating is [5],[3] and [3] 

[5] is 60%, each [3] is 20% (1/3 of 60%). 

 
4. The action used will be determined using random numbers based on the 

usage probability of those actions which are candidates. 
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Troop Settings 
 
This Data’s Role 

 
Troops are the data for the groups of enemies that appear during gameplay. The 

enemies that you have the player fight with through moving in the map and 
command events are specified based on this data. Even when having the player fight 

against just one enemy, you must prepare data for the troop with that enemy. 
"Battle Events" (events during battle) will also be set for each troop. 

 
Parameter Details 

 

 
 
Basic Settings 
 

Name 
 

The name of the troop. This property is just used in the editor (does not affect the 
game). By clicking the [Auto-name] button, a name will be automatically generated 

based on the characters entered. 
 

 

http://hg.mozilla.org/mozilla-central/tools/codesighs
http://hg.mozilla.org/mozilla-central/tools/codesighs
http://hg.mozilla.org/mozilla-central/tools/codesighs
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Change Battle Background 
 

Change the battle background that will be displayed in the Placement View. Specify 

the background using the left field, and the image used for the ground in the right 
field respectively in the window that is displayed. These settings are only used inside 

the editor (does not affect the game), and other data will be shared and used also 
when editing. 

 
Battle Test 

 
Run a battle test with the troop. Specify the actors that will battle, equipment, and 

levels using the tabs labeled [1] through [4] in the window that is displayed (trait 
values based on the settings will be displayed in the [Status] section). A window will 

open and a battle will start when you click [OK]. The test will end when the window 
is closed. 

 
* Save edited data when a plugin is set. When not saved, the plugin settings will not 

be reflected in the battle test. 

 
Placement View 

 
Those enemies that belong to the troop. It is possible to register up to 8 enemies 

(including those of the same type) in a single group. 
 

By dragging on an enemy in the Placement View, you can move the enemy. 
Additionally, when you right-click on an enemy in the Placement View and select 

[Appear Halfway], the enemy will become an enemy that will not appear until 
running an [Enemy Appearance] Event Command in the Battle Events. 

Use the buttons below to edit contents of the troop. 
 

Add 
Add the enemy selected in the field on the right to the Placement View. You 

can also add by double-clicking an enemy in the list. The order in which the 

enemies were added will be reflected in the enemy list displayed during battle. 
 

delete 
Remove the enemy selected in the Placement View. 

 
Clear 

Delete all enemies in the Placement View. 
 

Align 
Re-align the positions of the enemies in the Placement View according to the 

order which they were entered from the left. 
 

Battle Event Parameters 
 

Configure event conditions executed during battle with enemies and their details in 

the [Battle Event] section. Just like map events, it is possible to divide the contents 
processed depending on the situation using the Event Page and appear conditions. 
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Event Page Controls 
 

You can control Event Pages using the [New Event Page], [Copy Event Page], [Paste 

Event page] and [Clear Event Page] buttons located on the left. The functions are the 
same as the map events. 

 
Contents 

 
Event processing when [Conditions] and [Span] are met is configured based on 

event commands. Editing is done in the same way as Map Events' [Contents]. 
 

Conditions 
 

Conditions for the event pages. In the [Conditions] window that appears when the 
[...] button is pressed, enable the conditions from the below 5 conditions, and 

configure the decision criterion used for each. Unlike map events, if you do not 
specify any conditions for the battle events, the event page will not be run. Also, if 

there are multiple event pages that fulfill conditions, the event page with the 

smallest number will be the one which is used. 
 

 
 

Turn End 

The moment a turn ends will be treated as a condition. 
 

Turn 
When the number of turns specified have passed from the start of battle will be 

treated as a condition. Specify the number of turns from the start of battle in 
the field on the left and the interval between turns on the right. 

 
Enemy HP 

When an enemy's HP falls below the specified amount, it will be treated as a 
condition. Specify the enemy and the value (percentage of Max HP). 

 

Actor HP 
Treats when an actor's HP falls below the specified value. Specify the actor and 

the value (percentage of Max HP). 
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Switch 
When the specified switch is set to ON will be treated as a condition. 

 

Span 
 
Specify the timing of when the contents of the event page are allowed to run. 

 
Battle 

The event will run when a condition is first met from the start of battle. Once it 
has been run once, it will not be run again. 

 
Turn 

Conditions will be checked each turn, and the event will be run if there is a 
condition met. 

 
Moment 

The event will be run repeatedly while a condition is met. If event pages are 

not controlled with switches, there are cases where a battle will not progress, 
so please keep that in mind. 
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State Settings 
 
This Data’s Role 

 
States are things like "Poison" and "Confusion", those abnormal states which affect 

the condition and actions of a character. Configure the specific effects in the data 
when a state is added. You can prepare not only states with negative effects such as 

[Poison], [HP decreased], but also states with positive effects such as [Enraged], 
[Attack Power Increased]. 

 
Moreover, State #1, named [Knockout], is a special state that is automatically 

applied to characters and enemies when their HP reaches zero. If all members of a 
party are in this state, it will result in a game over. 

 
Parameter Details 

 

 
 

Basic Settings 
 

Name 
 

The name of the state. States are displayed using icons so the name will never be 
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used during gameplay. 
 

Icon 

 
This icon is the image displayed next to an actor's name or above an enemy's head 

when in that state. You can select an image in the [Select an Image] window that 
appears after double-clicking on the icon's image. Try choosing an icon that makes 

the details of the state clear. 
 

Restriction 
 

Restricts the actions of characters in a state. The details of a restriction will be set 
based on the 5 items below. If there are multiple restrictions configured for a state, 

the restriction at the bottom will be prioritized. 
 

None 
Actions will not be restricted. 

 

Attack an Enemy 
Will definitely attack an enemy. 

 
Attack Anyone 

Will definitely attack either an enemy or ally. 
 

Attack an Ally 
Will definitely attack an ally. 

 
Cannot Move 

Cannot move at all. 
 

Priority 
 

Priority (0 to 100) of displaying state icons. The icon with the highest priority will be 

displayed if a character has multiple states. If the priorities are the same, the state 
with the youngest ID will be prioritized. 

 
[SV] Motion 

 
Set the motion that will be displayed in Side Menu Mode when a state is active. 

 
[SV] Overlay 

 
Set the overlay image that will be displayed in Side Menu Mode when a state is 

active. 
 

Removal Conditions 
 
Conditions to remove a state. Conditions will be set based on the items below. If 
there are multiple conditions configured, the requirements for each will be 

determined and the condition removed. 
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Remove at Battle End 
 

When enabled, the condition will be removed when the battle ends. 

 
Remove by Restriction 

 
When enabled, the condition will be removed when another state is added that has 

separate restrictions. 
 

Auto-removal Timing/Duration in Turns 
 

Removed after turn. When using [Action End], the condition will be removed after 
the active character finishes an action, and will be removed after a turn ends and 

before returning to Action Selection when using [Turn End]. Specify the lower limit 
and upper limit (0 to 9999) of number of turns until a condition is removed following 

being given a state using [Duration in Turns]. 
 

Remove by Damage 

 
A condition will have a specified chance (0 to 100%) of being removed when 

receiving any sort of damage. 
 

Remove by Walking 
 

A condition will be removed when the player moves on the map after walking over 
the number of tiles specified (0 to 9999). 

 

Message 
 
Message that gets displayed during battle when this state is given or removed. For 
each of the following 4 states, a message will be displayed following the target's 

name: "If an actor is inflicted with the state","If an enemy is inflicted with the 

state","If the state persists", and "If the state is removed". 
 

Traits 
 
Traits given to the target when given a state. For more information please refer to 

[How to Set Traits]. 
 

Notes 
 
Used to make notes while making your game. 

 
Right-click to show the menu and choose [Plugin Help...] to display the Plugin Help. 
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Animation Settings 
 
This Data’s Role 

 
Animations are the data that can be played for visual representations for when 

enemies attack in the Battle Screen and things on the Map Screen.  
 

These are created by placing image patterns (cells) in a "Frame". 
 

Create MV-compatible data 
 

A menu will appear when right-clicking an item in the data list, allowing you to 
configure cell animation predating RPG Maker MZ by selecting "Create MV-compatible 

data". 
 

Select "Clear" to return to the particle animation settings screen. 

 
Create and store an [animations] folder under the [img] folder for MV-compatible 

animation files to be configured. 
 

 
 
Parameter Details 

 
(cont’d on next page) 
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Basic Settings 
 

Name 
 

The name of the animation. This property is only used in the editor and does not affect 
the game. 

 
Display Type 

 
The display position for the animation in the game. 

 

Align Bottom 
 

Dislayed using the bottom edge of the image as a base. 
 

Particle Effect 
 
Settings pertaining to particle effects. Configure the effect to be played. 
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File Name 
 

Set the Effekseeker file to be used in the animation. 

 
Scale 

 
Configure the scale of the effect. 

 
Speed 

 
Configure the playback speed of the effect. 

 
Rotation 

 
Configures the rotation angle of the effect. 

 
Offset X 

 

Set the number of pixels to shift the animation horizontally. 
 

Offset Y 
 

Set the number of pixels to shift the animation vertically. 
 

Preview 
 
Play 

 
Tests the animation. 

 
Change Target 

 
Change the currently displayed target image. 

 
Change Battle Background 

 
Change the battle background image used for testing. 

 

Sounds 
 
Configure the sound to play during animation playback. 

 
Frames 

 
Set the timing for the animation to be shown. 

 
File Name 

 
Configure the sound to play on the specified frame. 
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Flash 
 
Configure the flash effect to use during animation playback. 

 
Frames 

 
Specify the timing for the flash effect. 

 
Duration 

 

Set the timing of the flashes in 1/60ths of a second. 
 

Color 
 

Configure the color of the flash effect. 
 

Effekseer 
 
When creating animation effects yourself in RPG Maker MZ, you'll use the effect 

creation tool "Effekseer". RPG Maker MZ officially supports version 1.5. By placing 
files output in efkefc format to the "effects" folder inside your project, you can 

select added animations from [Particle Effects] in [Database] → [Animations]. Please 

see Database [Animation Settings] for information on configuring animations. 
 

What is Effekseer? 
 

Effekseer is a tool that allows you to create a variety of particle effects for games 
such as explosions and hit effects, as well as easily edit effects. 

 
Effekseer - Effect Creation Tool Official Site : https://effekseer.github.io/en/ 

 

 

https://effekseer.github.io/en/


 
105/258 

 

Edit Effects with Simple Controls! 
 

You can create a variety of effects using simple controls. You can also fine-tune 

effects. 
 

 
https://www.youtube.com/watch?v=3G5BrmI4V48 

 
 

 
https://www.youtube.com/watch?v=KUax3Y6mTqk 

 
 

https://www.youtube.com/watch?v=3G5BrmI4V48
https://www.youtube.com/watch?v=KUax3Y6mTqk
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Plenty of Samples 
 

Effekseer publishes many samples submitted by its users. 

 
Most samples are offered with a CC-0 license, so you can use them in your games 

as-is or use them as a base for a new effect. 
 

 
https://www.youtube.com/watch?v=JGMu5_opu5Y  

 

 
Effekseer Sample Effects 

 
https://effekseer.github.io/en/contribute.html  

 
 

Robust Help Documentation 
 

You can easily create effects that you can actually use by following the tutorials. 

 
Effekseer Help English 

 
https://effekseer.github.io/Help_Tool/en/index.html  

https://www.youtube.com/watch?v=JGMu5_opu5Y
https://effekseer.github.io/en/contribute.html
https://effekseer.github.io/Help_Tool/en/index.html
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Tileset Settings 
 
This Data’s Role 

 
Tilesets are the collection of "Tiles" used to design your map. Create tiles by setting 

whether a character can walk on the image used for the tile, and also the behavior in 
the game. 

 
Original images created for the map can be used as well by creating tilesets which 

use those images, and assign as map data. 
 

Moreover, whether or not vehicles (boats/large ships) can go over tiles is determined 
by the position over the tileset. For more information, please view [Asset Standards]. 

 
Planes are able to travel over all tiles. However, there are only able to land on tiles 

which can be walked on. 

 
Parameter Details 

 

 
 

Basic Settings 
 

Name 
 

A tileset's name. This property is just used in the editor (does not affect the game). 
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Mode 
 

The purpose of the tileset. This primarily influences Lower Layer Tile Special 

Specifications and Handling Battle Backgrounds. 
 

In general, please choose [Field Type] for tiles which represent the overworld (such 
as ocean and land), and [Area Type] for all other situations. 

 

Images 
 

Settings for images used for tiles. Specify the file you want to use for each type 
(Sets A through E) in the [Select an Image] window that is displayed when you press 

the button for each type. An image's contents will be displayed in the [Tile List] on 
the right. 

 

Tile List 
 

The tile images set in [Image] will be displayed here. By clicking tabs [A] through [E] 
below, you can switch the images displayed. The tiles for the images specified in 

[A1] through [A5] in the [Image] section on the [A] tab will be displayed in order. 
 

Marks representing the current parameter values in the settings editing mode will be 
displayed on top of each tile. You can change these parameter values by clicking 

them. 
 

Additionally, for items with 3 or more types of setting values (passage, terrain tags), 
pressing the right button will reverse the direction from that of the left button. 

By moving your cursor with the button held, you can change the settings for the tiles 
that your cursor moves through. 

 
Passage 

 

Switch to the editing mode where you can set whether a tile can be entered or not. 
Tiles marked with a [○] can be entered, ones marked with an [×] cannot be entered. 

Those which have a [☆] can also be entered, however this is for when hiding 

characters behind buildings (only possible in all other tabs except [A]). 
 

Passage (4 dir) 
 

Switch to the editing mode where you can set the direction from where tile can be 
entered. Use [Passage: Block] when creating tiles that can be passed only from a 

defined direction. For example, when you set the edge of a tile that represents a cliff 

as impassable, characters will be unable to move between that tile and the next tile, 
creating the sense of height. 

 
Those tiles with marks displayed as arrows pointing in a specific indicate that it is 

possible to move from that direction, ones without arrows are not passable. 
Moreover, by changing the parameters of the [Passage] setting, these settings will 

change automatically. 
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Ladder 
 

Switch to the editing mode for ladder settings. When you add this parameter, the 

direction a character using this tile faces will be fixed to up, giving the appearance of 
going up and down things like ladders and ropes. 

Click the marks in the Tile List to change tiles to have this parameter or not. A mark 
(a ladder) will be displayed on tiles which have this setting. 

 

Damage Floor 

 

Switch to the editing mode for Damage Floors. When a tile is given this setting, 
characters will receive damage when crossing this tile. This can be used for 

representing dangerous terrain like poisonous swamps, trees with thorns. 
Click the marks in the Tile List to change tiles to have this parameter or not. A mark 

(two triangles) will be displayed on tiles which have this setting. 
 

Bush 
 

Switch to the editing mode for bush settings. When a tile has this setting, 12 pixels 
from the bottom of characters who cross this tile will appear half transparent, as if 

their feet are being hidden by dense grass. However, part of the tile will not become 
half transparent depending on the image when giving this setting to tiles in [A1] 

through [A4]. 

 
Click the marks in the Tile List to change tiles to have this parameter or not. A mark 

(two wavy lines) will be displayed on tiles which have this setting. 
 

 
 

Counter 

 

Switch to the editing mode for counter settings. When a tile is given this setting, it 

will start events even when a character and event are not right next to each other, 
just as when talking to a character with a desk between them. 

 
Also, setting this to the tile in [A2], tiles having this element will be drawn 12 pixels 

downward. 
 

Click the marks in the Tile List to change tiles to have this parameter or not. Tiles 
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which have this setting have a mark (4-sided diamond) displayed on them. 
 

 
Terrain Tag 
 

You can assign values between 0 and 7 to each tile. No specific uses are defined. 
This value can be retrieved by using the [Get Location Info] event command. 

Those terrain tags retrieved which are located in upper layers other than zero will be 
prioritized. 

 
Copy Page 

 
Copies the current page settings onto the clipboard. 

The following data will be copied: Passages, passages (4-dir), ladders, bushes, 
counters, damage floors, terrain tags. 

 
Paste Page 

 

Pastes the content of the clipboard to the current page. 
Data copied from the [A] tab can only be pasted into the [A] tab. 

Data copied from any other tab can be pasted into the [B], [C], [D], and [E] tabs. 
 

Notes 
 
Used to make notes while making your game. 

 
Right-click to show the menu and choose [Plugin Help...] to display the Plugin Help. 
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Common Event Settings 
 
This Data’s Role 

 
Common events are those events that can be run when you want them to be during 

gameplay. You can define triggers that you run generally for the overall game such 
as regularly monitoring play conditions and run some kinds of processes when things 

such as items and skills are used. Common events created can be run by using event 
command or triggering it through defined switches. 

 
Parameter Details 

 

 
 
 
General Settings 
 

Name 

 
Name of the common event. This property is just used in the editor (does not affect 

the game). 
 

 



 
112/258 

 

Switch 
 

Specify what the switch is that triggers the event when setting the trigger to 

[Autorun] or [Parallel]. If there are multiple common events with the same switch, 
the event with the youngest ID (at the top of the list) will be run. 

 
Triggers 

 
Timing for when these events are run will be specified using the following. Moreover, 

[Autorun] and [Parallel] can only be enabled when the Map Screen is displayed. 
 

None 
Will only be triggered by skills, items, and other explicitly stated events. 

 
Autorun 

Will run when the specified [Switch] is switched to ON. 
 

Parallel 

Will run when the specified [Switch] is set to ON, and will repeat periodically. 
 

Contents 
 
Events run using common events will be set based on event commands. Editing is 

done the same way as the [Contents] for map events. 
 

Warning for Autorun and Parallel Triggers 
 

Events which are set to [Autorun] or [Parallel] will have their contents run repeatedly 
while the [Switch] is set to [ON]. 

 
Measures need to be taken to have the [OFF] value which is used as the condition 

set in order to stop the event from repeating. If you do not control this, there is a 

possibility that players will no longer be able to control the game depending on the 
contents of the event. 

 
If you are no longer able to play while in Playtest, you can forcibly close the game by 

pressing the [X] button or by hitting [Alt] + [F4]. 
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System 1 Settings 
 
This Data’s Role 

 
System data is the collection of things such as the initial settings for the game. You 

can specify things such as the formation and positions of party members at the start 
of the game, and the music that places in various situations during gameplay. 

 
Parameter Details 

 

 
 

Game Title 
 
The name of your game. This will be set when you enter the name into the [Game 

Title] field when creating a new project. This name will be displayed in the Game 
Screen title and the window's title bar. 

 

Starting Party 
 
The members that form the party at the start of the game. 

 
There is no limit to how many actors you can place into a party, however only the 

first 4 can participate in battle. 
 

To change or add new actors, double-click items (a blank row when adding) in the 
list, and specify the new actors. To remove actors, right-click the one you wish to 

remove and select [Delete] in the menu that is displayed. 
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Currency 

 
The name for the unit of money used in the game. This is used for things such as 
displaying how much gold the player has in the Menu Screen. 

 

Window Color 
 
Background color of the windows used in the game. This is specified using the 
composition of the [Red], [Green] and [Blue] values (-255 to 255) in the window 

that appears when you double-click inside the field. 
 

Vehicle Images 
 
Images for the vehicles (boats/ships/planes) displayed on the map. You can select an 

image in the [Select an Image] window that appears after double-clicking on each 
vehicle's section. Select [(None)] if you do not want to display an image. 

 

Starting Positions 
 
The positions of the player and vehicles (boats/ships/planes) when the game starts. 

Open the Settings Window for each field by pressing its [...] button, and specify the 
location by clicking a point on the map on the right. 

 
The specified starting location will be shown using an icon in a blue frame on the 

map. This icon can be moved by dragging it, just like map events, and be deleted by 
pressing the [Del] key. 

 
However, if the starting position for the player is not set (the icon is deleted), you 

cannot start the game. 
 

Title Screen 
 
The image which is displayed first in the Play Screen after starting the game. You can 
select an image in the [Select an Image] window that appears by pressing the [...] 

button in the settings field. When [Draw Game Title] is enabled, the game's name as 
specified in [Game Title] will be displayed towards the top of the Title Screen (you 

can disable this when including the title of the game in the image). 
 

Command Window 
 

Sets the background type and position of the command window. 
 

Battle Screen 
 
Set the battle screen POV. 

 

Front-view 
 

Displays enemies from the front. 
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Side-view 
 

Displays enemies and actors from the side. 

 

Battle System 
 
Set the battle system type. 
 

Turn-Based 
 

All battlers execute their actions at one time. 
 

Time Progression (Active) 
 

Battlers act based on their agility. Time passes during command input. 
 

Time Progression (Wait) 

 
Battlers act based on their agility. Time does not pass during command input. 

 

Options 
 
Specify special processes and rules related to the game's behavior. 
 

Start Transparent 
 

When enabled, the game will start with the character transparent (hidden). Use the 
[Change Transparency] event command to switch this off. 

 
Show Player Followers 

 

When enabled, the game will start with actors, starting from the 2nd, following the 
main actor while moving on the map. Only 4 actors starting from the first will be 

displayed even when there are 5 members in a party. 
 

Death by Slip Damage 
 

When enabled, this allows the HP to reach 0 by when damaged by states such as 
"Poison". HP will only go down to 1 when this is disabled. 

 
Death by Floor Damage 

 
When enabled, this allows the HP to reach 0 when damaged by tiles (Damage Floors) 

on the map. HP will only go down to 1 when this is disabled. 
 

Show TP in Window 

 
When enabled, TP values will be displayed in the party members' Status Window in 

the Battle Screen. 
 

 



 
116/258 

 

EXP for Reserve Members 
 

When enabled, actors who did not participate in battle will also receive EXP when a 

battle is won. 
 

Show Key Item Quantities 
 

When enabled, the quantity of Key Items held by the party will be displayed on the 
Item screen. 

 
Enable Autosave 

 
If enabled, game data will be saved at the end of battles and when moving between 

locations. 
 

Music 
 
Music that plays while playing. Specify the BGM or ME that plays in the parameters 
for each scene. The parameters for each scene are as follows. Also, the music that 

plays when the player moves on the map will be set in the map data. 
 

Title The BGM that plays in the Title Screen. 

Battle The BGM that plays in the Battle Screen. 

Victory The ME that plays after battle when a party wins. 

Defeat The ME that plays after battle when a party loses. 

Game Over The ME that plays in the Game Over screen. 

Boat The BGM that plays when on a boat. 

Ship The BGM that plays when on a ship. 

Airship The BGM that plays when on a airship. 

 

Sounds 
 
The sound effects (SE) that play in situations such as when the player moves or 

performs an action during battle. Set the SE file that will play for each situation. 
The parameters for each situation are as follows. 

 

Cursor When moving the cursor. 

OK When confirming the command to use. 

Cancel When canceling a command in the Menu Screen, etc. 

Buzzer When selecting a command that cannot be used in the Menu Screen, etc. 

Equip When changing equipment in the Menu Screen. 

Save When saving the game. 

Load When loading the game. 

Battle Start When encountering an enemy. 

Escape When a party or enemy escapes during battle. 

Enemy Attack When an enemy performs a normal attack during battle. 

t

t

t



 
117/258 

 

Enemy Damage When damaging an enemy during battle. 

Enemy Collapse When an enemy is knocked out during battle. 

Boss Collapse 1 When the [Collapse Effect] of a [Trait] knocks out an enemy [Boss]. 

Boss Collapse 2 When the [Collapse Effect] of a [Trait] displays the vanishing effect of an enemy [Boss]. 

Actor Damage When an actor is damaged. 

Actor Collapse When an actor becomes knocked out during battle. 

Recovery When an actor or enemy recovers during battle. 

Miss When a character fails to land a physical attack. 

Evasion When a character evades a physical attack. 

Magic Evasion When a character evades a magic attack. 

Magic Reflection When a character reflects a magic attack. 

Shop When buying or selling an item in the Shop Screen. 

Use Item When an item is used in the Menu Screen. 

Use Skill When a skill is used in the Menu Screen. 
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System 2 Settings 
 
This Data’s Role 

 
System 2 data is a collection of customization settings. 

 
Parameter Details 

 

 
 

 

Tile Size 
 
Changes the horizontal and vertical sizes of map tiles. Using your own tilesets with 

dimensions other than the MZ standard size of 48 x 48 allows you to create games 
featuring different visuals than the default MZ look. 

 
Refer to [Asset Standards] for more information on tile size specifications. 

 

Menu Commands 
 
Switch commands in the Menu Screen to ON or OFF. 
 

Item Categories 
 
Switch categories on the Item screen ON or OFF. 

 
 



 
119/258 

 

[SV] Attack Motions 

 
Select motions that are displayed for normal attacks in side-view mode. 
 

[SV] Magic Skills 
 
List of skill types which require casting motions in side-view mode. 

 

Advanced Settings 
 
Perform other advanced system configurations. 
 

Game ID 
 

You can change the Game ID. 
 

Screen Width/Screen Height 

 
Configure the game screen's width and height. 

 
UI Area Width/UI Area Height 

 
Configure the UI area's width and height. 

 
Screen Scale 

 
Changes the scale of the screen when the game is run. An integer between 1 and 4 

can be entered. 
 

Main Font Filename 
 

Configure the font. 

 
Number Font Filename 

 
Configure the font for displaying numbers. 

 
Fallback Font 

 
Configure the font for displaying characters not included in the main font. 

 
Font Size 

 
Configure the text size. 

 
Window Opacity 

 

Configure the opacity of the windows used in the game. 
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Type Settings 
 
This Data’s Role 

 
Types are the collection of name parameters of game elements, skill types, weapon 

types, armor types, and equipment types. The types configured here will be reflected 
in the Type section for each settings window. 

 
Parameter Details 

 

 
 

Elements 

 

List of element names. Click the name you want to change in the list, and enter the 
name in the field at the bottom. To increase and decrease the amount of names, 

click the [Change Maximum] button, and specify the new amount. 
 

This name will be used whenever making a selection in the editor. Changing the 
specific details of elements is done using skill and weapon data. 

 
Skill Type 

 

A list of the names of types that you specify in the [Skill Types] section. The method 
for changing names is the same as the [Elements] section. 

 
Weapon Types 

 
A list of the names of types that you specify in the [Weapon Types] section. The 



 
121/258 

 

method for changing names is the same as the [Elements] section. 
 

Armor Types 

 
A list of the names of types that you specify in the [Armor Types] section. The 

method for changing names is the same as the [Elements] section. 
 

Equipment Type 
 

A list of the names of types that you specify in the [Equipment Types] section. The 
method for changing names is the same as the [Elements] section. 
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Terms Settings 
 
This Data’s Role 

 
Terms are the collection of the names of things such as game commands and 

parameters. By changing the standard names to fit your game's world, you can 
create an even more original game. 

 
You can enter characters in the space provided in each settings field. However, the 

entire name may not be displayed if it is too long. 
 

Parameter Details 
 

 
 

Basic Statuses 
 
Terms for Level, HP, MP, TP as well as EXP. Specify the words used in the parameter 

provided for each default name. Those parameters with [(abbr.)] are where you can 
specify a shortened version to be displayed in places such as the status window in 

the Battle screen. 
 

Parameters 
 
Names of parameters. Specify the words used in the parameter provided for each 
default name. 
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Equipment Types 

 
Names for the items which a player wears. Specify the words used in the parameter 
provided for each default name. 

 

Commands 
 
The names of commands and choices displayed in places like the game's Menu 

Screen. Specify the words used in the parameter provided for each default name. 

 

Messages 
 
Contents of the messages displayed during gameplay. Specify the sentences used in 
the parameter provided for each default name. [%1] and [%2] and so on will be 

replaced when the message is run. 
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How to Set Traits 
 
Settings Overview 

 
The [Traits] parameter for actors, classes, weapons, armors, enemies and states 

define the unique properties and functions for each type of data. 
 

The 24 types of properties that can be given are found below. By giving these 
properties according to the contents of the data you wish to create, you can give the 

various types of data complex traits. 
 

Traits for classes, weapons, armors and states will be reflected in a character's traits 
when that character has that type of data added (equipped). 

 
Furthermore, please be careful when configuring traits that permanently restrict 

actions. For example, a weapon which is set to [Lock Equip] cannot be removed once 

an actor equips it. 
 

How to configure 

 

 
 

To set a trait, double-click an empty row in the Traits field. Select the property type 

in the displayed window, and specify what effects are applied. 

 

The property details will be displayed in the [Traits] list. You can re-edit the contents 
of properties by double-clicking the item.  

 
Additionally, you can perform actions such as copying the settings and deleting them 

in the context menu that is displayed when you right-click a trait. 
 

 

http://sourceforge.net/projects/flac/files/flac-src/flac-1.2.1-src/flac-1.2.1.tar.gz/download
http://sourceforge.net/projects/flac/files/flac-src/flac-1.2.1-src/flac-1.2.1.tar.gz/download
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Contents of Each Trait 
 

[Rate] Tab 
 
Element Rate 

 
Change the damage received when an attack contains an element. Specify the 

desired element and its rate (0 to 1000%4). An attack's damage will become larger 
than normal if the rate is set over 100%, indicating that this character is weak 

against the specified element. 

 
Debuff5 Rate 

 
Change the success rate of items and skills which have a [Debuff] effect when used. 

Specify the desired parameter and the change of success (0 to 1000%, 100% means 
no change). 

 
State Rate 

 
Change the success rate of items and skills which have an [Add State] effect when 

used. Specify the desired state and the change in rate of success (0 to 1000%, 
100% means no change). 

 
State Resist 

 

Negates the specified state. If [Knockout] is selected, a character will not be knocked 
out even when their HP reaches 0. 

 

[Param] Tab 
 
Regular Parameter 

 

Raises and lowers parameters such as Max HP, and Attack Power at a fixed rate. 
Specify the desired parameter and the change (0 to 1000%, 100% means no 

change). 
 

Ex-Parameters 
 

Raises and lowers the values of extra parameters such as Hit Rate and Evasion Rate. 
Specify the desired parameter and the percentage to add (-1000 to 1000%, starting 

value is 0%). 
 

Sp-Parameters 
 

Raises and lowers the values of special parameters such as Target Rate and Guard 
Rate. Specify the desired parameter and the change (0 to 1000%, starting value is 

100%). 

 
4 Not a typo: « The default value for each element is 100%; a value higher than 100% will cause the 

battler to take increased damage, and a value less than 100% will reduce damage. »  

(source : https://www.rpgmakerweb.com/blog/a-primer-on-database-traits-and-effects).  
5 Effect that weakens an in-game character. 

https://www.rpgmakerweb.com/blog/a-primer-on-database-traits-and-effects
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[Attack] Tab 
 
Attack Element 

 
Adds the specified element to normal attacks. 

 
Attack State 

 
Adds an effect of changing states to normal attacks. Specify the effect and the 

change in rate of success (0 to 1000%, 100% means no change). 

 
Attack Speed 

 
Raises and lowers agility when choosing a normal attack in battle. Specify the 

raise/lower value (-1000 to 1000). 
 

Attack Times 
 

Increases the number of times (1 time normally) a target is damaged using normal 
attacks. Specify the amount to increase. 

 
Attack Skills 

 
Specify the skill to be used as a regular attack. 

Please see [Improvements to Artistic Expressions in Games] → [Database 

Improvements] → [Add "Attack Skills"] for more information. 
 

[Skill] Tab 
 
Add Skill Type 

 
Allows the player to select the specified skill type command. 

 
Seal Skill Type 

 

Prevents the player from selecting the specified skill type. 
 

Add Skill 
 

Makes the specified skill usable. 
 

Seal Skill 
 

Makes the specified skill unusable. 
 

[Equip] Tab 
 
Equip Weapon 

 
Makes the specified weapon type able to be equipped. 
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Equip Armor 
 

Makes the specified armor type able to be equipped. 

 
Lock Equip 

 
Makes it so that equipment for the specified slot cannot be changed. Use this when 

you do not want to change the equipment of an actor that is temporarily in the party. 
 

Seal Equip 
 

Prevents equipment from being equipped in the specified slot. This allows you to 
create things such as "Two-handed Weapons" which seals shield equipment and 

"Full-body Clothing" that seals head equipment. 
 

Slot Type 
 

This can be only set to [Dual Wield]. In exchange for not being able to equip a 

shield, characters can equip two weapons. 
 

[Other] Tab 
 

Action Times + 
 

Sets the chance of raising the number of actions during battle by 1 using the 

specified probability. If a character has multiple entries for this trait, each instance 
will be calculated separately on whether to increase the number of actions using the 

specified probability. For example, if a character has two of these traits with a 
probability of 50% each, the chance of the number of actions increasing 2 times, and 

the chance of actions not increasing even 1 time will both be 25% (50% x 50%). 
 

Collapse Effect 
 

This only effective towards enemies. The effect when an enemy is knocked out and 
collapses will change to the specified effect. 

 
Special Flag 

 
Grants special traits related to actions during battle. 

 

Auto Battle Characters will perform actions automatically without taking commands from the player. 

Guard Decreases the amount of damage taken by a fixed rate. 

Substitute Take damage in place of an ally when they are attacked when their HP is low. 

Preserve TP 

Accumulated TP will be preserved for the next battle. By default, TP will be reset each battle, 

and the amount of TP that each character has at the start of battle will be decided randomly. 

 
Party Ability 

 
Grants special traits related to the party's actions during battle. The various traits of 

each actor will be reflected as traits for the entire party when even just one of those 

o 
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actors is in the party. 
 

Encounter Half The frequency of encounters while moving on the map will be reduced by half. 

Encounter None No encounters will occur while moving on the map. 

Cancel Surprise 
Suprise attacks (when only an enemy troop can perform actions on the first turn) will no 
longer occur when a battle starts. 

Raise Preemptive 
The chance of preemptive attacks (when only the party can perform actions on the first 
turn) when a battle starts will increase. 

Gold Double 
The amount of gold received when the party wins a battle will be twice the normal 
amount. 

Drop Item Double 
The rate of a party getting items from enemies after winning a battle will be twice the 
normal rate (only when an item has been configured for the enemy that is defeated). 
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How to Set Effects 
 
Settings Overview 

 
The [Effects] parameter defines the effects that you give to the desired character 

when an actor/enemy uses a skill or item. 
 

The 13 types of effects that can be given are found below. You can create skills/items 
which possess a combination of effects by configuring multiple effects. 

 
How to configure 

 

 
 

To set an effect, double-click an empty row in the Effects field. Select the type of 

effect in the window that is displayed, and specify such things as the targets which 
the effect applies to, the strength of the effect, etc. 

 

The details of the configured effect will be displayed in the [Effects] list. You can re-
edit the contents of effects by double-clicking the item. Additionally, you can perform 

actions such as copying the settings and deleting them in the context menu that is 
displayed when you right-click an effect. 

 

Contents of Each Effect 
 

Recover Tab 
 

Recover HP 
 

Recovers HP (adds to current value). Specify a value that is a percentage of the 

target character's Max HP (100% to 100%) and a set value (-999999 to 999999). In 
the case that you want to set just one of the values, set the other value to 0. Setting 

this effect to an item, the recovery value will change according to the user's 
[Pharmacology] special trait value. 
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Recover MP 
 

Recovers MP (adds to current value). Specify a value that is a percentage of the 

target character's Max MP (-100% to 100%) and a set value (-9999 to 9999). In the 
case that you want to set just one of the values, set the other value to 0. 

 
Gain TP 

 
Increases TP by only the specified amount. Specify the increase using a set value (0 

to 100). 
 

[State] Tab 
 
Add State 

 
Adds a state. Specify the desired state and the change in rate of success (0 to 

1000%). By setting this to a value higher than 100%, this will have a higher chance 
of success to add the state than its original effectiveness. 

 
Remove State 

 
Removes a state. Specify the desired state and the change in rate of success (0 to 

100%). 
 

[Param] Tab 
 
Add Buff 

 
Raises the fluctuation level of the specified trait by one. For each level, there is a 

25% fluctuation in the original value. To have this raise more than two levels at one 
time, add this effect multiple times. Set the target trait and the number of turns (1 

to 1000) this effect will last. 

 
Add Debuff 

 
Lowers the fluctuation level of the specified trait by one. For each level, there is a 

25% fluctuation in the original value. To have this lower more than two levels at one 
time, add this effect multiple times. Set the target trait and the number of turns (1 

to 1000) this effect will last. 
 

Remove Buff 
 

Resets a trait to its original value when the fluctuation level of the specified trait is 
buffed. 

 
Remove Debuff 

 

Resets a trait to its original value when the fluctuation level of the specified trait is 
debuffed. 
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[Other] Tab 
 
Special Effect 

 
You can set this only to [Escape]. The target character will flee from battle. If the 

actor has received this effect, they will not earn any EXP. 
 

Grow 
 

Permanently raise the value of a trait. Specify the target trait and the value (1 to 

1000) to be added. 
 

Learn Skill 
 

An actor will learn the specified skill. This effect will not be applied to enemies. 
 

Common Event 
 

Run the specified common event. Only one of this effect can be set for one type of 
data. 
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Events 

 
What Are Events? 

 
In RPGs, the game processes through things that happen in the game such as 

conversations with characters, getting items from treasure chests and fighting with 
bosses. Using this software, you will prepare those things that occur using data 

called "Events". 

 
Events are the mechanisms for carrying out some sort of process. For example, 

when a player talks to a character, you can assign an image and the sentences that 
appear on the screen for the character that responds by using events. 

 
It is a device which causes different things to happen in the game by running events 

depending on the play conditions and actions from the player. 
 

Event Types 
 

Events consist of the following 3 types. Those events related to the game's story and 
progression are made using "Map Events". 

 
Map Events 

 

Events which are run on the Map Screen. Use this type of event to express things 
like conversations with characters, and chests from which players can get items. 

Additionally, you can define events related to the game's structure and progression 
such as players changing locations and cut scenes through events that don't have 

images. 
  

To create and edit Map Events, switch to event editing mode by clicking the [Events] 
button in the toolbar in the Main Window (or by going to [Mode] → [Events] in the 

menu bar). 
 

Battle Events 

 
Events that are run in the Battle Screen. For example, these are used on events such 

as "Enemy transforms when HP is lower than the defined value". Create and edit 
these events in the [Troops] tab in the database. 

 
Common Events 

 
Events that are commonly run. Use these to call Map Events and Battle Events, and 

setting events that occur when using special items. Create and edit these events in 
the [Common Events] tab in the database. 
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Map Event System 
 
Map Event Processing Flow 

 
Expressing Events 

 
The details of events expressed in the game using map events are defined following 

this flow: where (location), what kind of situation (appearance conditions), what 
action is taken (trigger), what happens (contents). 

 
Events such as characters and chests with items in them are expressed by assigning 

images to the map events which defined the contents of what happens. Also, 
processes such as moving between the outside and inside of buildings, cutscenes 

that advance automatically can be prepared using events that do not have images. 
 

When creating an event, you first need to decide "where (location) and what 

happens) in the map view of the Main Window. After doing this, you will decide the 
remaining contents such as "what situation (appearance conditions)". 

 
Event Pages with "Conditional" Contents 

 
It is possible to change the details of what happens according to the play conditions 

of the game using map events. 
 

[Event Pages] are responsible for this. Event pages [conditionally] determine the 
contents of events. You can have one event with up to 20 event pages, and specify 

different images, triggers, and what processes are run for each. In other words, you 
can [conditionally] choose from 20 different events for one map event. 

 
Restrict Event Pages Using Appearance Conditions 

 

Deciding "what situation" to use the [conditional] event page is the [Conditions] 
parameter. Conditions are set based on criterion such as the values of [Switches] and 

[Variables], or "does the player have the specified item". 
 

Map events occur during gameplay based on the contents of the page which meet 
these conditions. When there are multiple pages which meet these [Conditions], the 

event page with the highest number will be used on the map. Conversely, nothing 
will happen on the map if there are no event pages which meet the [Conditions]. 

 
Evaluating Play Conditions 

 
Evaluating Play Conditions Using Switches 

 
Under [Conditions] in the event page, [Switches] and [Variables] are primarily used 

for determining the play conditions of the game. 

 
Switches record either the [ON] or [OFF] value. This is used for evaluating conditions 

of the game and state of progress such as "did the player accept the request from 
the king" or "did the player defeat the boss". 
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The game will start with all switches set to [OFF]. On top of that, when running an 
event that changes the position in the game, the specific switch's value in the 

"contents" will be switched to "ON". 

 
By using that switch in the [Conditions] of other event pages, it is possible to use the 

switch being set to [ON] to switch the contents of the map event all at once. The 
games story can be built through continuously changing the state of the overall 

game through the changing of these events. 
 

Variables That Store Values 
 

[Variables] are what store arbitrary values (integers). The values at the start of the 
game are set to 0, and you can do calculations such as assigning values of your 

choice according to the state of the game or add to other values (use [Control 
Variables] event command). 

 
By using this variable, you can do things like change the details of events using the 

HP of the player and the amount of gold they possess, allowing you to finely control 

the map event conditions and results. 
 

Management Switch Variables 
 

It is possible to use up to 5000 switches and variables each in one game. Which 
switch number/variable, what state is evaluated is up to the creator. Use names that 

help you understand their purposes so that you do not confuse the relationship of the 
two. You can set their names in the [Name] field in their respective selection 

windows. 
 

Using the "Self Switch" for Autonomous Events 
 

You can also use "Self Switches" in map events. This switch can be used only in each 
individual map event. You can store values in the 4 types of self switches, "A" 

through "D", included in an event. 

 
This self switch is used for evaluating the state of events that are completed using 

self processing. For example, for treasure chests which contain items, by managing 
whether the chest was opened or not using self switches, and setting the contents 

for "before opening" and "after opening" in two event pages, you can make it so that 
an item can be obtained only the first time the chest was checked. 
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Map Event Creation and Controls 
 
Map Event Creation and Controls 

 
Switch to Editing Mode 

 
To create and edit Map Events, switch to event editing mode by clicking the [Events] 

button in the toolbar in the Main Window (or by going to [Mode] → [Events] in the 
menu bar).  

 

Creating a New Map Event 
 

To create a new map event, double-click the location where you wish to place the 
event on the map view. Edit the settings for your event in the [Event Editor] Window 

that appears, and click [OK]. For more information on parameter details, please view 
[Map Event Settings]. 

 
Re-editing and Moving 

 
When you place a map event, an icon will be displayed at that location (the image 

that was selected on the first event page will be used). Double-clicking this icon will 
open the [Event Editor] Window where you can re-edit the event's settings details. 

You can change the location by dragging and dropping the icon. 
 

Event List 

 
Switching to Event Edit Mode will change the Tile Palette to the Event List. Selecting 

an event from the Event List will select the corresponding event on the map. Also, 
selecting an event on the map will select the corresponding event on the Event List. 

Double-clicking an item on the Event List will open the Event Editor. 
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Context Menu Controls 
 

When you right-click the map view in event editing mode, you can perform actions 

such as copying and deleting the event that you placed. The functions of each item 
are as follows. 

 
Edit ("New" when an event has not yet been placed) 

Opens the Event Editor Window. 
 

Cut 
Copies the map event that you right clicked to the clipboard and delete it. 

 
Copy 

Copies the map event that you right clicked to the clipboard. 
 

Paste 
Places the map event in the clipboard at the location you right-clicked. 

 

Delete 
Deletes the map event that you right-clicked. 

 
Quick Event Creation 

Creates 4 types of events using simple settings (mentioned later). 
 

Set Starting Position 
Sets the position for the player and vehicles at the start of the game. The 

starting position will be indicated by a blue frame. 
*Event icons use white frames. 

 
Quick Event Creation Feature 

 
By going to the [Quick Event Creation] section in the Context Menu, you can create 

the four following types of events often created in typical RPGs using simple settings: 

[Transfer], [Door], [Treasure] and [Inn]. The contents and parameter details for 
events that you can create using each option are as follows. 

 
Just like other events, events created using Quick Event Creation can also have their 

parameter details edited, copied, etc. 
 

Movement 
 

Creates an invisible (no image) event that transfers the player to the specified 
location. Use this for things such as entrances and stairs. In [Location] and 

[Direction], specify the location after transfer and the direction that the player is 
facing. 

 
Door 

 

Creates an event with an image that transfers the player to the specified location. 
Specify the image used in the [Image] field, and the location after transfer in 

[Location]. 
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Treasure 
 

Create an event where a player can get an item from a treasure chest limited to the 

first time the treasure chest is checked. Set the image to display in [Image], and 
specify what the player can obtain (gold/items/weapons/armor) in the [Content] 

section. 
 

Inn 
 

Event which allows the party to complete recover. Set the image to display in 
[Image], and the price in the [Price] field. 

 
Switch 

 
Creates a switch-based event. [Image] displays a picture of the switch. [Switch] 

displays the switch ID that can be set to an ON or OFF state. 
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Map Event Settings 
 
Common Settings and Event Page Controls 

 

 
 

ID (Displayed in Title Bar) 

 

The event's unique ID. IDs will be automatically set for each map in the order that 
they are created. This ID is used for occasions such as specifying events using 

variables. 
 

Name 
 

The name of the map event. This property is just used in the editor (does not affect 
the game). The name that uses the ID will be automatically entered in the initial 

state. Change the name of the event to something easily identifiable if necessary. 
 

Memo 
 

A text area where you can freely enter notes.  
 

Event Page ID 

 
The event page ID included in the event. By clicking a tab, you can switch to the 

event page that you want to edit. 
 

Event Page Control Buttons 
 

The buttons located towards the top of the window can be used to perform actions 
such as creating new event pages and deleting them. The functions of each button 

are as follows. 
 

New Event Page 
Creates a new consecutively numbered event page following the one that is 

currently being edited. Each following additional event page will have an ID 
that increases by 1 each time one is created. 

 

Copy Event Page 
Copies the contents of the event page currently being edited to the clipboard. 

 
Paste Event Page 

Adds (inserts) the event page in the clipboard using the ID that follows the 
event page currently being edited. Each event page added will have an ID that 

increases by 1 each time it is created. 
 

Delete Event Page 
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Deletes the event page that is currently being edited. The ID for each event 
page that follows the one that was deleted will have its ID decreased by 1. 

 

Clear Event Page 
Deletes the entire contents of the event page currently being edited (returns it 

to its initial state). 
 

Event Page Settings 

 

 
 
Appearance Conditions 
 
Conditions for the map event to appear on the map based on the settings of this 

event page. Enable what will be used as the conditions within the [Switch], 
[Variable], [Self Switch], [Item] and [Actor] settings, and set the criterion to be 

evaluated. 
 

Leave the condition settings as disabled when you want to have an event occur 
without any conditions. If multiple conditions are set, an event will only occur when 

all conditions are met. If the conditions of multiple event pages are met, the event 
with the ID with the highest value will be used. Conversely, an event will not occur if 

there are no pages which meet the conditions set. 
 

Switch 

 
The event will occur when the specified switch is set to ON. 

 
Variable 

 
The event will occur when the specified variable is greater than the fixed value. 

 



 
140/258 

 

Self Switch 
 

The event will occur when the specified self switch is set to ON. 

 
Item 

 
The event will occur when a party possesses the specified item. 

 
Actor 

 
The event will occur when the specified actor is in the party. 

 

Images 
 

Images that are displayed when an event occurs on a map. To specify an image, click 
the file list (left) and image (right) in order in the [Select an Image] window that 

appears when you double-click inside the frame. 
 

An image will not be visible on a map if an image is not set. Select [(None)] located 
in the very top of the file list in the [Select an Image] window to delete the image 

you have set.  
 

Autonomous Movement 
 
Specifies how the map event will move based on the [Type], [Speed] and 
[Frequency] settings. [Speed] determines the speed when the map event moves and 

the greater the number, the faster the map event will move. [Frequency] is the 
interval at which the map event moves and the greater the number, the shorter the 

movement interval will be. You can choose from the following 4 types of movements 
in [Type]. 

 
Fixed 

 
The map event will not move. 

 
Random 

 
The map event will move around at random. 

 

Approach 
 

The map event moves towards the location of the player. 
 

Custom 
 

The map event follows the specified route. You can specify the route in the window 
that appears when you click [Set Movement Route]. For more information, please 

refer to [Set Movement Route]. 
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Options 
 
How the image will be displayed. Enable the items to apply as necessary. 

 
Walking 

 
Displays animation when moving. Use when wanting to display characters and 

animals as walking. 
 

Stepping 

 
Displays the stepping animation while the character is stopped. Use when wanting to 

display the water's surface and fire as moving. 
 

Direction Fix 
 

Prevents the direction that the image is facing from changing while moving. 
 

Through 
 

Allows to pass through terrain and events that cannot be passed through. 
 

Priority 
 
Choose from the below in order to specify the priority of how players and other 

events are displayed on top of one another. The image that is on top will be 
prioritized and displayed when events and players can overlap. 

 
Below characters 

 
Players and so on will be able to move on top of this event. However, if a tile is 

selected in [Images], whether or not the player can move on top of that tile depends 

on the settings of the tile. 
 

Same as characters 
 

Will be at the same height as characters, and it will not be possible to go through 
this event. 

 
Above characters 

 
Players and so on will be able to move beneath this event. 

 

Triggers 
 

Choose the timing for when the processing of the [Contents] of an event that occurs 
on the map will be. 

 
Action Button 

 
When the player touches the event, and presses the action button while facing (when 
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overlapping an event where overlapping is possible) in the direction of the event 
 

Player Touch 

 
When the player touches the event (when overlapping an event where overlapping is 

possible), and presses the action button while in that state. 
 

Event Touch 
 

When an event makes contact (when overlapping where overlapping is possible) with 
a player through via the autonomous movement of the event as well as when in the 

same state as in [Player Touch]. 
 

Autorun 
 

When the event appears after meeting appear conditions. 
 

Parallel 

 
When the event appears after meeting appear conditions (contents of the event will 

be repeatedly processed). 
 

Contents 
 

List of the processes that will be run when the [Trigger] is activated. For more 

information, please refer to the following [Editing Contents] section. 
 

Editing Contents 
 

Viewing the Contents of the List 
 

Processes added to the game while playing are edited using commands called [Event 
Commands]. 

 
Event commands will be processed in order from the top item in the list and will be 

reflected in the game being played. Rows with a [◆] in the list indicate a registered 

event command. Rows with a [:] display the settings of event commands and 
indicate the position of where the flow of processes will be branched. 

 
Additional Event Commands 

 

Double-click the row with a [◆] to add an event command to the list. Select the 

event command to use in the window that appears, and define the details (excluding 

some parts) of the process. Double-clicking a row which already has an event 
command will insert the new event command in that position. 

 
Context Menu Controls 

 
Registered event commands will be displayed using a [◆]. Right-clicking this row will 

cause a menu to appear where you can perform actions such as [Copy] and [Delete]. 

Each available action is as follows. 
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New 
Inserts a new event command at the selected position. 

 

Edit 
Re-edit the settings of the event command in the row that is selected. 

 
Cut 

Copies the contents of the selected row to the clipboard and deletes it from the 
list. 

 
Copy 

Copies the contents of the selected row to the clipboard. 
 

Paste 
Inserts the contents of the clipboard to the row that is selected. 

 
Delete 

Delete the event command in the row that is selected. 

 
Select All 

Selects everything in the list as items to be edited. 
 

Copy as Text  
Copies the selected lines of text to the clipboard. 

 
Copy as HTML Tags 

Copies the HTML of the selected lines of text to the clipboard. 
 

Test 
Tests the selected event in the game screen. 

 
Toggle Skip 

Creates a skip option that blocks the execution of selected lines. 

Refer to [Skip Event Commands] for more information. 
 

Selecting Multiple Items at Once 
 

While having one of the rows in the list selected, clicking another row while holding 
down the [Shift] key will select all the event commands (blocks that have a [◆]) 

within that range. Right-clicking those items selected (highlighted in blue) will allow 

you to perform actions to all the items via a context menu. However, you can only 
select the items which are in the same branch when including branch processes. 

 
Skip Event Commands 

 
Press Ctrl + / or select Toggle Skip from the context menu while execution content is 

selected to create a skip command. 
 

The commands between [Skip] and [End] will not be executed. This function is useful 
for debugging or flow testing. 
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Event Commands 

 
The following event commands that can be used in [Contents] in events are as 

follows. Make good use of these to produce your game's story. 
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Messages 
 
Show Text 

 

 
 

Function 

 
Opens the Message Window and displays text. 

 

Settings 
 
Face 

 

Specifies the face image to display in the left side of the Message Window. You can 
select an image in the [Select an Image] Window that appears after double-clicking in 

the image area. 

Text 

 
Input the text to display. It is possible to display up to 4 lines of text at once in the 

Message Window. Press the [Enter] key to go to the next line when wanting to display 
text after the 2nd line. 

Right-click to show the menu. 

• [Plugin Help...] ・・・ Displays the Plugin Help. 

• [IconSet Viewer...] ・・・ Displays the IconSet Viewer. 

Background 
 

Select the Message Window format that will display the text. 

Window Position 

 

Specify either [Bottom], [Middle] or [Top] for the display position of the Message 

Window. 
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Preview 
 

You can check what will actually be displayed by clicking this. 

Batch Entry 
 

When enabled, it allows you to enter more than 4 lines of text. Text which exceeds 4 
lines will be set in the contents window after dividing every 4 lines into multiple [Show 

Text] event commands. 

 

Remarks 
 
• Pressing [Ctrl] + [Enter] while inputting text is the same as pressing the [OK] 

button. 
• The vertical line in the [Text] field is a guide for the amount of characters that 

are possible to display in the Message Window. To check whether the text is 
displayed as intended, enter text while checking the [Preview]. 

• You can display values of variables and names of actors by entering control 

characters into the text. Control characters and what will be displayed is as 
follows. Be sure to enter all control characters using half-width input. 

 

\V[n] Will be replaced with the value of the nth variable. 

\N[n] Will be replaced with the name of the nth actor. 

\P[n] Will be replaced by the name of the nth (arranged order) party member. 

\G Will be replaced by the currency unit. 

\C[n] 

Draw the subsequent text in the nth color. Text color conforms to the contents of the [Window.png] 

system image. 

\I[n] Draws the nth icon. 

\{ Increases the text by 1 step. 

\} Decreases the text by 1 step. 

\\ Replaced with the backslash character. 

\$ Open the gold window. 

\. Wait for 1/4 second. 

\| Wait for 1 second. 

\! Wait for button input. 

\> Display remaining text on same line all at once. 

\< Cancel the effect that displays text all at once. 

\^ Do not wait for input after displaying the next. 

 
 

* The control characters \V, \N, \P, \G, \C, \I, \\ may be used in the below places as 

well. 
• Event Command: [Show Choices] 

• Database: [Profile] in [Actor Settings] 
• Database: [Message] in [Skill Settings] 

• Database: [Description] in [Item Settings] and [Weapon/Armor Settings] 
• Database: [Messages] in [State Settings] 
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• Database: [Save Message] and [Load Message] fields in [Messages] in [Terms 
Settings] 

• Database: In [Messages] in [Terms Settings], the messages used during battle 

from [Party Name] and below (For things displayed in the window, \$ \. \| \! \> 
\< \^ may also be used) 

 
Show Choices 

 

 
 

Function 

 

Displays the Choices Window (up to 6 choices), and handles branches according to 
the player's choices. You can use control characters similar to how you use them in 

messages. 
 

Settings 
 

Choices (1 through 6) 
Specifies the text for the choices. Choices left blank will not be displayed. 

 
Background 

Specifies the background type for choices. 

 
Window Position 

Specifies the display position of the choices on the screen. 
 

Default 
Specifies the initial position of the cursor. 

 
Cancel 

Handling method for when the cancel button is pressed. 
 

Remarks 
 

• After confirming your settings, all the branches that handle the choices 

1 

b 
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(including Cancel) will be created in the [Contents] section. What will be run 
after selecting a choice will be set in these branches. 

 

Input Number 

 

 
Function 

 

Displays the Input Number screen, and assigns the value input by the player to a 

variable. 
 

Setting 
 

Variable 
Specify the variable that will store the number specified by the player. 

 
Digits 

Specify the number of digits (1 through 8) that the input will accept. 
 

Select Item 

 

 
 

Function 

 

Displays the Item Selection Window. Assigns the ID of the item that the player 
selects to a variable. 

 
Settings 

 

Variable 
Specifies the variable that the item number (item ID) selected by the player 
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will be assigned to. 
 

Item Type 

Specify the types of items to display in the list. 
 

Show Scrolling Text 

 

 
 

Function 

 

Displays text that scrolls from the bottom to the top. Scrolling will be fast forwarded 

when the confirm button is pressed. 
 

Settings 
 

Text 
Input the text to display. 

Right-click to show the menu. 
 

• [Plugin Help...] ・・・ Displays the Plugin Help. 

• [IconSet Viewer...] ・・・ Displays the IconSet Viewer. 

 

Speed 
Specifies the scroll speed (1 through 8). The higher the number, the faster the 

scrolling becomes. 
 

No Fast Forward 
Fast forwarding will not be possible when the confirm button is pressed. 
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Game Progression 
 
Control Switches 

 

 
 

Function 

 

Changes the values (ON/OFF) of switches. 
 

Settings 
 

Switch 
Specifies the switch to change. Select [Single] when controlling one switch, 

and specify the target switch. Select[Range] when wanting to change the 
values of a group of switches, and specify the number range of the switches. 

 
Operation 

Specifies the value (ON/OFF) to store in the switch. 
 

Control Variables 
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Function 

 

Changes the value stored in a variable. 
 

Settings 
 

Variable 
Specify the variable of the value you want to change. Select [Single] when 

controlling one variable, and specify the target variable. Select [Range] when 
wanting to change the values of a group of variables, and specify the number 

range of the variables. 
 

Operation 

Specify how the numbers will be calculated (refer to remarks). The variable 
calculated in [Variable] will change based on the value before the operation, 

method of calculation, and the operand. 
 

Operand 
Specifies the operand used for the [Operation] calculation (refer to remarks). 

 
Remarks 

 
Details regarding the method of calculation specified under [Operation] are as follows. 

 

Set Sets the value of the operand (no calculation). 

Add Sets a value calculated using [variable value before operation + operand]. 

Sub Sets a value calculated using [variable value before operation - operand]. 

Mul Sets a value calculated using [variable value before operation x operand]. 

Divide Sets a value calculated using [variable value before operation ÷ operand]. 

Mod Sets a value which is the remainder of [variable value before operation ÷ operand]. 

 
Details regarding [Operand] are as follows. These can be set from -99999999 to 

99999999). 
 

Constant Uses a fixed value. Specify the value in the right field. 

Variable Uses a variable. Specify the variable to reference. 

Random 

Uses a random (number chosen randomly) value. Range of the random value that can 

be generated (-99999999 to 99999999) 

Game Data 

Uses a value related to the play state of the game. Specify the information to 

reference in the window that opens when you click [...](refer below). 

Script Use the result evaluated as JavaScript for the value. 

 

When selecting [Game Data] as the [Operand], the type of data which the operand will 
be evaluated as will be one of the following. 

 

Item Uses the possession count of the specified item. 

Weapon Uses the possession count of the specified weapon. 



 
154/258 

 

Armor Uses the possession count of the specified armor. 

Actor 

Uses the actor's parameter (HP, MP, etc.) as the value. Specifies the target actor and 

parameter. 

Enemy 

Uses the enemy's parameter (HP, MP, etc.) as the value. Specifies the target enemy 

and parameter. This is only effective during battle. 

Character 

Uses values such as the coordinates and direction of the player or events. 

Map X, Map Y ：Map coordinates of current location 

Direction ：Current direction (up = 8 / left = 4 / right = 6 / down = 2) 

Screen X, Screen Y ：Uses the display position coordinates on the screen (pixels) 
 

Party Uses the ID of the actor at the specified position in the party. 

Other Uses all other data. 

 

Control Self Switch 
 

 
 

Function 
 

Controls the value of self switches. 
 

Settings 
 

Self Switch 

Specify the target self switch (A through D). 
 

Operation 
Specifies the value (ON/OFF) to store in the switch. 

 
Remarks 

 
This cannot be used in battle events. 

 
Control Timer 
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Function 

 

Start/stop the timer that calculates the time limit (time remaining). Starting the 
timer will cause the time remaining to be displayed at the top right of the screen. 

The timer will temporarily stop (will not be calculated) while the menu is displayed. 
To branch a process using the time left on the timer, use the [Conditional Branch] 

event command. 
 

Settings 
 

Operation 
Select [Start] to start calculating the time limit and select [Stop] to stop 

calculating it. 

 
Duration 

In the case that [Start] was selected under [Operation], specify the time limit 
(0 minutes, 0 seconds to 99 minutes, 59 seconds). 
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Flow Control 
 
Conditional Branch 

 

 
 

Function 

 

Specifies event commands which branch processes so that it is possible to run 
special processes only when specified conditions are met. When [Create Else Branch] 

is enabled, it is possible to branch conditions when the specified conditions are not 
met. 

 
Settings 

 
Specifies the conditions from the below options along with the evaluation criteria. 

 
Switch 

Use the value of the specified switch as a criterion. Set the target switch and 
its value to (ON/OFF). 

 
Variable 

Use the value of the specified variable as a criterion. Set the variable used to 

evaluate conditions, the value to compare, and the method for comparison. 
When using a variable for the value to compare, select [Variable], and specify 

the value to reference. 
 

 
Self Switch 

Use the state of the specified self switch as a criterion. Set the target self 



 
157/258 

 

switch and its value to (ON/OFF). 
 

Timer 

Use the remaining time on the timer as a criterion. Specify the remaining time 
and criterion (greater than/less than). 

 
Actor 

Use the specified actor as a criterion. Select the target actor, the content to 
reference (in party /name /class /skill /weapon /armor/state) and the 

evaluation criteria (specific item). 
 

Enemy 
Use the specified enemy during battle as a criterion. Select the target enemy 

and the evaluation criteria (appeared/state). This is only effective in battle 
events. 

 
Character 

Uses the direction of the player or map event as a criterion. Specify the target 

character and direction. This is only effective in map events. 
 

Vehicle 
Use whether the player is riding the specified vehicle (boat/ship/plane) as a 

criterion. 
 

Gold 
Use Gold possessed by the party as a criterion. Specify the amount and 

method for comparison (greater than/less than). 
 

Items 
Use whether the party possesses the specified item as a criterion. 

 
Weapons 

Use whether the party possesses the specified weapon as a criterion. When 

[Include Equipment] is enabled, the equipment that the actors are wearing will 
also be evaluated. 

 
Armor 

Use whether the party possesses the specified armor as a criterion. When 
[Include Equipment] is enabled, the equipment that the actors are wearing will 

also be evaluated. 
 

Button 
Use whether the specified button is pressed as a criterion. 

 
Pressed 

The conditions will count as being met the entire time the button is 
pressed. 

 

Triggered 
The conditions will count as being met only in the initial moment that the 

button is pressed. 
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Repeated 
While the button is continually pressed, the conditions will count as being 

met in the initial moment the button is pressed, then 24 frames after, 

then every 6 frames after that. 
 

Script 
For advanced users: use the evaluation result of the script as a criterion. 

Right-click to show the menu and choose [Plugin Help...] to display the Plugin 
Help. 

 
Loop 

 
Function 

 
Adds the event commands [Loop] and [Repeat Above] which carry out repeated 

processes used for control. You can repeatedly run the event commands set in the 
rows found between these two commands. It is also possible to use a "multiloop" 

which runs additional loops inside other loops. 

 
Remarks 

 
 Event commands between [Loop] and [Repeat Above] will be repeated indefinitely. 

Use the event commands such as [Break Loop] to end repeated processes. 
 

Break Loop 
 

Function 
 

Stops the process being repeated using the [Loop] event command. When this is 
run, the process will skip to the event command specified in the row after [Repeat 

Above]. There are no parameters to set. 
 

Exit Event Processing 

 
Function 

 
Stops processing of the contents. Event commands after this will not be processed. 

There are no parameters to set. 
 

Common Events 
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Function 

 

Invokes common events. After the common event that was invoked is finished 
processing, the game will move to the next event command. 

 
Settings 

 
Common Event 

Specify the common event to run. 
 

Label 

 

 
 

Function 

 

Creates a jump location for processes which use the [Jump to Label] event 
command. 

 

Settings 
 

Label Name 
Specify the name of the label. 

 
 

Jump to Label 
 

 
Function 
 

Causes the current process to jump to the location of the specified label. The event 
command of the row following this label will then be processed. 

 
Settings 

 

Label Name 
Specify the label name of the jump location. Only labels belonging to the same 

event page can be specified. 
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Comment 
 

 
 
Function 

 
Sets comments displayed in the contents list. Has no effect on the game.  

 
Settings 

 
Comment 

Set the text to be displayed as comments. 
Right-click to show the menu and choose [Plugin Help...] to display the Plugin 

Help. 
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Party 
 
Change Gold 

 

 
 

Function 

 

Changes the amount of gold of the party. 
 

Settings 
 

Operation 
Specify whether to increase or decrease gold. 

 
Operand 

Set the amount to increase or decrease gold. Choose [Constant] to change the 
gold using a fixed value, and enter the amount. Choose [Variable] to set the 

amount using a variable, and specify the variable to reference. 
 

Change Items 
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Function 

 

Changes the quantity of items of the party. Upon changing the quantity, if that 
number is outside of the 0 to 99 range, the value will be adjusted to either 99 (max 

number a player can have) or 0 (none in inventory). 
 

Settings 
 

Item 
Specify the item to increase or decrease. 

 
Operation 

Specify whether to increase or decrease the quantity. 

 
Operand 

Set the amount by which to increase or decrease the quantity. Choose 
[Constant] to change the quantity using a fixed value, and enter the amount. 

Choose [Variable] to set the amount using a variable, and specify the variable 
to reference. 

 
Change Weapons 

 

 
 

Function 
 

Changes the quantity of weapons of the party. Upon changing the quantity, if that 
number is outside of the 0 to 99 range, the value will be adjusted to either 99 (max 

number a player can have) or 0 (none in inventory). 

 
Settings 

 
Weapon 

Specify the weapon to increase or decrease. 
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Operation 
Specify whether to increase or decrease the quantity. 

 

Operand 
Set the amount by which to increase or decrease the quantity. Choose 

[Constant] to change the quantity using a fixed value, and enter the amount. 
Choose [Variable] to set the amount using a variable, and specify the variable 

to reference. 
 

Include Equipment 
When enabled, weapons that actors have equipped can also be decreased. 

 
Change Armors 

 

 
 

Function 

 

Changes the quantity of armors of the party. Upon changing the quantity, if that 
number is outside of the 0 to 99 range, the value will be adjusted to either 99 (max 

number a player can have) or 0 (none in inventory). 
 

Settings 

 
Armor 

Specifies the armor to increase or decrease. 
 

Operation 
Specifies whether to increase or decrease the quantity. 

 
Operand 

Set the amount by which to increase or decrease the quantity. Choose 
[Constant] to change the quantity using a fixed value, and enter the amount. 

Choose [Variable] to set the amount using a variable, and specify the variable 
to reference. 
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Include Equipment 
When enabled, armor that actors have equipped can also be decreased. 

 

Change Party Member 
 

 
 

Function 
 

Change the formation of the actors in the party. You can also change the number of 
actors in the party to 0 using this command. If so, players will not be displayed on 

the map. 
 

Settings 
 

Actor 
Select the actor to change. 

 

Operation 
Select which operation to perform (Add/Remove). 

 
Initialize 

When enabled, the traits when adding an actor will be reset according to the 
parameters in the [Database]. 
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Actor 
 
Change HP 

 

 
 

Function 

 

Changes the HP of the actor. 
 

Settings 
 

Actor 
Select the target actor. Select [Fixed] when wanting to select a specific actor 

and specify the actor (all members will be selected when selecting [Entire 
party]). Select [Variable] when wanting to select an actor using an ID number, 

and specify the value to reference. 
 

Operation 
Specify whether to increase or decrease the HP. 

 
Operand 

Specify the amount by which to raise or lower the HP. Select [Constant] to set 

this to a fixed value, and enter a value (1 to 9999). Choose [Variable] to set 
the amount using a variable, and specify the variable to reference. 

 
Allow Death 

When enabled, the actors will be knocked out when their HP falls to 0 or lower. 
When disabled, the HP will be set to 1 in the event their HP falls to 0 or lower. 

 
 

 



 
166/258 

 

Change MP 

 

 
 

Function 

 
Changes the MP of the actor.  

 

Settings 
 

Actor 
Select the target actor. Select [Fixed] when wanting to select a specific actor 

and specify the actor (all members will be selected when selecting [Entire 
party]). Select [Variable] when wanting to select an actor using an ID number, 

and specify the value to reference. 
 

Operation 
Specify whether to increase or decrease the MP. 

 
Operand 

Specify the amount by which to raise or lower the MP. Select [Constant] to set 
this to a fixed value, and enter a value (1 to 9999). Choose [Variable] to set 

the amount using a variable, and specify the variable to reference. 

 
Change TP 

 

(see image on next page) 
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Function 

 

Changes the TP of the actor. 

 
Settings 

 
Actor 

Select the target actor. Select [Fixed] when wanting to select a specific actor 
and specify the actor (all members will be selected when selecting [Entire 

party]). Select [Variable] when wanting to select an actor using an ID number, 
and specify the value to reference. 

 
Operation 

Specify whether to increase or decrease the TP. 
 

Operand 

Specify the amount by which to raise or lower the TP. Select [Constant] to set 
this to a fixed value, and enter a value (1 to 100). Choose [Variable] to set the 

amount using a variable, and specify the variable to reference. 
 

Change State 

 

(see image on next page) 
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Function 

 

Changes the state of the actor. 

 
Settings 

 
Actor 

Select the target actor. Select [Fixed] when wanting to select a specific actor 
and specify the actor (all members will be selected when selecting [Entire 

party]). Select [Variable] when wanting to select an actor using an ID number, 
and specify the value to reference. 

 
Operation 

Specify the content (Add/Remove) of the operation. 
 

State 

Specify the state that will be added or removed. 
 

Recover All 
 

 
 
Function 

 
Fully recovers the HP and MP of the actor, and removes all states. 
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Settings 
 

Actor 

Select the target actor. Select [Fixed] when wanting to select a specific actor 
and specify the actor (all members will be selected when selecting [Entire 

party]). Select [Variable] when wanting to select an actor using an ID number, 
and specify the value to reference. 

 
Change EXP 

 

 
 

Function 

 

Changes the EXP of the actor. 
 

Settings 
 

Actor 
Select the target actor. Select [Fixed] when wanting to select a specific actor 

and specify the actor (all members will be selected when selecting [Entire 
party]). Select [Variable] when wanting to select an actor using an ID number, 

and specify the value to reference. 

 
Operation 

Specify whether to increase or decrease the EXP. 
 

Operand 
Specify the amount by which to raise or lower the EXP. Select [Constant] to set 

this to a fixed value, and enter a value (1 to 99999999). Choose [Variable] to 
set the amount using a variable, and specify the variable to reference. 

 

https://github.com/googlei18n/libaddressinput
https://github.com/googlei18n/libaddressinput
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Show Level Up 
When enabled, a message will be displayed on the Play Screen indicating if an 

actor leveled up after their EXP increased. 

 
Change Level 

 

 
 
Function 

 
Changes the level of the actor. 

 
Settings 

 
Actor 

Select the target actor. Select [Fixed] when wanting to select a specific actor 
and specify the actor (all members will be selected when selecting [Entire 

party]). Select [Variable] when wanting to select an actor using an ID number, 

and specify the value to reference. 
 

Operation 
Specify whether to increase or decrease the level. 

 
Operand 

Specify the amount by which to raise or lower the level. Select [Constant] to 
set this to a fixed value, and enter a value (1 to 98). Choose [Variable] to set 

the amount using a variable, and specify the variable to reference. 
 

Show Level Up 
When enabled, a message will be displayed on the Play Screen indicating if an 

actor leveled up after their level increased. 
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Change Parameter 

 

 
 

Function 

 
Changes the actor's parameters. 

 

Settings 
 

Actor 
Select the target actor. Select [Fixed] when wanting to select a specific actor 

and specify the actor (all members will be selected when selecting [Entire 
party]). Select [Variable] when wanting to select an actor using an ID number, 

and specify the value to reference. 
 

Parameter 
Specify the type of parameter to increase or decrease. 

 
Operation 

Specify whether to increase or decrease the parameter. 
 

Operand 

Specify the amount by which to raise or lower the parameter. Select [Constant] 
to set this to a fixed value, and enter a value (1 to 9999). Choose [Variable] to 

set the amount using a variable, and specify the variable to reference. 
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Change Skill 

 

 
 

Function 

 
Controls the skills that actors can use. 

 

Settings 
 

Actor 
Select the target actor. When selecting a specific actor, select [Fixed] and 

specify the actor. Select [Variable] when wanting to select an actor using an ID 
number, and specify the value to reference. 

 
Operation 

Select [Learn] to make a skill useable, and select [Forget] to make it unusable. 
 

Skill 
Specify the skill that will be added or removed. 

 
Change Equipment 
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Function 

 

Changes the equipment of the actor. 
 

Settings 
 

Actor 
Select the target actor. 

 
Equipment Type 

Specify the type of equipment to change. 
 

Equipment Item 

Specify the new equipment to equip. A party must possess the specified 
equipment. 

 
Remarks 

 
 Equipment will not be changed in the party does not possess the specified equipment 

item. To forcibly equip an item, you must first give the equipment armor to the party 
using the [Change Weapons] and [Change Armors] event commands. 

 
Change Name 

 

 
 

Function 

 
Changes the name of the actor.  

 
Settings 

 
Actor 

Select the target actor. 

 
Name 

Specify the name after changing it. 
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Change Class 

 

 
 

Function 

 

Changes the class of the actor. 
 

Settings 

 
Actor  

Select the target actor. 
 

Class 
Specify the class to be changed to. 

 
Save Level 

Check off the box to keep the same level as before class has been changed. 
 

Remarks 
 

Equipment and armor that cannot be equipped will automatically be unequipped. 
 

Change Nickname 

 

 
 

Function 

 

Changes the nickname of the actor.  
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Settings 
 

Actor 

Select the target actor. 
 

Nickname 
Specify the nickname after changing it. 

 
Change Profile 

 

 
 

Function 

 

Changes the profile of the actor.  

 
Settings 

 
Actor 

Select the target actor. 
 

Profile 
Specify the profile after changing it. 
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Movement 

 
Transfer Player 

 

 
 

Function 

 
Changes the location of the party. 

 
Settings 

 
Location 

Specify the location after changing it. To move a party to a specific location, 

select [Direct designation], and click to specify the location to move the party 
in the window that is displayed when you click [...]. To specify the location 

using a map ID and coordinates, select [Designation with variables], and 
specify the variables to reference in [ID], [X], [Y]. 

 
Direction 

Specify the direction of the player after being transferred. 
 

Fade 
Specify how the screen will transition during a transfer. The screen will be 

displayed in black when choosing [Black] and [White] when choosing white, 
followed by displaying the new map location. 
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Set Vehicle Location 

 

 
 

Function 

 

Changes the location of vehicles. 
 

Settings 

 
Vehicle 

Specify the target vehicle (boat/ship/plane). 
 

Location 
Specify the location after changing the location. To move a vehicle to a specific 

location, select [Direct designation], and click to specify the location to move 
the vehicle in the window that is displayed when you click [...]. To specify the 

location using a map ID and coordinates, select [Designation with variables], 
and specify the variables to reference in [ID], [X], [Y]. 

 
Set Event Location 
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Function 

 

Changes the location of an event. 

 

Settings 

 
Events 

Specify the target event. By setting this to [This Event], the event itself will be 
the target for changing the location. Moving the event is limited to the same 

map. 
 

Location 
Specify the location after changing the location. To move an event to a specific 

location, select [Direct designation], and click to specify the location to move 
the event in the window that is displayed when you click [...]. To specify the 

location using a map ID and coordinates, select [Designation with variables], 
and specify the variables to reference in [ID], [X], [Y]. 

 

Direction 
Specify the direction of the event after being moved. 

 
Remarks 

 
This cannot be used in battle events. 

 
Scroll Map 

 

 
Function 

 

Moves (scrolls) the range of the map displayed while playing without changing the 
location of the player. 

 
Settings 

 
Direction 

Specify the direction to scroll. 
 

Distance 
Specify the distance (number of tiles) to move. 
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Speed 
Specify the speed (6 levels) of the scrolling. 

 

Wait for Completion 
When enabled, will wait until scroll is complete. 

 
Remarks 

 
This cannot be used in battle events. 

 
Set Movement Route 

 
Function 

 
Forces the player or map event to move along a specified route. For more 

information please refer to the [Set Movement Route] chapter below. 
  

Remarks 

 
• Characters set on a movement route will start to move immediately. 

• Using this event command on characters which are already set on 
movement routes will cause those settings to be abandoned, and only 

the new settings will be active. Choose [Wait for Completion] when 
wanting to set the next route after the movement from a previous route 

is completed. 
• When [Wait for Completion] is enabled, the player cannot perform any 

actions until the movement command has finished (excluding processes 
running in parallel). If the character on the specified movement route 

runs into any obstacles during this time and the movement command is 
no longer able to run, the event will stop at that point. Enable options 

such as [Skip If Cannot Move] to avoid these sort of situations. 
• The player's total number of steps will not be added using this event 

command even if they move. 

• This cannot be used in battle events. 
 

Get on/off Vehicle 
 

Function 
 

Controls getting on and off vehicles. The player will get off onto the ground when on 
the vehicle, and get on the vehicle when not on it. There are no parameters to set. 

 
Remarks 

 
• This event forces the player to get on or off the vehicle just as when they 

use the [Action] key. Nothing will happen if there are no vehicles 
available that can normally be ridden (when there are no vehicles that 

can be boarded and when there is no ground to move to).  

• This cannot be used in battle events. 
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Movement Route Settings 
 
 

What is a Movement Route? 
 

A movement route determines how a player or event will move. This is set if 
[Custom] is selected in the event's [Autonomous Movement] settings, as well as 

when using [Set Movement Route]. 
 

Either setting will be carried out in the [Set Movement Route] window. Routes can be 
edited when used with [Movement Commands] that control the movement, direction, 

etc. of the player. For example, entering in the [Move Right], [Move Down], [Move 
Left] and [Move Up] movement commands will cause the player, etc. to move in a 

loop going clockwise from their current location. 
 

Parameter Details 

 

 
 

Player 

 
Specify the target actor/event for the movement route. This will be set only when 

configuring the [Set Movement Route] event command. 

 
Preview 

 
A preview of the movement route on the map will be carried out. 

 
Command List 

 
List of movement commands that have been entered. Movement commands are 

entered in the order of the route that will be set here. 
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Movement commands clicked in the movement command list will be added at the 
position of the item clicked in the list. Additionally, you can perform actions such as 

reediting settings and copying them using the context menu that is displayed when 

you right-click an item. 
 

Movement Commands 
 

Group of commands to control the movement and direction of characters 
(players/events). A command will be added (inserted) at the location which is 

currently selected in the command list by clicking a command's button. The 
movement for each command is as follows. The movement distance for 1 step is 

equal to one tile. 
 

Move Down/Move Left/Move Right/Move Up/Move Lower Left/Move Lower 
Right/Move Upper Left/Move Upper Right 

Move 1 step in the direction indicated in the command's name. 

Move at Random 

Move 1 step in a randomly selected direction between up, down, left and right. 

Move toward Player 

Move 1 step towards the direction of the player. 

Move away from Player 

Move 1 step in the direction away from the player. 

1 Step Forward 

Move 1 step in the direction currently faced. 

1 Step Backward 

Move 1 step away from the direction currently faced. 

Jump 
Move using a jump. Specify the distance to jump by setting the [X coordinate] 

and [Y coordinate] (each can be between -100 and 100, with a positive value 
being in the right/down direction). Players will move through obstacles during a 

jump. Moreover, members from the 2nd party member and on will remain in that 

location for parties which have [Show Player Followers] set to ON when jumping. 

Wait 

Specify the time to stop the process in number of frames (1 to 999). 1 frame is 

equal to 1/60th of a second. 

Turn Down/Turn Left/Turn Right/Turn Up 

Change the direction faced using the direction in the name. 

Turn 90° Right/Turn 90° Left 

Change the direction faced by 90° using the direction in the name. 

Turn 180° 

Face the opposite of the direction currently faced. 
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Turn 90° Right or Left 

Change the direction randomly by 90°. 

Turn at Random 

Face up, down, left or right randomly. 

Turn toward Player 

Face toward where the player is. 

Turn away from Player 

Face the opposite direction of where the player is. 

Switch ON/Switch OFF 

Change the specified switch to the value in the name of the command. 

Change Speed 

Change the [Speed] setting under [Autonomous Movement] of the target map 

event. This change will continue even after movement has finished. 

Change Frequency 
Change the [Frequency] setting under [Autonomous Movement] of the target 

map event. This change will continue even after movement has finished. 

Walking Animation ON/Walking Animation OFF 

Change the value of the [Walking] setting under [Options] of the target map 

event. This change will continue even after movement has finished. 

Stepping Animation ON/Stepping Animation OFF 

Change the value of the [Stepping] setting under [Options] of the target map 

event. 

Direction Fix ON/Direction Fix OFF 
Change the value of the [Direction Fix] setting under [Options] of the target map 

event. This change will continue even after movement has finished. 

Through ON/Through OFF 

Change the value of the [Through] setting under [Options] of the target map 

event. This change will continue even after movement has finished. 

Transparent ON/Transparent OFF 
Change the image of the character to be displayed/hidden. The character will not 

be displayed when this is set to ON. This change will continue even after 

movement has finished. 

Change Image 

Change the character's image to the specified image. This change will continue 

even after movement has finished. 

Change Opacity 
Change the opacity (0 to 255) of the image of the character. The image will be 

invisible when this is set to 0. This change will continue even after movement has 
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finished. 

Change Blend Mode 

Change the blending method of the colors displayed for the characters and map. 

• [Normal] ・・・ Displayed as normal. 

• [Additive] ・・・ Displayed in a whiter color. 

• [Multiply] ・・・ Displayed in a darker color. 

• [Screen] ・・・ Displayed in a brighter color. 

 

Play SE 

Play the specified SE. 

Script 

Run the loaded script. 

Options 
 

This is a way to processes all movement commands entered into the command list. 
Enable the processes to apply as necessary. 

 
Repeat Movements 

When enabled, the contents of the command list will be run repeatedly. 

 
Skip If Cannot Move 

When enabled, the processes will be skipped when it is not possible to move 
via movement commands due to things like obstacles. 

 
Wait for Completion 

When enabled, all other processes will be temporarily stopped until all vent 
commands are finished being processed. This will be set only when configuring 

the [Set movement Route] event command. 
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Character 
 
 

Change Transparency 

 

Function 

 

Controls the display (transparency) of the party moving on the map. 
 

Settings 
 

Transparency 
Set to [ON] to make the party invisible, set it to [OFF] to make the party 

visible. 
 

Change Player Followers 

 

Function 

 

Controls whether or not the party members from the 2nd member and on are 

displayed while walking. 
 

Settings 
 

Player Followers 
Set to [ON] to make the party visible, set it to [OFF] to hide the party. 

 
Remarks 

 
• Only 4 actors starting from the first will be displayed even when there are 5 

members in a party. 

 
Gather Followers 

 
Function 

 
Moves all party members to the same location as the lead actor. There are no 

parameters to set. 
 

Show Animation 

 

Function 

 

Shows animations on the map. 
 

Settings 

 
Character 

The display location will be based on the position of the player and events. 
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Animations 
Specify the animation to display. 

 

Wait for Completion 
When enabled, the event will be paused until the animation being displayed 

has finished. 
 

Remarks 
 

• This cannot be used in battle events. 
• Use the [Show Battle Animation] event command when wanting to play an 

animation during battle. 
 

Show Balloon Icon 
 

 
 

Function 

 
Display icons that express emotions using balloons that appear over the party and 

events. 10 types of icons such as "!" for being surprised and a light bulb when a 
character has a good idea are available. It is also possible for users to define their 

own balloon icons. 
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Settings 
 

Character 

The display location will be based on the position of the player and events. 
 

Balloon Icon 
Specify the balloon icon to display. 

 
Wait for Completion 

When enabled, the event will be paused until the balloon icon being displayed 
has disappeared. 

 
Erase Event 

 
Function 

 
Temporarily removes the event currently being run. There are no parameters to set. 

The event will remain erased until the party moves to another map. 

 
Remarks 

 
This cannot be used in battle events. 
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Picture 
 
 

Show Picture 

 

 
 

Function 

 

Displays a picture (static image) on the screen. 
 

Settings 
 

Picture: Number 
Specify a control number (1 to 100) to link to the picture. 

 
Picture: Image 

Specify the picture to display. 
 

Position 
Specify the display position of the picture. First, select the [Origin Point] of the 

picture which can be the [Upper Left] or [Center] of the screen. After doing so, 

specify the position using coordinates which will use (0, 0) as the origin. When 
using [Direct designation], enter in coordinates (-9999 to 9999) for [X] which 

will be the horizontal position, and [Y] which will be the vertical position. To 
specify the location using variables to specify coordinates, select [Designation 

with variables], and specify the variables for [X], and [Y]. 
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Scale 
Specify the percentage to scale the image (between 0 and 2000% with 100% 

being the original size) using the [Width] and [Height] fields. 

 
Blend 

Specify the opacity (0 to 255) of the picture under [Opacity]. The smaller the 
value, the more transparent the picture will be (will not be displayed if 0). 

Specify how to blend the image colors when changing the opacity of the image 
under [Blending Mode]. 

 
• [Normal] ・・・ Displayed as normal. 

• [Additive] ・・・ Displayed in a whiter color.  

• [Multiply] ・・・ Displayed in a darker color.  

• [Screen] ・・・ Displayed in a brighter color. 

 

Remarks 
 

• 100 pictures can be displayed at one time. The higher the control number, 
the higher it will be prioritized when displayed. 

• If there are multiple of the same control number, only the picture that was 
displayed last will be displayed (all earlier pictures will be erased). 

 
Move Picture 
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Function 
 

Moves the currently displayed picture. 

 
Settings 

 
Picture: Number 

Specify the control number (1 to 100) for the target picture. 
 

Position 
Specifies the position of the picture after it has been moved. First, select the 

[Origin Point] of the picture which can be the [Upper Left] or [Center] of the 
screen. Next, specify the position using coordinates which will use (0, 0) as the 

origin. When using [Direct designation], enter in coordinates (-9999 to 9999) 
for [X] which will be the horizontal position, and [Y] which will be the vertical 

position. To specify the location using variables to specify coordinates, select 
[Designation with variables], and specify the variables for [X], and [Y]. 

 

Scale 
Specify the percentage (0 to 2000%) by which to scale the [Width] and 

[Height] of the picture after it has been moved. 
 

Blend 
Specify the opacity (0 to 255) of the picture after it has been moved under 

[Opacity]. The smaller the value, the more transparent the picture will be (will 
not be displayed if 0). Specify how to blend the image colors when changing 

the opacity of the image under [Blending Mode]. 
 

• [Normal] ・・・ Displayed as normal. 

• [Additive] ・・・ Displayed in a whiter color.  

• [Multiply] ・・・ Displayed in a darker color.  

• [Screen] ・・・ Displayed in a brighter color. 

 
Duration 

Specify the amount of time moving the picture will take in number of frames (1 
to 999). 1 frame is equal to 1/60th of a second.Wait for CompletionWhen 

enabled, processing will wait for this event command to finish. 
 

Wait for Completion 
When enabled, processing will wait for this event command to finish. 

 
Rotate Picture 

 

 

http://www.ijg.org/
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Function 

 

Rotates the displayed image. 
 

Settings 
 

Picture: Number 
Specify the control number (1 to 100) for the target picture. 

 
Rotation: Speed 

It will be rotated clockwise when this number is positive, and counterclockwise when 
negative. 

 

Remarks 
 

The rotation axis (center point) will be set to the origin that was specified for the 
target picture when it's last displayed/moved. 

 
Tint Picture 

 

 
 

Function 

 

Changes the color tone of the picture that is displayed. 
 

Settings 
 

Picture: ID 
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Specify the control number (1 to 100) for the target picture. 
 

Color Tone 

Specifies the amount of each [Red], [Green] and [Blue] to add (-255 to 255). 
Set the strength of the gray scale filter (0 to 255) by changing the [Gray] 

value. The higher the value, the stronger the overall color tone will be. Check 
the color tone using the preview area on the right. 

 
Time 

Specify the amount of time changing the tint of the picture will take in number 
of frames (1 to 999). 1 frame is equal to 1/60th of a second. 

 
Wait for Completion 

When enabled, processing will wait for this event command to finish. 
 

Remarks 
 

The changed color tone will be effective until updated again by this event command. 

 
Erase Picture 

 

 
 

Function 

 

Erases the picture displayed.  

 
Settings 

 
Picture: NumberSpecify the control number (1 to 100) for picture to be deleted. 
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Timing 
 
 

Wait 

 

 
 

Function 

 

Temporarily stops the event. While stopped, the player cannot perform any actions 
(excluding processes running in parallel). 

 
Settings 

 
Duration 

Specify the time to stop the process in number of frames (1 to 999). 1 frame is 
equal to 1/60th of a second. 
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Screen 
 
 

Fadeout Screen 
 

Function 
 

Fades out the screen (slowly fades the screen into black). There are no parameters 
to set. 

 
Remarks 

 
• The screen will remain faded out until the [Fadein Screen] event command 

is run. 
• Elements such as the menu, message windows and battle command window 

will still be visible even while faded out. 

• If run during a battle event, everything except the command window and 
messages will appear black, and enemies, etc. will not be visible. 

 
Fadein Screen 

 
Function 

 
Returns the screen back to normal after using [Fadeout Screen]. There are no 

parameters to set. 
 

Tint Screen 

 

 
 

Function 

 

Changes the color tone of the entire screen. The color tone of pictures and message 
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windows will not change. 
 

Settings 

 
Color Tone 

Specify the amount of each [Red], [Green] and [Blue] to add (-255 to 255). 
Set the strength of the gray scale filter (0 to 255) by changing the [Gray] 

value. The higher the value, the stronger the overall color tone will be. By 
clicking the [Normal], [Dark], [Sepia], [Sunset] and [Night] buttons below, 

values representing each color tone will be applied ([Normal] will return the 
color tone back to its original setting). Check the color tone using the preview 

area on the right. 
 

Duration 
Specify the amount of time changing the tint of the picture will take in number 

of frames (1 to 999). 1 frame is equal to 1/60th of a second. 
 

Wait for Completion 

When enabled, processing will wait for this event command to finish. 
 

Remarks 
 

This color tone will remain in effect, including during battle, until using this event 
command is used again to change the settings. 

 
Flash Screen 

 

 
 

Function 
 

Causes the entire screen to change to the specified color for just an instant, and will 
slowly return back to normal. You can use this to express things like lightning. 
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Settings 
 

Flash Color 

Specify the color to display based on each of the [Red], [Green] and [Blue] 
component values (0 to 255). The specified color can be checked in the 

preview area on the right. [Intensity] sets the opacity (0 to 255) of the color. 
Putting this to 0 will cause it to be completely transparent, and will not affect 

what appears on the screen. 
 

Duration 
Specify the amount of time the flash will last in number of frames (1 to 999). 1 

frame is equal to 1/60th of a second. 
 

Wait for Completion 
When enabled, processing will wait for this event command to finish. 

 
Shake Screen 

 

 
 

Function 

 

Shakes the entire screen left to right. 

 
Settings 

 
Shake 

Set the size (1 to 9) of the shaking range using the [Power] parameter, and the 
speed (1 to 9) of the shaking using the [Speed] parameter. 

 
Duration 

Specify the amount of time the shaking will last in number of frames (1 to 
999). 1 frame is equal to 1/60th of a second. 

 
Wait for Completion 

When enabled, processing will wait for this event command to finish. 
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Set Weather Effect 
 

 
 

Function 
 

Controls the display of effects which represent weather (rain/storm/snow). 
 

Settings 
 

Type 
Specify the type of image to display. Set to [None] to stop displaying an image. 

 
Power 

Specify the amount of images to display (1 to 9). 
 

Duration 
Specify the amount of time changing the weather will take in number of frames 

(1 to 999). 1 frame is equal to 1/60th of a second. 

 
Wait for Completion 

When enabled, processing will wait for this event command to finish. 
 

Remarks 
 

This cannot be used in battle events. 
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Audio & Video 
 
 

Play BGM 

 

 
 

Function 

 

Starts playing the BGM (background music). 

 
Settings 

 
File List 

Select the BGM file to play. Set to [(None)] to stop playing the music. 
 

Play/Stop 
By clicking [Play], BGM will start playing using the current settings. Click 

[Stop] to stop the music. 
 

Volume 
Specify the volume. 

 

Pitch 
Specify the pitch (50 to 150%). When this is set to over 100%, the playback 

speed becomes faster and the musical scale gets higher. 
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Pan 
Set the pan (-100 to 100). When set to a negative value, more sound will 

come out of the left speaker. When set to a positive value, more sound will 

come out of the right speaker. 
 

Remarks 
 

This event will not run if the specified BGM is already playing. 
 

Fadeout BGM 

 

 
 

Function 

 

Stops the playback while lowering the volume of the BGM.  
 

Settings 
 

DurationSpecify the amount of seconds (1 to 60) the fade-out takes. 
 

Save BGM 
 

Function 

 
Saves the BGM currently being playing including the playtime position. There are no 

parameters to set. 
 

Rsume BGM 
 

Function 
 

Resume the BGM saved with [Save BGM]. There are no parameters to set. 
 

Play BGS 

 

 

(see image on next page) 
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Function 

 

Starts playing the BGS (background sound). 

 
Settings 

 
File List 

Select the BGS file to play. Set to [(None)] to stop playing the sound. 
 

Play/Stop 
By clicking [Play], BGS will start playing using the current settings. Click [Stop] 

to stop the BGS. 
 

Volume 
Specify the volume. 

 

Pitch 
Specify the pitch (50 to 150%). When this is set to over 100%, the playback 

speed becomes faster and the sound scale gets higher. 
 

Pan 
Sets the pan (-100 to 100). When set to a negative value, more sound will 

come out of the left speaker. When set to a positive value, more sound will 
come out of the right speaker. 
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Remarks 
 

This event will not run if the specified BGS is already playing. 

 
Fadeout BGS 

 

 
 

Function 

 

Stops the playback while lowering the volume of the BGS.  

 
Settings 

 
Duration 

Specify the amount of seconds (1 to 60) the fade-out takes. 
 

Play ME 
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Function 
 

Starts playing the ME (Music Effect). 

 
Settings 

 
File List 

Select the ME file to play. Set to [(None)] to stop playing the ME. 
 

Play/Stop 
By clicking [Play], ME will start playing using the current settings. Click [Stop] 

to stop the music. 
 

Volume 
Specify the volume. 

 
Pitch 

Specify the pitch (50 to 150%). When this is set to over 100%, the playback 

speed becomes faster and the scale gets higher. 
 

Pan 
Set the pan (-100 to 100). When set to a negative value, more sound will 

come out of the left speaker. When set to a positive value, more sound will 
come out of the right speaker. 

 
Remarks 

 
This event will not run if the specified ME is already playing. 

 
Play SE 
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Function 
 

Starts playing the SE (sound effects). 

 
Settings 

 
File List 

Select the SE file to play. 
 

Play/Stop 
By clicking [Play], SE will start playing using the current settings. Click [Stop] 

to stop the SE. 
 

Volume 
Specify the volume. 

 
Pitch 

Specify the pitch (50 to 150%). When this is set to over 100%, the playback 

speed becomes faster and the scale gets higher. 
 

Pan 
Sets the pan (-100 to 100). When set to a negative value, more sound will 

come out of the left speaker. When set to a positive value, more sound will 
come out of the right speaker. 

 
Remarks 

 
• If this command is run before the SE finishes playing, sound effects will 

be played on top of each other. 
• SE will not stop playing even if [(None)] is played. Please use the Stop 

SE event command to stop SE from playing. 
 

Stop SE 

 
Function 

 
Stops the playback of all SE (sound effects). There are no parameters to set. 

 
Play Movie 
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Function  

 

Plays a movie. 

 

Settings 

 
File List 

Select the movie file to play. 
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Scene Control 
 
 

Battle Processing 

 

 
 

Function 

 

Causes troops to appear and starts a battle. 
 

Settings 
 

Troop 
Specify the troop that the player will fight against. Choose "Direct designation" 

and select the troop to have the player fight against a specific troop. To specify 
a troop by ID, choose "Designation with a variable" and enter in the value to 

reference. If you choose "Same as Random Encounter", the chosen troop will 
appear based on the [Encounter] settings of the map that the party is currently 

in. 
 

Can Escape 

When enabled, the [Escape] command will be enabled during battle, and you 
can make conditional branches based on "if player won" and "if player 

escaped". 
 

Can Lose 
When enabled, there will not be a game over even if the entire party is 

defeated, and you can make conditional branches based on "if player won" and 
"if player lost". 

 
Remarks 

 
This cannot be used in battle events. 
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Shop Processing 

 

 
 

Function 

 

Calls the shop screen where the player can buy weapons, armors and items.  
 

Settings 

 
Merchandise 

Specify the items to sell. Set the [Merchandise] and [Price] in the window that 
is displayed when you double-click an empty row in the list. Choosing 

[Standard] will set the price to what was set in the data, and choosing 
[Specify] will set this price only to what is specified using this event command. 

 
Purchase Only 

When enabled, the player will be unable to sell items. 
 

Remarks 
 

This cannot be used in battle events. 
 

 

Name Input Processing 
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Function 

 

Displays the name input screen for actors, and the actors name will be changed 
according to the input of the player. 

 
Settings 

 
Actor 

Specify which actor will have their name changed. 
 

Max characters 
Specify the max amount of characters (1 to 16) for the name. 

 

Remarks 
 

• This cannot be used in battle events. 
• When entering a name while playing, you can move the cursor using the 

D-pad, and enter characters using the confirm button and delete the last 
character using the delete button. 

 
Open Menu Screen 

 
Function 

 
Calls the Menu Screen. There are no parameters to set. 

 
Remarks 

 

This cannot be used in battle events. 
 

Open Save Screen 
 

Function 
 

Calls the Save Screen. There are no parameters to set. 
 

Remarks 
 

This cannot be used in battle events. 
 

Game Over 
 

Function 

 
Forces the game to end and displays the Game Over Screen. There are no 

parameters to set. 
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Return to Title Screen 
 

Function 

 
Forces the game to end and returns to the Title Screen. There are no parameters to 

set. 
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System Settings 
 
 

Change Battle BGM 

 

 
 

Function 

 

Changes the settings of the BGM that plays during battle. These settings will be left 

unchanged until changed using this event command again. 
 

Settings 
 

File List 
Specify the BGM file that will be used. Select [(None)] if you do not want to 

play a file. 
 

Play/Stop 
By clicking [Play], BGM will start playing using the current settings. Click 

[Stop] to stop the BGM. 
 

Volume 

Specify the volume. 
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Pitch 
Specify the pitch (50 to 150%). When this is set to over 100%, the playback 

speed becomes faster and the scale gets higher. 

 
Pan 

Set the pan (-100 to 100). When set to a negative value, more sound will 
come out of the left speaker. When set to a positive value, more sound will 

come out of the right speaker. 
 

Remarks 
 

• If this is changed during battle, the settings will take effect from the next 
battle. 

• When the map and battle BGM is identical, the music will not stop when 
switching between screens. 

 
Change Victory ME 

 

 
 

Function 
 

Changes the settings for the ME that plays when winning a battle. These settings will 
be left unchanged until changed using this event command again. 
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Settings 
 

File List 

Specify the ME file that will be used. Select [(None)] if you do not want to play 
a file. 

 
Play/Stop 

By clicking [Play], ME will start playing using the current settings. Click [Stop] 
to stop the ME. 

Volume 
Specify the volume. 

 
Pitch 

Specify the pitch (50 to 150%). When this is set to over 100%, the playback 
speed becomes faster and the scale gets higher. 

 
Pan 

Sets the pan (-100 to 100). When set to a negative value, more sound will 

come out of the left speaker. When set to a positive value, more sound will 
come out of the right speaker. 

 
Change Defeat ME 
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Function 
 

Changes the settings for the ME that plays when losing a battle. These settings will 

be left unchanged until changed using this event command again. 
 

Settings 
 

File List 
Specify the ME file that will be used. Select [(None)] if you do not want to play 

a file. 
 

Play/Stop 
By clicking [Play], ME will start playing using the current settings. Click [Stop] 

to stop the ME. 
 

Volume 
Specify the volume. 

 

Pitch 
Specify the pitch (50 to 150%). When this is set to over 100%, the playback 

speed becomes faster and the sound scale gets higher. 
 

Pan 
Set the pan (-100 to 100). When set to a negative value, more sound will 

come out of the left speaker. When set to a positive value, more sound will 
come out of the right speaker. 

 
Change Vehicle BGM 

 

 
 

Function 

 

Changes the settings for the BGM music that plays when riding a vehicle. 
 

Settings 
 

Vehicle 

Specify the vehicle for the BGM. 
 

BGM 
Specify the BGM that will be played. 
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Change Save Access 

 

 
 

Function 

 

Changes whether or not the game can be saved by the player. These settings will be 
left unchanged until changed using this event command again. 

 

Settings 
 

Save 
Set this to [Disable] to prevent the player from saving, and [Enable] to allow 

the player to save. 
 

Change Menu Access 

 

 
Function 

 

Changes whether or not the Menu Screen can be called by the player. These settings 
will be left unchanged until changed using this event command again. 

 
Settings 

 
Menu 

Set this to [Disable] to prevent the player from opening the Menu Screen, and 
[Enable] to allow the player to open the Menu Screen. 

 
Change Encounter 
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Function 

 

Controls whether or not encounters (process that randomly causes a battle against a 
troop) occur. These settings will be left unchanged until changed using this event 

command again.  
 

Settings 
 

Encounter 
Set this to [Disable] to stop encounters, and [Enable] to allow encounters. 

 
Change Formation Access 

 

 
 

Function 

 
Controls whether or not a player can change the formation of his or her party 

members. These settings will be left unchanged until changed using this event 

command again. 
 

Settings 
 

Formation 
Set this to [Disable] to prevent the player from changing the party, and [Enable] to 

allow the player to change the party. 
 

Change Window Color 

 

 
 

Function 

 
Changes the window color settings. These settings will be left unchanged until 
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changed using this event command again. 
 

Settings 

 
Window Color 

Specifies the color after it is changed based on each of the [Red], [Green] and 
[Blue] component values (255 to 255). The specified color can be checked in 

the preview area on the right. 
 

Change Actor Images 

 

 
Function 

 

Changes the image of an actor. These settings will be left unchanged until changed 

using this event command again. 
 

Settings 
 

Actor 
Select the target actor. 

 
Images 

You can set images for the [Face], [Character], and [ [SV] Battler] in the 
window that opens when you double-click their images. Setting this to 

[(None)] will result in no image being displayed. 
 

Change Vehicle Image 
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Function 

 

Changes the image for vehicles. These settings will be left unchanged until changed 
using this event command again. 

 
Settings 

 
Vehicle 

Specify the target vehicle. 
 

Image 
Double-click the image to specify the image that will display after the change. 

Setting this to [(None)] will have an image not be displayed. 
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Map 
 
 

Change Map Name Display 

 

 
Function 

 
Controls whether or not the name of a map will be displayed when moving to a 

different map. 
 

Settings 

 
Map Name Display 

Set to [ON] to display the name, set it to [OFF] to hide the name. 
 

Change Tileset 

 

 
Function 

 

Changes the settings of the map's tileset. The tileset that can be changed is limited 
to the map where the event was placed. 

 

Settings 
 

Tileset 
Specify the tileset after changing it. 

 
Change Battle Background 
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Function 

 

Changes the settings for the map's battle back. The battle back that can be changed 
is limited to the map where the event was placed. 

 
Settings 

 
Battle Background 

You can set the left and right images in the window that appears when you click 
the [...]. The specified image can be checked in the preview area on the right. 

 
Remarks 

 

If this event is run during a battle event, the background will change from the next 
battle. 

 
Change Parallax 

 

 
 
Function 

 
Changes the settings for the map's parallax. The changing the parallax is limited to 

the map where the event was placed. 
 

Settings 
 

Images 

Specify the image after it is changed. 
Loop Horizontally 

When enabled, the image will loop horizontally. Specify the speed (-32 to 32/0 
to stop) in the [Scroll] section to auto-scroll the map. 

 
Loop Vertically 

When enabled, the image will loop vertically. Specify the speed (-32 to 32/0 to 
stop) in the [Scroll] section to auto-scroll the map. 
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Get Location Info 

 

 
 

Function 

 

References the value at the specified location on the map and stores it in a variable. 
Variables that can be referenced are limited to the map where the event was placed.  

 

Settings 
 

Variable 
Specify the variable to store the acquired value. 

 
Info Type 

Specify the type of information that is acquired. 
 

Location 
Specifies the location of where to acquire the value. Select [Direct designation] 

to specify a specific location, and select the location in the window that opens 
when you press [...]. To specify the location using a map ID and coordinates, 

select [Designation with variables], and specify the variables for [X] and [Y]. 
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Battle 
 
 

Change Enemy HP 

 

 
 

Function 

 

Changes the HP of enemies. 
 

Settings 
 

Enemy 
Specify the target enemy. Setting this to [Entire Troop] will target all enemies. 

 
Operation 

Select either [Increase] or [Decrease]. 
 

Operand 
Specify the amount by which to raise or lower the HP. Select [Constant] to set 

this to a fixed value and enter the value. Choose [Variable] to set the amount 

using a variable, and specify the variable to reference. 
 

Allow Knockout 
When enabled, the enemy will be knocked out when its HP reaches 0. HP will 

remain at 1 even if the enemy's HP falls below 0 when disabled. 
 

Remarks 
 

This can be used only in battle events. 
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Change Enemy MP 

 

 
 

Function 

 

Changes the MP of enemies. 
 

Settings 

 
Enemy 

Specify the target enemy. Setting this to [Entire Troop] will target all enemies 
currently in battle. 

 
Operation 

Select either [Increase] or [Decrease]. 
 

Operand 
Specify the amount by which to raise or lower the MP. Select [Constant] to set 

this to a fixed value and enter the value. Choose [Variable] to set the amount 
using a variable, and specify the variable to reference. 

 
Remarks 

 

This can be used only in battle events. 
 

Change Enemy TP 

 

 

(See image on next page) 
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Function 

 
Changes the TP of enemies. 

 

Settings 
 

Enemy 
Specify the target enemy. Setting this to [Entire Troop] will target all enemies 

currently in battle. 
 

Operation 
Select either [Increase] or [Decrease]. 

 
Operand 

Specify the amount by which to raise or lower the TP. Select [Constant] to set 
this to a fixed value and enter the value. Choose [Variable] to set the amount 

using a variable, and specify the variable to reference. 
 

Remarks 

 
This can be used only in battle events. 

 
Change Enemy State 

 

 

http://code.google.com/p/libyuv/
http://code.google.com/p/libyuv/
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Function 

 

Changes the state of enemies. 
 

Settings 
 

Enemy 
Specifies the target enemy. Setting this to [Entire Troop] will target all enemies 

currently in battle. 
 

Operation 
Select either [Add] or [Remove]. 

 

State 
Specifies the type of state to add or remove. 

 
Remarks 

 
This can be used only in battle events. 

 
Enemy Recover All 

 

 
 

Function 

 

Fully recovers the HP and MP of the enemy, and removes all states. 
 

Settings 
 

 
Enemy 

Specifies the target enemy. Setting this to [Entire Troop] will target all enemies 

currently in battle. 
 

Remarks 
 

This can be used only in battle events. 
 

 
 

 
 

 
 

https://github.com/rentzsch/mach_override
https://github.com/rentzsch/mach_override
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Enemy Appear 

 

 
 

Function 

 
Causes an enemy to appear which was had the [Appear Halfway] option set in the 

Troop section. 

 
Settings 

 
Enemy 

Specifies the target enemy. 
 

Remarks 
 

This can be used only in battle events. 
 

Enemy Transform 

 

 
 

Function 

 
Transforms an enemy currently in battle to a different enemy. The HP and MP from 

the enemy prior to transformation will be carried over to the new enemy. 
 

Settings 
 

Enemy 

Specify the enemy to transform. 
 

Transform to 
Specify what the enemy will be after transforming. 
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Remarks 
 

This can be used only in battle events. 

 
Show Battle Animation 

 

 
Function 

 
Displays an animation using the enemy as the target.  

 
Settings 

 

Enemy 
Specify the target enemy. 

Animation 
Specify the animation to display. 

 
Remarks 

 
This can be used only in battle events. 

 
Force Action 

 

 
 

Function 
 

Forces the enemy/actor to use the specified skill. 



 
225/258 

 

Settings 
 

Subject 

Specify the target enemy/actor. 
 

Action 
The skill that they enemy or actor will be forced to use is specified in [Skill]. 

Targets of the skill will be selected from the [Last Target] (the same target of 
the performer immediately before), [Random] (selected at random), [Index X] 

(X can be 1 through 8/refer to remarks for more information). 
 

Remarks 
 

This can be used only in battle events. 
 

Abort Battle 
 

Function 

 
Forces the battle to end and the game to return to the map. There are no 

parameters to set. 
 

Remarks 
 

This can be used only in battle events. 
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Advanced 
 
 

Script 

 

 
 

Function 

 

Evaluates text as JavaScript. 

 
Settings 

 
Script 

Enter the JavaScript to be evaluated.  
Right-click to show the menu. 

 
• [Plugin Help...] ・・・ Displays the Plugin Help. 

 

Plugin Command 

 

 

(see image on next page) 
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Function 

 

Sends a command to a plugin. 
 

Settings 
 

Plugin Command 
Input the command to send to the plugin.  

 
• [Plugin Name] ・・・ Specify the plugin enabled in the Plugin Manager. 

• [Command Name] ・・・ Select the Plugin Command. 
 
Arguments 

 
Set the arguments defined in the plugin.  
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Documentation 

 
Documentation for the different formulas and asset standards have been included for 

when you make your game.  
 

Please use this when you want to find out more about the technical specifications of 
this software. 
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Asset Standards 
 
 

It is possible to use your own original files for all kinds of assets such as images and 
audio. 

 
By copying the asset file into the appropriate folder you can select the asset from the 

editor. 
 

Image Assets 
 
All images will use the PNG format. 

 
Animation Patterns (img/animations) 

 
These are primarily the images used for animations shown as effects in the Battle 

Screen. 
1 cell contains an image that measures 192x192 in size, and 5 cells lined up 

horizontally are treated as a block which will be stretched vertically only as necessary, 
becoming 1 file. A file can contain up to 20 blocks (100 cells). 

* Images used are the same size as in the previous version (VX Ace). 

Battlebacks (img/battlebacks1, img/battlebacks2) 

 
Images used as the backgrounds for the Battle Screen. 

A battleback measures 1000x740 in size, backgrounds in the battlebacks1 folder are 

primarily for floors, and those in the battlebacks2 folder are primarily for walls, and 
you can put these into any combination that you like in order to create your 

battleback. 
The upper part of images in front-view battles and the lower part of images in side-

view battles will be cropped then displayed. 

Characters (img/characters) 

 
Images shown for the characters on the map. 

The size for a character image can be changed freely (normally 48x48), and consist of 
4 directions (down, left, right, up) and 3 patterns for a total of 12 patterns that will be 

arranged in the provided order. A file for 1 character will be arranged into 2 rows and 4 
columns equaling 8 images. The size of the character will be calculated using 1/12 of 

the width and 1/8 of the height of this file. Moreover, characters will be shown 6 pixels 

above tile so that they appear more natural when on top of buildings. 

• It is possible treat 1 character as 1 file by including "$" at the beginning of the 

file name. 

• Including a "!" at the beginning of the file name will prevent the image from 
being shifted 6 pixels and will no longer appear half transparent by bush elements. 

This is primarily used for objects found in the map such as doors and treasure chests. 

• It is also possible to use the "$" and "!" special characters together. 

 



 
230/258 

 

Front-view Enemies (img/enemies) 
 

Images for enemies that are displayed in front-view battle. You can choose any size 

you want for the image 

Face (img/faces) 

 
Images which are displayed in the Menu Screen and message windows. 

Face images are 144x144 in size, and arranged into 2 rows and 4 columns equaling 8 

images. 

Parallax (img/parallaxes) 
 

Images shown behind maps. You can choose any size you want for the image. 
Like wallpaper, the top, bottom, left and right sides of the image will be connected 

when wanting to loop the image. 
Additionally, parallax files will be treated as floors (no parallax) when there is a "!" at 

the beginning of the file name. 

Pictures (img/pictures) 

 

Images which are displayed by using event commands during the game. You can 

choose any size you want for the image. 

Side-view Allies (img/sv_actors) 
 

Actor images which are displayed in side-view battle. 
Please refer to [Side-view Character Standards]. 

 
Side-view Enemies (img/sv_enemies) 

 
Images for enemies that are displayed in side-view battle. You can choose any size you 

want for the image. 

System Images (img/system) 

 

The various images used in the overall game. 

Balloon.png 

Asset used for actor chat balloons. The transparent area below the image is 

defined by the user. 

ButtonSet.png 
Buttons used when the game is displayed on devices such as smartphones which 

support touch controls. 
This can be used for changing things like the number of items when purchasing 

them. 

Damage.png 

Asset used for displaying damage pop-ups in the Battle Screen. 

https://www.didiermorandi.fr/lpdm/Zork2D_Project/page/01_11_02.html
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GameOver.png 

Asset displayed on the Game Over Screen. 

Loading.png 

Asset used for the Loading Screen. 

IconSet.png 

Assets used for the icons for items, weapons, skills, etc. 

Shadow1.png 

Asset for the shadow displayed when flying a plane. 

Shadow2.png 

Asset for the shadows of allies in side-view battle. 

States.png 

Asset for the states of allies in side-view battle. 

Weapons1.png, Weapons2.png, Weapons3.png 

The weapon images that are displayed when allies perform normal attacks in 
side-view battle. 

 
There are 12 different types of images for Weapons1 and Weapons2. Weapons3 

has 6 different types of images. Weapons3 is defined by the user. 

 
Window.png 

Collection of image assets that compose the windows. 

Tilesets (img/tilesets) 

 

Images which consist of the tiles (also known as map chips) that make up a map. 

Title Screen (img/titles1, img/titles2) 
 

Images displayed on the Title Screen. 
 

The size for these images is 816x624. Titles1 contains files for the main background, 
and titles2 contains images for frames, etc. Use these in any combination to create the 

Title Screen. 
 

Tileset details 

 
1 tile is 48x48 in size, and tiles need to be grouped in the 5 types of sets, A through E, 

below. Additionally, the specifications for some tiles can change according to the 

contents set under [Mode] found in [Tilesets] in the database. 

Set A 
 

This set will be used as the lower layer when drawing the map. This set is divided 
further into 5 parts, with most of them being called [Autotiles], which are composed of 

special tiles that have their boundary lines automatically created. 
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Autotiles are, as a rule, arranged in a pattern composed of 6 tiles as seen in the 

illustration below, making up the basic structure of the tiles. 

 
a 

Representative Pattern (for displaying in the tile palette) 

b 

Pattern with boundaries at each corner 

c 

Group Pattern (refers to group of tiles with one in the center and 1 in each of the 8 

directions) 

 
 

If the autotile located in the (8,8) position from the bottom-right is transparent, that 

autotile will be evaluated as a "forest type". If a forest tile has the bush element 
assigned to it, character images will not appear as half transparent in the 8 types of 

tiles below which includes the bottom right and bottom left boundaries. 

Part 1 
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These are 768x576 in size and made up of the 5-pattern blocks as in the illustration 

above.  

Basically, tiles in this part will not have a boundary created even if they touch. 

 
Boats and ships can only travel through the tiles in this part. However, tiles in this 

tileset will no longer be able to be entered using boats and ships if the tileset is 

configured to allow players to walk on the tiles. 

Block A 
 

Autotiles used as ocean tiles. By placing 3 autotile basic patterns horizontally in a 

row, it is possible to animate them. 

Block B 
 

Autotiles used as deep ocean tiles. Boundaries for ocean tiles will be created only 
when tiles in this block touch tiles in part 1. Tiles in Block A will automatically 

complete the transparent color of this block. Just like Block A, by placing 3 
autotile basic patterns horizontally in a row, it is possible to animate them. 

Moreover, boats cannot travel through tiles in this block. 

Block C 
 

Autotiles which decorate ocean tiles in Block A. Tiles in Block A will automatically 
complete the transparent color of this block. Additionally, boats and ships cannot 

travel through tiles in this block. 

Block D 

 
Autotiles used as water tiles. By placing 3 autotile basic patterns horizontally in a 

row, it is possible to animate them. 

Block E 

 
Used for waterfall tiles. You can create a group pattern by placing two tiles 

horizontally, and animate them by placing 3 vertically in a row. Additionally, 

boats and ships cannot travel through tiles in this block. 

Part 2 

 

 
 

These are 768x576 in size and composed of 4 2-pattern blocks placed vertically in a 

row as in the illustration above.  
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Specifications for this part only can change according to the contents set under [Mode] 
found in [Tilesets] in the database. If the tiles in this part have the counter element, 

they will be used as autotiles to create tables, and the bottom of the pattern will be 

displayed as shifted 12 pixels down when placed. 

 
 

Block A (Field Type) 

 

Composed using 4-pattern autotiles, and will be handled as 1 only, 1 and 2 

overlapping, 3 only, 3 and 4 overlapping in the actual tileset. 

 
↓ 

 
 

Block B (Field Type) 

 
It is possible to store 4 patterns, and are special tiles that can be placed over tiles in 

Block A in the actual tileset. 

Block A (Area Type) 

 
It is possible to store 4 patterns, and are tiles that can be placed over tiles in Block B 

in the actual tileset. 

Block B (Area Type) 

 
It is possible to store 4 patterns, and are tiles that can be placed over tiles in Block A 

in the actual tileset. 

Part 3 
 

Autotiles which will be primarily used for the appearance of buildings. These are 
768x384 in size, and are composed by placing 8 tiles horizontally and 4 tiles vertically, 

formed using only the autotile group pattern. 
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By placing two or more tiles in this part together vertically when designing your map, 

shadows will automatically be created on the adjacent touching tile on the right side. 

However, shadows will not be automatically generated if the adjacent tile belongs to a 

part other than Part 2 (excluding Block C) or Part 5. 

Part 4 

 
Autotiles which will be primarily used for walls. These are also used for walls for 

dungeon instances. These are 768x720 in size. Composed by placing 8 tiles 
horizontally and 3 tiles vertically using autotile basic structures and those tiles placed 

vertically in a row using only the autotile group pattern. 
 

By placing two or more tiles in this part together vertically when designing your map, 
shadows will automatically be created on the adjacent touching tile on the right side. 

However, shadows will not be automatically generated if the adjacent tile belongs to a 

part other than Part 2 (excluding Block C) or Part 5. 

Part 5 
 

These are 384x768 in size and please be sure to place the tiles here in an 8x16 

arrangement. Tiles contained in this file will all be treated as normal tiles. The 3rd, 5th 

and 7th tiles from the top are used also for the floors of dungeon instances. 

Set B through Set E 
 

These sets will be used as the upper layers when drawing the map. 

These are 768x768 in size and be sure to place the tiles here in a 16x16 arrangement. 

• Leave the tile located in the top left of Set B blank as this represents nothing 
being placed in the upper layer. 

 
Audio Files (Music, Sound Effects) 

 
The file formats that are playable depend on the operating environment, so please 

prepare the below 2 file formats with the same file name. 

• Ogg Vorbis(.ogg) 

• AAC(.m4a) 

* When creating a game that will be played on Windows or Mac, please prepare only 

the Ogg Vorbis file format. When creating a game that will be released on the web or 
made for Android/iOS, both file formats are required. 

 
 

Video Files (Movies) 
 

The file formats that are playable depend on the operating environment, so please 

prepare the below 2 file formats with the same file name. 

• WebM(.webm) 
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• MP4 (.mp4 encoded with H.264 codec) 

* When creating a game that will be played on Windows or Mac, please prepare only 

the WebM file format. When creating a game that will be released on the web or made 
for Android/iOS, both file formats are required. 

 
It is possible to use your own original files for all kinds of assets such as images and 

audio. By copying the asset file into the appropriate folder you can select the asset 
from the editor. 
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Side-view Character Standards 
 
These are the standards for images used as the battle graphics of actors displayed in 

Side-view Mode. It is possible to use one image file per character. 
 

Specifications 
 

Images are stored in a file in a 9x6=54 pattern. 
 

 
 

• The width of the image is 9 and the height is 6, which becomes the size for 1 

character. 
• The image size for standard assets is 576x384. 

 
3 patterns lined up in a row will be treated as one motion. 
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• Looping standby motions will be repeatedly displayed in a 1-2-3-2 order 
starting from the left. 

• Motions that occur only 1 time such as damage motions will be shown in 1-2-3 

order starting from the left. 
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Output Formats 
 

Deployment 
 

 
 

Exports the deployment package for each platform. It is possible to output for Windows, 

macOS, and web browsers. 

For Windows 
The exported game folder will be deployed. 

 

For macOS 
Distributes the exported game folder or the Game.app file inside the game folder. 
*Game.app will be displayed as a folder in a Windows environment, but you can run 

this as an application in a macOS environment. 
 

Web Browsers 
 
You can run your game on a web browser by uploading your exported project folder to a 
web server. 

Gameplay System Requirements 

 

System 
Requirements 

Environments which support HTML5 Canvas and Web 
Audio API 

iOS 12 or higher 
Android 8 or higher 

 

Recommended 
Browsers 

Google Chrome, Safari, Firefox, iOS Safari, Chrome for 
Android 
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*Please use Wi-Fi when playing using a browser on a smartphone. 

*Can exclusively be played on browsers that supports WebGL. 

 

 

Options [Exclude Unused Files] 
 
Check the option [Exclude Unused Files] during deployment to export the game folder 

without including unused files in the game. Use this function to reduce the file size. 
Files that can be excluded will be unnecessary files contained in the following folders. 

• Project Folder/img/all nested files 

• Project Folder/audio/all nested files 
• Project Folder/effects/all nested files 

 
Depending on a plugin's design, files specified by a plugin may end up being excluded. 

Files can be excluded by configuring them in the "MaterialBase" official plugin. 
 

Encryption 
 
Encrypt image or sound files that you use in the game. 
 

Image Files 
Check the box to encrypt all image files included in the package. 

Sound Files 
Check the box to encrypt all sound files included in the package. 

Encryption Key 
Enter a character string. This character string will be used in the file when 

encrypting. 
 

*You can not use encrypted files within the project folder. 
*Due to circumstances beyond our control regarding browser games, we cannot guarantee 

that these measures will prevent your game from being unlawfully copied. 
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Enabling Plugins 
 
Users can find easier to use plugin features in RPG Maker MV. 

 

Enabling Plugins 
 

Enable plugins using the [Plugin Manager] found under [Tools]. 

1. Double-click an empty row. 

 
 

2. Select the plugin you want to use and click the [OK] button. 

 
 

3. The selected plugin will appear in the list. 

(see image on next page) 
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Enabling Unofficial Plugins 
 
When adding a plugin, after copying the desired plugin's js file to the "plugins" folder 

found in the project folder's "js" folder, enable it using the above procedure. 

1. Copy the desired plugin's js file to the "plugins" folder found in the project 

folder's "js" folder. 
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2. Double-click an empty row in the Plugin Manager and the name of the plugin 
that was added will appear when you click [Name]. Select the name and click 

[OK]. 

 
 

3. The selected plugin will appear in the list. 

 
 

Changing multiple [Statuses] at once 
 
Press the Shift key to select multiple plugins and right-click to change all statuses at 

once. 
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Refreshing Plugins  
 
When changes have been made to a plugin, the changes will be reflected to the editor 

by clicking the Refresh button. 
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Using Official Plugins 
 

In RPG Maker MV, there are several plugins already included in your new project and 

can be used with simple settings. 

AltMenuScreen 
 
A plugin that changes the Menu Screen to a different layout. 
 

Party members will be displayed horizontally. 
 

 
 

AltSaveScreen 
 
A plugin that changes the Save Screen and Load Screen to a different layout. 

 

It becomes possible to display images such as the faces of party members. 



 
246/258 

 

 
 

EnemyBook 

 
Monster Enemy Book 
 

You can make a [Monster Enemy Book] which lists the enemies the player has fought. 

Plugin Command 

 

Set up as an event using the [Plugin Command] advanced event command. 
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EnemyBook open Open the Enemy Book Screen 

EnemyBook add 3 Add the enemy 3 to the Enemy Book 

EnemyBook remove 4 Remove enemy 4 from the Enemy Book 

EnemyBook complete Complete the Enemy Book 

EnemyBook clear Clear the Enemy Book 

 
Enemy Note 

 

Writes to the [Note] section in the [Enemies] tab of the database. 

 
 

<desc1:description 1> Display description on the first line 

<desc2:description 2> Display description on the second line 

<book:no> Use when you will not put in the Enemy Book 

 

ItemBook 
 
Item Book 
 

You can make an [Item Book] which lists all the equipment and items a player has 
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collected. 

Plugin Command 

 

Set up as an event using the [Plugin Command] advanced event command. 

 
 

ItemBook open Open the Item Book Screen 

ItemBook add weapon 3 Add weapon 3 to the Item Book 

ItemBook add armor 4 Add armor 4 to the Item Book 

ItemBook remove armor 5 Remove armor 5 from the Item Book 

ItemBook remove item 6 Remove item 6 from the Item Book 

ItemBook complete Complete the Item Book 

ItemBook clear Clear the Item Book 

 
Item (weapons, armors) Note 

 

Writes to the [Note] field in the [Items (weapons, armors)] tab in the database. 
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<book:no> Use when you will not put in the Item Book 

 

SimpleMsgSideView 
 
Hide the battle log shown in side-view during battle. Only the names of skills, items 

and actions (Attack and Guard) will be displayed in the upper part of the screen. 

Parameters 
 

displayAttack 

Whether to display a normal [Attack] or not. 

Will not be displayed when set to 0 (default), and will be displayed when set to 1. 

position 
Whether to display the names of skills and items to the left or in the center. 

Left when set to 0, and in the center when set to 1. 
 

TitleCommandPosition 
 
A plugin that changes the position of the command window on the Title Screen and its 

background. 

Parameters 

 
Offset X 

The offset value for the X coordinate. 
 

Offset Y 

The offset value for the Y coordinate. 
 

Width 
Width of the command window. 

 
Background 

The background type. You can select from 3 different types: 0 - Normal, 1 - 
Dark, 2 - Transparent. 

 

WeaponSkill 
 
A plugin that changes the skill ID for the normal attacks for each weapon. 
 

Create the skill that you want to add to the weapon. Specifying the skill ID in the 

[Note] field of the weapon will cause that skill to be activated when attacking with a 
weapon. 

 
Example: <skill_id:3> 

 
You can create the following types of weapons. 

• Make a weapon that attacks multiple enemies. 
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• Make a weapon that attacks 2 or 3 times. 

• If recovery magic is set to a skill, you can select an ally and cause them to 

recover when you select [Attack]. 

• It is possible to create weapons which are equal to the Guard command, etc. 
 

Sets the [Skill Type] to "None" for skills selected using weapons. 
In the case that a Skill Type whose use can be disabled, the player will not be able to 

select "Attack" if that skill is disabled. 
 

TouchUI 
 
This will change the current UI to touch controls. 

 
*This plugin cannot be used simultaneously with other plugins that change the UI. 

(AltMenuScreen, AltSaveScreen, SimpleMsgSideView, TitleCommandPosition, etc.) 

Parameters 

 
Menu Command Text 

This is the text on the Menu button that shows up in the map scene. 
 

Previous Command Text 
This is the text on the Previous button displayed in the menu. 

 
Next Command Text 

This is the text on the Next button displayed in the menu. 

 

Gacha / GachaBook 
 

This is a plugin that allows you to add a Gacha system. 

  

 

Gacha 
 

A probability system that generates random chances to obtain items. 
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Parameters 
 

Help Message Text 

A Help Message in the Gacha screen. Required Amount is replaced by required G. 

 
Button Text 

Text displayed on the Gacha Button. 
 

Get Message Text 

Message displayed after a Gacha is done. Item Name will be replaced by the 

obtained Item Name. 

 
Show Item Description 

Turns on/off to display the description when item is obtained. 
Choose from the following; 0: do not show description, or 1: show description. 

 
Effect 

Sets the animation number for when items are obtained. 

 
Rank1～5 Effect 

Sets the animation number for Rank 1 to 5. 
 

ME 
Sets ME for when items are obtained. 

 
Required Amount 

Required G to do a Gacha. 

 
Plugin Command 

 

Sets as an event in [Plugin Command] in Advanced under Event Commands. 
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Gacha open Opens Gacha screen. 

Gacha add item 1 Adds item no. 1 as obtainable item in Gacha. 

Gacha remove item 1 Removes item no. 1 as obtainable item in Gacha. 

Gacha clear Clears all obtainable items in Gacha. 

 

Items (Weapon/Armor) Note 
 

Writes to [Note] in [Items (Weapon/Armor)] under Database. 

 
 

<gachaImage: 

image> 

Choose image for Gacha item. Add image file under img/gacha/(this 

folder). 

<gachaNumLot: 10> Sets number of Gacha. 

<gachaRank: 5> Sets rank (1 to 5) for Gacha item. 

 

GachaBook 
 
Displays list of Gacha Items. 
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Parameters 
 

Unknown Data 

Name of an unknown Gacha item. 
 

Price Text 
This is the text for [Price]. 

 
 

Equip Text 
This is the text for [Equipment]. 

 
 

Type Text 
This is the text for [Type]. 

 
Rank Text 

This is the text for [Rank]. 

 
Simple Display 

Switches the display method for description display. Choose from the following; 
0: Normal Display, 1: Simple Display (name and description only). 

 
Plugin Command 

 

Set as an event in [Plugin Command] in Advanced under Event Commands. 

 
 

GachaBook open Opens Gacha book. 

GachaBook add weapon 3 Adds Weapon No. 3 to Gacha book. 

GachaBook add armor 4 Adds Armor No. 4 to Gacha book. 

GachaBook remove armor 5 Removes Armor No. 5 from Gacha book. 

GachaBook remove item 6 Removes Item No. 6 from Gacha book. 

GachaBook clear Clear all content in Gacha book. 
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SlotMachine  

 
This is a plugin to add a slot machine system. 

 
 

Parameters 

 
Variable ID 

This is this variable ID to manage the amount of coins owned. 
 

Help Text 
This is the message for help. 

 
Won Text 

This is the message shown when winning. Win Coin will be replaced by the 

amount of obtained coins. 
 

Lost Text 

This is the message shown when losing. 
 

Replay Text 
This is the message shown when choosing to retry or not. 
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Coin Full Text 
This is the message shown when coins reach maximum amount. 

 

Bet Text 
This is the text for the Bet Command. 

 
Spin Text 

This is the text for the Spin Command. 
 

Yes Text 
This is the text for the Yes Command. 

 
No Text 

This is the text for the No Command. 
 

Plugin Command 
 

Set as an event in [Plugin Command] in Advanced under Event Commands. 

 
 
 

SlotMachine open Opens slot machine. 

SlotMachine 

expectation 0.5 

Sets expected value to a number in between 0 to 1. The closer to the value 

1, the better chance of winning, though there is never a 100% chance. 

SlotMachine scale 0 Sets the multiplying factor. Value 0 is x1, 1 is x10, and 2 is x100. 

 

Community_Basic 
 
This plugin allows you to set basic parameters for your game. 

Parameters 

 
cacheLimit 

Maximum cache limit for image file memory (MPix) 
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screenWidth 
Screen size (width) 

 

screenHeight 
Screen size (height) 

changeWindowWidthTo 
Change the screen width to the set value 

 
changeWindowHeightTo 

Change the screen height to the set value 
 

renderingMode 
Rendering mode (canvas/webgl/auto) 

 
alwaysDash 

Default setting for auto-run (on/off) 
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